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Chapter 1    Program Installation
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AgData( Software License Agreement
This is a legal agreement between you, the end user, and AgData. By continuing with installation of this program, you agree to be bound by the terms of this agreement. If you do not agree to this agreement, promptly return the installation package and any accompanying items (including written materials and binders or other containers) to the place you obtained them for a full refund. 
When you purchase AgData software, you do not become the owner of the copyright.  Rather, you are purchasing the right to use the software as described in this license agreement.  If you copy, distribute or install the software in ways not allowed by this license, whether you are swapping disks with friends and coworkers or participating in widespread duplication, you are violating federal copyright laws.  Even if you only help someone else make unauthorized copies, you still are liable under the copyright law.  For more information about software piracy, or to report piracy, call 1-888-NO-PIRACY.
PIRACY WARNING: AgData programs are serialized by both client number and internal encryption to identify the origin of unauthorized program copies. 
1. GRANT OF LICENSE. AgData grants to you the right to use ONE copy of the enclosed AgData software program (the "SOFTWARE") on a single terminal connected to a single computer (i.e. with a single CPU).  You also may install this program on your Certified Public Accountant's computer to allow him to make a few adjusting entries – up to approximately one percent of your total number of transactions - and to print final reports.  Other than the CPA location, you may NOT network the SOFTWARE or in any other way use it on more than one computer or computer terminal at the same time unless you have purchased the appropriate network and workstation program license from AgData. 
2. COPYRIGHT. The SOFTWARE is owned by AgData or its suppliers and is protected by United States copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE like any other copyrighted materials (e.g. a book or musical recording) except that you may either (a) make one copy of SOFTWARE solely for backup or archival purposes, or (b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for backup or archival purposes. You may not copy the written materials accompanying the software. 
3. OTHER RESTRICTIONS. You may not rent or lease the SOFTWARE, but you may transfer the SOFTWARE and accompanying written materials on a permanent basis provided you retain no copies and the recipient agrees to the terms of this Agreement and you get prior written approval from AgData. The Software Maintenance Policy is not transferable. You may not reverse engineer, de-compile, or disassemble the SOFTWARE. If the SOFTWARE is an update, any transfer must include the update and all prior versions. Contact AgData Customer Service for information regarding transfer fees and other conditions, which may apply. 
4. DUAL MEDIA SOFTWARE. If the SOFTWARE package contains both 3.5" and CD format disks, then you may use only the disks appropriate for your single-use computer. You may not use the other disks on another computer or loan, rent, lease, or transfer them to another user except as part of the permanent transfer (as provided in section three) of all SOFTWARE and written materials. 
LIMITED WARRANTY. AgData warrants that the SOFTWARE will perform substantially in accordance with the accompanying written materials for a period of 45 days from the date of receipt. Any implied warranties on the SOFTWARE limited to 45 days. Some states do not allow limitations on duration of an implied warranty, so the above limitation may not apply to you. 
CUSTOMER REMEDIES. AgData's entire liability and your exclusive remedy shall be, at AgData's option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE that does not meet the AgData Limited Warranty and which is returned to AgData with a copy of your receipt. Any replacement SOFTWARE will be warranted for the remainder of the original warranty period or for 45 days, whichever is longer. THESE REMEDIES ARE NOT AVAILABLE OUTSIDE THE UNITED STATES OF AMERICA. 
NO OTHER WARRANTIES. AgData disclaims all other warranties, either express or implied, including but not limited to implied warranties of fitness for a particular purpose, with respect to the SOFTWARE and the accompanying written materials. This limited warranty gives you specific legal rights. You may have others, which vary from state to state. 
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. In no event shall AgData or its suppliers be liable for any damages whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business information, or other pecuniary loss) arising out of the use or inability to use this AgData product, even if AgData has been advised of the possibility of such damages. Because some states do not allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply to you. 
U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to the restrictions as set forth in subparagraph (c)(1 )(ii) of The Rights in Technical Data and Computer Software clause at 52.227-7013. The manufacturer is AgData, 891 Hazel Street, Gridley CA 95948. 
This Agreement is governed by the laws of the State of California. Should you have any questions concerning the Agreement or if you wish to contact AgData(for any reason, please write: Customer Service, AgData, 891 Hazel Street, Gridley, CA 95948. 
Blue Skies Accounting®  by  AgData®

Software Design by Dan Boeger

Software Credits, programming language, etc.

Third Edition, AgData Blue Skies Accounting®User Guide

Documentation:  Dan Boeger with contributions by:

Mary Boeger, Willie Armstrong, Patsy Schutz, Brenda McCombs-Pogue, and Kathy Martin— Technical Support Specialists. 

Manual Design and Layout by Mary Boeger

Images provided by Dick Kennedy (the AgData plane).  Fonts are Times New Roman and Arial.  This publication was created using Word for Windows by 

AgData®, 891 Hazel St. , Gridley, CA  95948, (530) 846-6203

Sales e-mail to: sales@agdata-usa.com; support emails to: support-usa@agdata.com
Company webpage: www.agdata-usa.com
Software Copyrights.  Portions of AgData’s Blue Skies Accounting® are copy-righted by Microsoft Corporation of Seattle, Washington.  All rights reserved.  End-Users shall be bound by the AgData End-User Software License to protect the copyrights of these companies.

Author’s Preface
Computers have changed our lives.  Everything from research satellites orbiting above us, to medical research, to communications, to education now benefits from computers.  Computers are so helpful, that within ten years of the introduction of the IBM personal computer, over 70% of people who work in finance, insurance, and real estate industries use a computer on the job.
AgData was first started as a University of California and Gianini Foundation research project in 1965.  The University Extension people reviewed computer management systems both from other states’ ag extension services and from the ‘real world’, from the best managed construction and ag companies.  AgData first sold computer time and printouts off giant, multimillion-dollar, IBM main frame computers in 1968.  AgData had a personal computer program written and was selling AgData brand personal computers two years before Apple Computer sold their first computer and four years before IBM sold its first personal computers.  AgData is the oldest ag computer company in the United States and still continues to be a leading innovator.
Blue Skies Accounting(is the third total rewrite out of that original research plus years of suggestions by users and our technical support staff.  The first was the main frame program, which was written in COBOL.  The second was the rewrite into Altair and then Microsoft BASIC language for CP/M and then for IBM and for Apple Macintosh personal computers.  And now Blue Skies Accounting( in Microsoft’s Visual Basic programming language for Microsoft’s Windows.  Microsoft’s Visual Basic has become the language of choice for Windows programmers from corporate America to games programmers.  The program design both fully harnesses the power and beauty of the newest computers and printers, but also is designed to allow for maximum ‘open architecture’ so the program can easily incorporate new computer technology like bar code readers, digital cameras as well as adapting to your changing needs in the future.  Blue Skies, ‘under the hood’, uses Microsoft’s Access Jet Engine for the highest speed database access and updates and the closest integration with Microsoft technology.
Blue Skies is designed to minimize bookkeeping time for general ledger and payroll books and at the same time produce professional management books by enterprise, operation, and equipment number activity in a format especially suited for heavy equipment work-in-progress businesses like construction and agriculture.
I hope you find that the simplicity of use, speed, and power of Blue Skies Accounting(gives you the Power to Manage Your Business.
Dan Boeger
Hardware Requirements & Installing Program
 XE "Hardware Requirements" Hardware Requirements
The Blue Skies Accounting System a computer with Windows XP or later equivalent operating system.  Microsoft Word and Microsoft Excel also are required.
Install Blue Skies Accounting Programs
Install the program
Close all programs.  Go to http://www.agdata-usa.com/download.htm and download ‘Full Blue Skies Install’ to install all components of Blue Skies, even those that will never change.  Once the full program is installed and operating, you may download ‘Blue Skies Latest Updates’ to get updates for Blue Skies by clicking on that item on this Download page.  The date of this latest program version – which includes tax table updates – appears in the heading of this website Download page.
Install your licensee information
Use of the software program Blue Skies Accounting is subject to the terms of the License Agreement which you should read on your screen at the beginning of the software installation.  By using the software, you signify that you read the License Agreement and accept its terms.
Tech Note: If you purchased additional options beyond these original ones, you will receive a diskette with a file named ‘SKCLIENT.UPG’.  Before starting Blue Skies, insert that diskette in your floppy disk drive 'a:' or 'b:', hold down your <Ctrl> key while starting Blue Skies.  The 'skclient.upg' will be copied to your ‘C:\BLUE_SKY’ directory.  When you get to your Open Client window in Blue Skies, release your <Ctrl> key then click on the client's books you wish to open. The new options will automatically be installed.
Multi-user XE "Multiuser"  Warning: Do not use a single user version of Blue Skies Accounting to enter data on a network XE "Network"  computer.  If you do so, you will find that lines from a check you entered will mysteriously disappear, only to reappear on a check entered by some other network user.  The multi-user (or network XE "Network"  ) version of Blue Skies Accounting takes the extra time and effort to assure a disciplined flow of data to avoid this type of cross posting of data.  In multi-user Blue Skies, many operators can enter data for general ledger or paychecks, and then one master operator will print and post all the checks.
Blue Skies Program Group
When Blue Skies Accounting is installed, a Blue Skies Accounting group of programs will be created.  In this group, you will find:
The 'Blue Skies Accounting' icon.
A 'Speed Test' that will perform a simple test of your computer’s speed.
A 'Convert Data' program to use only if you want to re-convert your AgData DOS data to Blue Skies format.
An 'Enable New Reports' program that adds or deletes reports from your list of active reports.
Chapter 2    Open Client’s Books

Open Client’s Books

The Open Client XE "Open Client"  window automatically opens when the program starts.  This tells the program which set of books in which subdirectory you wish to open.  To add or modify data or print reports XE "Reports"  for client number 1000, Progressive Farming Company, either double click on '1000, PROGRESSIVE FARMING CO' or single click on it to highlight it as shown below, then click on the 'Open' button to open Progressive Farming Company's books.  Blue Skies will remember that set of books you last used and will use it as the default XE "Default"  set of books next time you start Blue Skies.
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Open Client’s Books screen

Note Program Status Bar on lower left of your screen after opening your books.

If  your company name (e.g. PROGRESSIVE FARMING CO in the above example) isn't visible or isn't the fiscal year desired (note that the PROGRESSIVE FARMING CO's books displayed is for the 2016 fiscal year):

Click on the down triangle of the yellow ‘combo’ box to display all the subdirectories in ‘C:\Blue_Sky that have company setup information.  When the list of names of subdirectories appears, click on the name that contains the books you wish to open.  The books in that subdirectory will then be listed.
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-or- If you know how to use window's directory list boxes and know where the fiscal year's subdirectory is located, Click Change Directory XE "Change Directory" 

 XE "Change Directory"  button to find the directory where it is located.  Either click up and down your ‘Tree’ of directories to navigate to the subdirectory that contains your data.

-or- Click 'Find Dir' XE "Find Directory" 

 XE "Directory"  to search your entire hard disk for all Blue Skies books.  Click the 'Go' button to search the entire hard disk.  Go up or down the list of companies to find the various fiscal years XE "Find Fiscal Years"  books then double click on the company in the fiscal year's subdirectory to open that company's books.

-or- Click on the ‘Ask’ button that appears after you have clicked on ‘Change Directory’ and type in the path of your directory, such as ‘C:\SKY_DATA\2016DATA’ and then touch your <Enter> key to jump directly to that subdirectory.

When you find the proper directory, all the companies in that directory will be listed in the box on the right.
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Program Status Bar

After opening Progressive Farming Company’s books, in this Main Menu, the Program Status Bar will appear on lower left corner of main menu.  If it has a white background, then your Blue Skies Accounting program version is current.  But if the background is Red, a new, improved version of Blue Skies needs to be downloaded and installed.  If so, just double-click on the Status Bar to download the new program version

Main Menu

After opening your books (PROGRESSIVE FARMING CO, Client#1000 in C:\Blue_Sky\DemoData\2016Data), this main menu will appear.  You have AgData License#1234, Licensed to ‘Progressive Farming Co’ as the master company.  Click on each of these dropdown menus, File, Edit, View, Transactions, Setup, Tools, and Help menu to see the subcommands under that heading.  On this screen and all Blue Skies screens, you can use the Alt Shortcut Key method.
The File \Relate "Blue_Sky.doc!21", "File" \D2HTargetDefault  does open and close a company’s books, print reports, XE "Reports"  and exit from Blue Skies.

The Edit \Relate "Blue_Sky.doc!22", "Edit" \D2HTargetDefault  does cut, XE "Cut"  copy, XE "Copy"  and paste XE "Paste"  and display clipboard.

The View XE "View"  \Relate "Blue_Sky.doc!23", "View" \D2HTargetDefault  displays lists of setup codes and during transaction input allows you to choose your code from the list.

The Transactions \Relate "Blue_Sky.doc!24", "Transactions" \D2HTargetDefault  enters or edits all types of transactions.

The Setup \Relate "Blue_Sky.doc!8", "Setup" \D2HTargetDefault  menu items must be completed in the order they appear on the pulldown lists before any transactions can be entered.

The Tools \Relate "Blue_Sky.doc!25", "Tools" \D2HTargetDefault  menu gives you easy access to standard and purchased windows programs and optional Blue Skies modules as well as powerful tools designed to be used by AgData tech support and program customization such as changing the picture shown below this menu, changing the music (the .wav file) played when Blue Skies starts, and your background and highlight screen colors.

The Help \Relate "Blue_Sky.doc!26", "Help" \D2HTargetDefault  menu gives you access to the on screen help manual, some diagnostics on your computer (available hard disk and memory space and speed tests) and other items to assist you and AgData tech support.  Touch your <F1> shortcut XE "Shortcut"  key from anywhere in Blue Skies to get ‘context sensitive help’ - to get the program to jump to the page of the on screen manual to pertains to the subject being shown on your screen.

.

Chapter 3Setup
Setup menu
You must set up computer codes and other options before entering any of your transactions.  Do this first!  Without these codes the computer cannot process any of the information you enter. It is important that you enter setup information in the order that topics are listed on the Setup Menu, shown below.  
When you click on Setup the Setup Menu drops down. Throughout the written manual and the on-line help manual, we will refer to these as pulldown menus.   When you click on Company a second menu will drop down or cascade to the right, listing all the Company Setup options.  It is important to proceed through these options in order from top to bottom. 
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Setup Menu
Begin "Company Setup" with "Set Company Name and Address" \Relate "BLUE_SKY.DOC!41", "^34" \D2HTargetDefault  and continue through "Set Expert Options". \Relate "BLUE_SKY.DOC!7", "." \D2HTargetDefault  XE "Expert Options"      You will use the options listed below the lines – ‘Add a New Company’ thru ‘Reset Payroll Yr Bal Fwd’ – later on in the year. 
Return to the Setup Menu and click on Accounts, the next Setup option.  Continue downward through the list to Setup Employer where you will proceed in order from top to bottom through its cascading menus.  The last Setup topic will be Setup Employees \Relate "BLUE_SKY.DOC!14", "Setup Employees" \D2HTargetDefault . Then, you will be ready to enter transactions, write checks, XE "Checks"  and print reports. XE "Reports"   Once the initial setup has been completed, you may add new or revise old employees, vendors XE "Vendors"  and other codes.
Chapter Two describes each Setup option in the order in which you must complete it, so just follow along.
Setup Company
Use this option to set up your company name, address, and company options.  Complete Company Setup before beginning other Setup options, and before entering any transactions.  Note that Company Setup displays an arrow pointing off to the right that indicates a 'cascading' pulldown menu. (See the illustration on the preceding page.)  Hold your mouse down on Company setup and a second menu will drop down listing Name and Address, Costing Options, XE "Costing Options"  Password, XE "Password"  etc.  To select one of these options, slide your mouse off the arrow on the right edge and onto an option on the second menu, and then click.
Begin Company Setup by selecting Set Name and Address.  Continue through the cascading menu items in order, completing Set Expert Options XE "Expert Options"  before moving on to Setup ! Accounts.
Setup Company Name and Address
[image: image5.png]Company Setup: Name and Address

Fie
Address 891 HAZEL STREET
City. St GRIDLEY. CA
Zip Code 95948

Phone Number 530-846-6203
Federal DB 94-123456

State DB 707-23458





Company Setup:  Name and Address screen
Enter your Company Name and Address.  This information will show on the top left of most of your reports and also will show on your payroll reports such as your W2 forms.  So, if are using Blue Skies for payroll reporting, make sure this is set to the legal name of your company before printing payroll reports.  Your company's phone number will print, as required, on your federal form 1099 XE "1099" 's.
Multi-user/network XE "Network" 

 XE "Multiuser"  feature: Under the ‘State ID#’ prompt, you will see a ‘User Name’ prompt. Enter either your name (such as ‘JANE SMITH’) or your workstation name (such as ‘RECEPTIONIST’ or ‘NORTH OFFICE’).  Then when you choose ‘Help ! Who Are We’, the program can tell you who is using Blue Skies and what job step he/she is currently doing.
Touch your Save button to save your entries and exit this screen.
Set Accounts Design
Setup ! Company ! Set Account Design 
Use the ‘Set Accounts Design’ option to design a financial chart of accounts for your company. You must Set Account Design before you can set up any general ledger accounts.
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Company Setup:  Account Design screen
 XE "Account Groups" Account Groups
Use this screen to enter account ranges for Account Groups like Current Assets XE "Current Assets"  and Long Term Liabilities. XE "Long Term Liabilities" 

 XE "Long Term Liabilities"   Accounts within each group will subtotal on reports.
Enter the beginning account number for each group.  In the example above, Current Assets XE "Current Assets"  begin with account #100 and fixed assets XE "Fixed Assets"  begin with account #200.  The program will include account numbers 101, 107, and 111 within the Current Assets account group.  The Other Assets group is not used by this company, and has been left blank.
Assign special account numbers.   For example, Progressive Farming Co. has designated general ledger account # 101 as its Checking Account.
Special Account Numbers
Checking Account. XE "Checking Account" 
Enter the checking account you will use for this set of books.  If you have more than one checking account, enter here the account you use the most often.  Go to Setup ! Company ! Expert Options XE "Expert Options"  and check the ‘Multiple Checking Accounts \Relate "BLUE_SKY.DOC!47", "Multiple Checking Accounts" \D2HTargetDefault ’ option to let the program know you will be ‘writing checks XE "Checks"  from’ and ‘making deposits to’ more than one checking account. Then Go to Setup ! Accounts ! and check-mark the box next to each checking account number. Every time you start to write checks, XE "Checks"  the program will now ask which checking account you wish to use. The checking account number that appears on this screen will be the most-recently used account.
Discount Account. XE "Discount Account" 
Use to track discounts taken on invoices.
Accounts Payable  XE "Accounts Payable" Account.
If you use the Blue Skies Accounts Payable program, set up this account. Otherwise, leave it as zero.  This is a current liability account that represents the total Accounts Payable due.
Accounts Receivable  XE "Accounts Receivable" Account.
If you use the Blue Skies Accounts Receivable program, set up this account. Otherwise, leave it as zero.  This is a current asset account that represents the total Accounts Receivable.
Interest Income XE "Interest Income" 

 XE "Interest"  Account.
If you also use the Blue Skies Accounts Receivable program, the interest charged to your customers for late payment of their bills is credited to this account number.  If you do not have Accounts Receivable, you can leave this account number as zero.
Miscellaneous Expense. XE "Miscellaneous Expense" 
In Accounts Receivable, if you wish to write off the balance owed by a customer, XE "Customer" 

 XE "Customer"  the written-off amount XE "Amount" 

 XE "Amount"  will be posted to this account.  If you don’t use accounts receivable, you may leave this account number as zero.
Closing Account. XE "Closing Account" 
This account is needed by the Year-end Closing \Relate "Blue_Sky.doc!31", "Year-end Closing" \D2HTargetDefault  XE "Closing" step (in Setup ! Company ! Reset Fiscal Yr Bal Fwd XE "Bal Fwd" ) to post the year’s profit or loss.
Touch your Save button to save your entries and exit this screen.
 XE "Fiscal Year" Setup Fiscal Year
Setup ! Company ! Set Fiscal Year
Use the ‘Setup Fiscal Year’ option to designate the first month of your fiscal year and to select your accounting method.  The fiscal year setup must be completed before any general ledger reports XE "Reports"  can be printed.
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Accounting Basis.  Click on either Cash or Accrual Basis Accounting.
Fiscal Year.  Click on the arrow and select the month that begins your fiscal year.
Budget Year.  Click on the arrow and select the month that begins your budget year.  In this example, Progressive Farming has chosen a calendar XE "Calendar"  fiscal year and a budget year that starts in November. When they print General Ledger Budget Report for January, the year-to-date XE "Date"  budget and expense totals will include amounts from November and December as well as January.  Your Budget Year cannot start after your Fiscal Year.
Touch your Save button to save your entries and exit this screen.
 XE "Password" Set Password
Setup ! Company ! Set Password
You can limit access to any set of books by setting passwords.  To gain access the operator must type in the correct password at the prompt.  Each set of books may be assigned different passwords.  In this example, ‘One Password’ has been selected.  It is ‘WXYZ’.  Passwords may be from one to four letters and/or numbers in length.  Lower case letters will be converted to upper case.  You may change the number of passwords you have (none, one, or two) and select new passwords as often as you like.
Tech note: AgData tech support can help you if your forget your password.
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Password Options
To enter or change your password, select one of the three numbered password options and click the ‘Enter Code’ button.  
No Password.  Click on ‘No Password', then on ‘Save’.
One Password.  When you select 'One Password', the word ‘Password’ will display under the ‘Enter Code’ button and the cursor XE "Cursor"  will flash to its right.  At the cursor, type in your password and click ‘Save’.
Two Passwords.  When you select Two Passwords, two password prompts will display under the ‘Enter Code’ button:  Clerical Password and Manager’s Password.  The operator with the clerical password can enter only checks XE "Checks"  and other transactions.  The operator with the executive password is needed to do setup or to print reports. XE "Reports" 
At the cursor, type in the first password.  Touch 'Enter' to move to the second password prompt.  Type in the second password and touch 'Enter'.
Touch your Save button to save your inputs and exit this screen.
 XE "Costing Options" Setup Costing Options
Setup ! Company! Set Costing Options
The costing option you select here will determine the amount XE "Amount"  of detail that will appear in your General Ledger, Cost Accounting, and Payroll reports. XE "Reports"   In addition, it will determine the appearance of the screens you will use to enter transactions.  For example, if you select ‘No Enterprise XE "Enterprise"  Accounting’ from the setup screen shown below, the prompts (questions) for Enterprise, Operation, XE "Operation"  and Equipment XE "Equipment"  number will not appear on your entry screens. 
If you use heavy equipment, AgData recommends you begin with the option ‘Ask Enterprise, Oper, and Equip#’ and change to the to ‘Ask Enterprise, Oper, and Equip#, &Equip Chargeout' XE "Chargeout"  at the start of the next year, when you have determined your equipment cost-per-hour.  If you do not use heavy equipment, but do have phases or operations of projects in progress, select ‘Ask Enterprise & Operation’.  Refer to Setup Enterprise \Relate "Blue_Sky.doc!39", "Setup Enterprise" \D2HTargetDefault  and Setup Operation \Relate "Blue_Sky.doc!40", "Setup Operation" \D2HTargetDefault  to see further definition of these terms and a sample code list.
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Costing Option Screen
If you do not use Blue Skies Cost Accounting
Select the ‘No Enterprise XE "Enterprise"  Accounting’ option listed in the Cost Accounting Level Box, and no Cost Accounting prompts will appear on any of your data screens.  Proceed to ‘Set Expert Options’.
Enterprise Group Descriptions
You may group enterprises XE "Enterprises"  into major and minor groups, giving each a description.  Enterprise Group Descriptions are addressed in more detail in Setup Enterprises \Relate "BLUE_SKY.DOC!39", "Setup Enterprises" \D2HTargetDefault .
Major
Click the arrow and select from the four major description categories listed: Project, Group, Crop, and Herd. 
Minor
Click the arrow and select from the three Minor description categories listed: Year, Project Year XE "Crop Year" , and Crop Year.
Click your Save button to save your entries and exit this screen.
 XE "Expert Options" Set Expert Options
These options are selected when checked.  For example, each time you enter transactions your typing will appear in upper case unless you return to this screen and uncheck the ‘Upper Case Input Only’ box.
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Expert Options Screen
 XE "Accounts Payable" Accounts Payable entries start in HOLD status
If you use the Blue Skies Accounts Payable program, and check this box, you can enter all your payables at once and print checks XE "Checks"  for just a few payables at a time.  A payable remains in HOLD status until you mark it 'released'.  Only then will a check be issued.
If you have Accounts Payable and leave this box unchecked, all entries will start in the READY status.  All checks will print unless you click on specific entries to place them in HOLD status.  
This option lets you specify the default XE "Default"  for new Accounts Payable entries.  The computer operator can specify which entries will change from that default.
Upper Case Input Only
If you prefer to type using both upper and lower case, leave this box unchecked - you will able to use ‘John Smith’ for an employee’s name.  On the other hand, if it is checkmarked, you may type in ‘John Smith’ – in both upper and lower case, but it will appear on your screen and in reports as ‘JOHN SMITH’ – in all capital letters.
 XE "Multiple Checking Accounts" Multiple Checking Accounts
Click this expert option if you will write checks XE "Checks"  from more than one checking account.  Then, when you select Quick Checks, Manual Checks, or Deposits, the program will display your list of general ledger accounts and ask you to select the appropriate checking account. Multiple checking accounts may be setup as well. 
 XE "Post Payroll" 

 XE "Multiple Wage Accounts" 

 XE "Job Codes" Post Payroll to Multiple Wage Accounts per Job Codes
Click this expert option if you want to post wages to more than one general ledger wage account. Usually, wage expenses are posted to the default general ledger account #600, WAGE EXPENSE or to another account number you will be able to specify later in Employer setup.  
If you want to post to account #600 as well as to account #601 OFFICE WAGES, and 602 MANAGEMENT WAGES, click this expert option, and set up these three wage expense accounts (600, 601, and 602). To reach the Wage Expense Setup screen, follow this path:  Setup ! Employer ! Setup Deductions ! Payroll Standard Deductions & Accounts ! Wage Expense. Then, add Office Wages and Management Wages to your Job Code Table at Setup ! Employer ! Job Codes.  Enter Job Code Number 1 as ‘Office Wages’ and Job Code Number 2 as ‘Management Wages’.  See the Job Code Table \Relate "Blue_Sky.doc!32", "Job Code Table" \D2HTargetDefault  for setup procedures.  When you complete these setup steps, wages can be posted to the new wage accounts.  The program will post wages entered under Job Code 1 to account #601, and wages entered under Job Code 2 to account #602.
Technical Note: The program will use 601 equal to the base Wage Expense Account number of 600 plus the 1 representing Job Code number one to post to GL account #601
Post Payroll w/ Summarized Timecard Lines
If you leave this option unchecked and then write a payroll with 100 employees doing the same job and post the payroll to General Ledger and Cost Accounting, you will generate 100 new general ledger transactions - one for each employee.  If you check this expert option, all 100 similar timecard lines for this same payroll will be totaled, and the program will generate a summary line that is posted to General Ledger and Cost Accounting. 
Computer Paychecks not alphabetized
If this expert option is checked, the paychecks will be issued in the order they were entered into the computer rather than in the alphabetical order of employee last names.  Some clients with large numbers of employees want paychecks to print out in the same order they were entered; e.g. the first timecard entered becomes the first paycheck printed.  It becomes easier to compare the paycheck amounts with the timecards because both checks and registers will be in the same order. (See Computer Paychecks ‘Check Printing Options’ for further options).
Touch your Save button to save your entries and exit this screen.
Set 1099 XE "1099"  GL Accounts XE "Set 1099 GL Accounts" 
You may print Form 1099 for Rents, Royalties, Non-employee Compensation, or Interest Income.  If you need to report any of these four, do the setup required by choosing ‘Set 1099 GL Accounts’ under the Setup Company menu choice.  Then Drag and Drop the Accounts from your Account Search list to the Rents, Royalties, Nonempl comp, or Interest Income boxes.  In the below example, account number 540, ‘Interest Income’ is the account number the program needs to add up for the 1099-Int forms.  Click on the ‘540’ line to highlight it.  Then drag and drop that account line into the 1099-Int Interest Income box, as shown below.  After the drop, it will appear in that box, similar to the ‘722, Rent, Irrigation Equipment’ line shown in the 1099-Misc Rents box in the upper left corner of this window.  Then any vendors with transactions to gl account #540 whose total dollar amount exceeds the minimum required for reporting, will have a 1099 when you choose print 1099 in Report Requests for GL reports.
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Also: read about other 1099 Setup described in Form 1099 Printing \Relate "BLUE_SKY.DOC!61", "Form 1099 Printing" \D2HTargetDefault .
Setup GL Account
Setup ! Accounts
Now that you have completed Company Setup, addressed at ‘Setup ! Company ! Set Accounts Design \Relate "Blue_Sky.doc!37", "Set Accounts Design" \D2HTargetDefault ’, and have established your General Ledger account design, you are ready to setup individual general ledger accounts.  Your general ledger accounts must be set up before you can enter transactions or post payrolls.  You may add new accounts throughout the year, but do not change account numbers or descriptions mid-year, or delete accounts once you have coded transactions to them.
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General Ledger Account Setup screen
Either click ‘Add New’ to add a new general ledger account or ‘Find Old’ to retrieve and update an already existing general ledger account.  If you don't remember which accounts are already set up, click ‘Find Old’ to look through your list of accounts.  Accounts are listed first in numerical order and then in alphabetical order.  Double-click on an account to retrieve it and begin the editing process. Touch your 'Escape' to put the list away without retrieving an account.
When you click 'Add New' the GL Account Setup screen will display.  The following descriptions will assist you as you enter account setup information.
Account Number.  Type in XE "Account Number"  your new account number here and touch 'Enter'.  The program will classify the new account according to the account design you specified in Setup ! Company ! Set Account Design.  For example, if you # 600, and you add a new account number 600, WAGES, the program will classify the new account an expense account and add it to the account list.
Checking Account.  The Checking Account XE "Checking Account"  box will appear to the right of the Account Number if you have turned on the Expert Option, ‘Multiple Checking Accounts’, and you have entered a current asset account number.  If you are setting up one of your checking accounts, click on this box. The new account will be included on the list of checking account numbers that displays when you begin entry of general ledger checks XE "Checks"  or deposits.  In addition, clicking on this box will inform the Check Reconciliation XE "Reconciliation"  module that these general ledger accounts are checking accounts.
Fiscal Year XE "Fiscal Year"  Balance Forward XE "Balance Forward"  will be zero for all income and expense accounts.
Income Tax Group.  Key in the group here.  Income Tax Groups will appear subtotaled on your balance sheet. XE "Income Tax Group" 
Cost Accounting Expense Type XE "Expense Type"  is only used for Expense (or Cost of Goods Sold) accounts only.  Click on the arrow to display the three choices: Custom Work, Rent, or Wages.  Click on your selection.  The principal use is Wage Account.  In the ‘Post Payroll XE "Post Payroll"  to Multiple Wage Accounts XE "Multiple Wage Accounts"  per Job Codes’ example, accounts 600, 601, and 602 were set up as Wage Accounts so the program, in Management Reports, XE "Reports"  and markup the wage expenses to cover Labor Burden.  Designate Wage Expense accounts as being a ‘Wages’ expense type, here, for those dollars to be included on Workman’s Comp Insurance reports.
To Edit Budgets XE "Budgets" , pulldown ‘Options’ and click on ‘Edit Budgets’ so it has a check beside it.  You may also use the shortcut key <F3> to toggle ‘Edit Budgets’ off and on.  When ‘Edit Budgets’ is disabled, the program won’t ask for any budget amounts, and will save you keystrokes.  If the start of your Budget year differs from the start of your fiscal year, you will see an additional field to the right of the total year budget display.  If, for example, in Setup ! Company !Fiscal Year \Relate "Blue_Sky.doc!38", "Fiscal Year" \D2HTargetDefault  we set our fiscal year to start on Jan ‘16 and our G/L Budget to start on Nov ‘15, you should enter the total expense for Nov ‘15 + Dec ‘15 in this additional box.  You may use ‘Autoset Nov-Dec 15 Actuals’ under the File pulldown menu to have the program look in the subdirectory where last year’s books were saved to determine the actual total expense of Nov ‘15 + Dec ’15 for all income and expense accounts.  In this case, those actuals will be compared to the Nov + Dec budget shown in this budget box.  Annual budget may be spread evenly over the year. Go to Setup! Accounts! Options!   You may also set GL Budgets from last year’s actuals. Go to Tools! Head Bookkeeper File Repair!  Edit! for this new feature.
Use the 'Add New' through 'Exit' Buttons, XE "Buttons"  as appropriate to save or discard changes.  To Delete an account, click on 'Find Old' to display the account list.  Double-click on the account you want to delete to retrieve it to the screen. Click on the 'Delete' button.  The account will be removed from the account list
Caution!  Do not delete any account codes that are being used by transactions or your general ledger reports will not print until they are reactivated (setup once again).
 XE "Enterprise" Setup Enterprise
Enterprises  XE "Enterprises" are major cost accounting breakdowns, and may be used in many different ways by each Blue Skies client.  The most detail-minded will classify each field or herd as a separate enterprise.  Others will group all fields of one crop into one enterprise.  For example, all fields of wheat, regardless of field or ranch number, are included in the wheat enterprise and all cornfields have become a second enterprise.  Another method is a combination of the first two. In this third method, all cornfields on one ranch form one enterprise, and all cornfields on a separate ranch form a second enterprise.  These enterprises could be called 'Corn, North Ranch' and 'Corn, South Ranch'.
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Enterprise Setup screen
Don’t want to use Enterprise Coding? If you don’t want to use Enterprise codes, return to Setup ! Company! Set Costing Options XE "Costing Options"  ! Cost Accounting Level and check ‘No Enterprise Accounting’.
If you do want the program to prompt for enterprise codes for income and expense transactions, and it is currently set up for 'No Cost Accounting', return to the menu above and select from one of the four options that specifies ‘Ask Enterprise’. 
Enterprise Number: An Enterprise number may be any number between 1 and 99999.  Some operators reserve the numbers from 1 to 100 for the current year’s enterprises, and numbers from 101 to 200 for the last crop year’s enterprises.  For example, Smith Ranch Corn, ’97 Crop, would be enterprise number 18 as shown in the Sample List of Enterprises, below.  The income and expense carried over from last years’ corn crop on the same ranch would be enterprise XE "Enterprise"  number 118, ’96 Corn on the Smith Ranch.  This numbering system is just a convenience to the user, it isn’t required by the program.
Administrative Overhead XE "Overhead" 

 XE "Administrative Overhead"  Enterprise. This must be Enterprise #1. In addition to crop enterprises, XE "Enterprises"  you will need an enterprise for administrative expenses like office and management expenses. 
Enterprises for Custom Work. XE "Custom Work"   Setup an enterprise number for custom harvesting; for example, your own grain drying and storage, your own seed cleaning and treating, or your own grain trucking.  Any portion of your business that you can hire done should have either an enterprise code or an operation XE "Operation"  code; so you can keep the costs separate and justify that your costs don’t exceed hiring that work done.  If your costs are higher, you should seriously consider hiring the work done.  If your costs are less than the custom rate, you may want to earn extra money by doing some custom work yourself.
Crop Overhead Enterprises.  Suppose you had twenty berry enterprises.  Coding the purchase of irrigation supplies like shovels for berry irrigators to any one berry field would be inaccurate because the shovels will be used on all berry fields in a ratio of the number of acres in each field to the total acres of berries. Charge these expenses to a Crop Overhead Enterprise like 'Berry Overhead'.  If berry field #10 were 25 acres out of 60 total acres in berries, or 41.67% of the total berry acreage, it would be charged with 41.67% of the cost of the shovels.  
Crop Description and Crop Number: Type in a description and any number between 1 and 99999.  Operators often use the lowest enterprise number as the crop number.  For this example, Berries are enterprise numbers 10, 11, 14, 27, 37, and 143.  The lowest berry enterprise number is ten, so ten is used for the crop number in all six of these enterprises.  The program will then, in the Operation Comparison Report, put the cost per acre of the Operations (PLANT, IRRIGATE, WEED CONTROL, HARVEST, etc.) for each berry field side-by-side in spread sheet mode so you can easily compare harvest cost per acre among all the berry fields.  The Enterprise Summary Report will let you combine all berry enterprises (all those enterprises that have Crop number =10) into one aggregate enterprise for enterprise budgeting XE "Budgeting"  and other purposes.
Tech Note: You can change the Crop Number and Crop Description as often as you like.  If you want to total all berry costs, follow the standard method, above.  For example, if you want to total the costs of all South Ranch fields, revise all enterprise setups to enter a ‘20 into the Crop Number field and, ‘South Ranch’ into the Crop Descriptions field.  Then, run the Enterprise Summary Report again.  The result will be as desired.  Then, change all enterprise setups back to the Crop Number grouping.
Crop Year.  XE "Crop Year"  The year this crop will be harvested.  This lets the program know, if you have both ’95 and ’96 enterprise numbers setup, to build one composite enterprise for ’95 Berries crop #10 and a second for ’96 Berries, even though it still may be crop #10.
Location. Your own description, such as ‘South 40’ or ‘Swickard 76’.
Divisor and Divisor Description: This field is 25 acres in size.  In addition to showing the income and expense items pertaining to this field, the reports XE "Reports"  will show the income and expense dollars per acre.  Other typical divisors are number of head in a herd, number of CWT (hundredweight), or TON for a grain drier or trucking operation. XE "Operation"   This divisor can easily be revised, so you can setup the grain drier with 250,000 CWT as the divisor initially, and at season end, when the actual quantity XE "Quantity"  is known to be 265,370 CWT, you can revise the enterprise XE "Enterprise"  setup from the estimated divisor to the actual divisor.
Month Divisor: Some farms may want a second divisor available.  For example, Dairies may want to know their income and expense per gallon of milk for last month, rather than using the cost per total number of gallons in the year.  Unless you have a dairy or similar business, just enter the same number as in the Divisor, above.
Equipment Repair (Shop) XE "Farm Shop Enterprise" 

 XE "Farm Shop"  Enterprise.  The Farm Shop usually is assigned Enterprise #2 – but checkmark this box if this is a Shop enterprise.  This enterprise is needed to track income and expenses for equipment XE "Equipment"  maintenance and construction.  A Farm Shop Enterprise is required if you wish to use Equipment Costing.
Edit Allocations XE "Allocations" 

 XE "Enterprise Allocations" : Suppose you had ten fields of Berries.  You could set up a ‘BERRY OVERHEAD’ enterprise as enterprise number twenty-five (or any other unused number).  Then, when you have expenses that are common to all berry fields, you just can charge the total dollar amount to Berry Overhead enterprise.  The program can allocate these expenses to all berry enterprises (probably on a percentage of total berry acres). In other words, for every item you code to enterprise number twenty-five, ten additional items will be automatically generated - one to each of the individual berry enterprises.  Check the 'Details' box to see all the details - account number, check number, check date, payee, memo and individual dollar amount (the dollar amount showing in enterprise #10 wil equal 41.67% of the total amount posted to Berry Overhead).  These pro-rations, or allocations, will be temporary, and will be erased after the Enterprise Detail Report is printed to avoid duplicating costs in your general ledger books.
If you don't want the details to show, leave the 'Details' unchecked, as was done for the 20.80% allocation of Enterprise #1 (Overhead).  Overhead has charges like telephone, legal fees, bank charges and other items that you don't want to show in detail in Berry field #10's enterprise detail report.  Leaving the 'Details' box unchecked will cause one line to appear in Operation #99, ALLOCATIONS, for the prorata share of the totaled enterprise #1.
Touch <F3> to enable entering allocations. (Enabling allocations here will have no effect on the printing of your ‘Enterprise Detail Report with Allocations’.)
Workman’s Compensation Insurance Report.  Often your enterprises and operations will have different labor experience rates.  For example, 'IRRIGATE' is lower than 'HARVEST' and 'OFFICE ADMIN' is lower than 'BERRIES'.  Being able to categorize wages according to labor experience rate and combine all field crops or orchards has the potential to save you thousands of dollars in Workman's Compensation premiums.
Using Job Codes can make it possible to re-group wage categories according to Compensation categories.  For example, to total all the FIELD CROP wages, setup a Job Code XE "Job Code Table"  using the Setup ! Employer ! Job Codes XE "Job Codes"  screen and then run File ! Reports XE "Reports"  ! Payroll Reports ! Print Workman’s Comp by Job Code.  See Setup Employer Job Codes for more information. \Relate "BLUE_SKY.DOC!32", "See Setup Employer Job Codes for more information." \D2HTargetDefault 
Use the 'Add New' thru 'Exit' buttons, XE "Buttons"  as appropriate, to save or discard changes.
A sample list of farm enterprises:
	Enterprise #
	   Crop
	Yr
	  Location
	  Divisor

	1
	1=Admin Overhead XE "Overhead" 
	15
	
	 300.40 Acres

	2
	2=Farm Shop XE "Farm Shop" 
	15
	
	 300.40 Acres

	3
	3=Ranch Overhead
	15
	  Smith Ranch
	 140.40 Acres

	4
	4=Crop Overhead
	15
	  All Berries
	  60 Acres

	10
	10=Berries
	15
	  Home Ranch
	  25 Acres

	11
	10=Berries
	15
	  Smith Ranch
	  35 Acres

	12
	12=Corn
	15
	  River Ranch
	  75 Acres

	14
	14=Wheat
	15
	  Smith Ranch
	 100 Acres

	18
	12=Corn
	15
	  Smith Ranch
	  65.4 Acres

	21
	21=Custom Harvest
	15
	
	  4000 Tons


 XE "Operation" Setup Operation
Setup ! Operations
Operations are the cost groupings within each enterprise.  Typical Crop Operations are Land Prep, Planting, Irrigation, Weed Control, Harvest, etc.  For construction companies, the enterprises will correspond to the project numbers such as building ‘John Smith’s Residence’.  Construction operations would be Site Prep, Foundation, Siding, Roofing, Plumbing, Electrical, etc.  They correspond to the subcontractors that may work on the project, on the enterprise as it progresses from its beginning to a finished residence.  Farmers can adopt a similar operation code structure to let them compare the cost of subcontracting an operation like 'WEED CONTROL' to the cost of doing it themselves, using ground application equipment, labor, and materials to spray the weeds. 
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Operation Setup screen
Don’t want to use Operation Coding?  If you don’t want to use Enterprise coding, go to Setup ! Company ! Set Costing Options XE "Costing Options"  ! Cost Accounting Level, and check ‘No Enterprise Accounting’ or ‘Ask Enterprise only’.  If, on the other hand, you want the program to prompt you for the operation codes for income and expense transactions, your Cost Accounting Level must be one of the three that specify ‘Ask Operation’.  
Operation Number. Can be any number between one and 299.  You have from 1 to 16 for income type operations, and from 17 to 299 for expenses.  Typically you use code 1 for INCOME, skip from two through 16 (operations reserved for special income operations that are seldom used), use 17 for LABOR BENEFITS, and 18 through 299 for expense operations that are generally set up in chronological order.
A typical list of operations for a farm would be:
	Operation #
	     Description
	Notes
	Operation #
	     Description
	Notes

	1
	INCOME XE "Overhead" 
	
	64
	REPAIRS & MAINT
	2

	17
	LABOR BENEFITS
	1
	70
	WEED CONTROL
	

	25
	OFFICE
	1
	74
	PEST CONTROL
	

	28
	LAND PREPARATION
	
	77
	FIXED COSTS
	3

	35
	CONSTRUCTION
	2
	82
	HARVEST
	

	36
	PLANTING
	
	84
	DRYING
	

	43
	FUEL & OIL
	2
	97
	RENT
	

	52
	FERTILIZER
	
	98
	MISCELLANEOUS
	

	58
	IRRIGATION
	
	
	
	


Notes:
1  for Administration Overhead, XE "Overhead"  enterprise#1, XE "Enterprise"  only

2  for Farm Shop, XE "Farm Shop Enterprise"  enterprise#2, only

3  for Farm Shop, enterprise#2, only = depreciation, insurance, taxes & licenses
Use the 'Add New' through 'Exit' buttons, XE "Buttons"  as appropriate, to save or discard changes.
 XE "Equipment" Setup Equipment
Setup ! Equipment
Equipment Numbers can be assigned either to individual pieces of equipment or to groups of equipment.  Using equipment numbers lets you retrieve the total cost and/or the cost-per-hour of running your own equipment.  You can maintain records on your internal equipment rental business and get the information you need to figure the profit or loss involved in owning individual pieces of equipment.  Also, you can compare the cost-per-hour of older equipment to that of newer equipment.  
When you pay a parts bill, a repair shop bill, or even enter a shop employee’s timecard line, you can enter the equipment number involved.  The Equipment Costing Report then sorts the year's expenses by equipment number and you receive a printout of your equipment costs by equipment number. 
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Equipment Setup screen
Equipment Number: Any number between 1 and 99999.  AgData recommends a numbering system as a convenience to users.  The program doesn't require it.  Some examples are:
    1-99
for pickups and cars
101-199 
for trucks (truck #3 would be equipmt# 103)
201-299 
for tractors
301-399 
for harvesters etc.
You can select your own range of equipment numbers.  If you have more than 100 pieces of equipment in one of the above classes, you could use 1-999 for pickups, 1001-1999 for trucks, 2001-2999 for tractors, 3001-3999 for harvesters, etc.  Of course, you can use the numbers 100, 200, and 300 if you wish.
Some operators simplify their equipment coding by grouping all tractors as Equipment #200, all trucks as Equipment #100, etc.
Chargeout XE "Chargeout"  Rate: Blue Skies Accounting( has an optional internal equipment XE "Equipment"  rental system.  You can rent your equipment to yourself.  If you wish to use it, go to the Cost Accounting Level question asked below and check the last cost accounting option, ‘Ask Ent, Oper, Equip#, & Equip Chargeout’.  Then you will be asked another question on this Equipment Setup form, ‘Chargeout Rate’ that will automatically be charged to the field when employees drive that piece of equipment.  For example, if you setup $27.50 here as the chargeout rate for equipment number 201, whenever you enter a timecard line saying a seven dollars per hour employee was driving equipment number 201 for ten hours XE "Hours"  on Enterprise XE "Enterprise"  number 11 (Berries on the Smith Ranch), Operation XE "Operation"  #28 (Land Preparation) the program will post that paycheck with 10 hours times $7.00 = $70.00 as wage expense for Land Prep on those Berries plus 10 hours at $27.50 = $275.00 as an equipment chargeout, as an internal equipment rental expense, for the use of that equipment.  The Machinery Management Report will compare the chargeouts with the actual expenses charged against that equipment number 201 to determine if $27.50/hour is too much or too low, given the number of hours that piece of equipment is used and the its actual repairs and maintenance cost.  If you can rent that Cat D7G for $27.50, commercially, but it costs you $40/hour to run, you should seriously consider selling your Cat!  The chargeout is an internal charge, it will not effect your general ledger books, only your internal management books.  This is called ‘standard costing’, this imputing of an hourly charge and is the method used by the most professional construction companies to determine which equipment is making them money and which they should sell.
Reset Equip Charges
Want to change your equipment chargeout rates?  Just change it on this form for each of your pieces of equipment.  Then do ‘File ! Reset Equip Charges’ and the program will revise all chargeouts in the year for all pieces of equipment to the current equipment rates.
Don’t want to use Equipment Coding?  If you want the program to ask you the operation codes for income and expense transactions, your Setup ! Company ! Set Costing Options XE "Costing Options"  ! Cost Accounting Level must be one of the two options that specify ‘Ask Equip’.  If, on the other hand, you don’t want to use Enterprise coding on any transactions, in that same option check ‘No Enterprise Accounting’ or ‘Ask Enterprise only’ or ‘Ask Enterprise and Operation’.
Use the Add New thru Exit Buttons, XE "Buttons"  as appropriate to save or discard changes.
Touch your Photo XE "Photo"  button \Relate "BLUE_SKY.DOC!59", "Photo button" \D2HTargetDefault  to take a photo of this piece of equipment and to store it on your computer’s hard disk.  Or use some other scanner or camera and store in \Foto1000 folder under the current year’s transaction file as EQP101.bmp for equipment #101.

 XE "Vendors" Setup Vendors & Customers
Vendors are businesses you write checks XE "Checks"  to.  In Blue Skies Accounting(, for convenience and to save disk space, these names and addresses also are used for Customer  XE "Customer" names and addresses.   You can setup you vendors before starting to write checks, or – if you aren’t a network user - you may setup vendors ‘on the fly’ by touching your <F2> shortcut XE "Shortcut"  key to setup the next vendor number (one higher than the highest previously setup) while entering a new check.
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Setup Vendors & Customers screen
Tech Note: Want a printout of this screen?  Do a Windows Print Screen.
Vendor Number (as used for Customer Numbers) is a number between 1 and 99999.  It cannot be zero.  Vendor numbers can be added throughout the year.  But if you have two different vendor numbers setup for XYZ Trucking, you will get two Form 1099 XE "1099" s for them.  Click your Find button to Speed Search to check to see if a vendor already has a number assigned to him before setting up a new vendor number. 
Phone Number  XE "Phone Number" and Fax Number:  XE "Fax Number" are for your own information.  You may leave them blank if you wish.
Federal ID# and ‘dba name’  XE "Federal ID" are used on Form 1099’s.  XE "1099"  If this vendor or customer may need a Form 1099, enter his federal identification number in this space.  But, on the other hand, if this vendor is an exempt corporation or in some other way will never need a Form 1099, leave this field blank and he never will get a Form 1099, regardless of payments made to him.  If the Federal ID# isn’t known, you may leave this input field blank and fill it in later, before running Form 1099’s.
Their acct# for you:  XE "Their acct# for you" If Central Farm Service’s bill to you says ‘Your Account No.: Prog001’, then if you enter this number , ‘Prog001’ in this field, it will print out on your check to them and be here for ready reference if you need to talk with their billing department.
Internal Notes: Entirely for your internal use so these notes will not be printed on outgoing checks XE "Checks"  or invoices (unless you want them to print on checks or invoices and make the simple changes in the Report Writer XE "Report Writer"  program).
Vendor Defaults: When you start to issue a check to Bank of America, it will be automatically be made out as $150 to general ledger account 748 and coded to Enterprise  XE "Enterprise" number 1, Operation  XE "Operation" number 98.  You may overtype these fields to recode them.
Overdue Interest  XE "Interest" Rate: If you have Accounts Receivable,  XE "Accounts Receivable" this question will appear.  In this example, you wouldn’t ever be billing Bank of America so leave the Overdue Interest XE "Interest"  Rate as zero.  But if this was a customer XE "Customer"  record, enter ‘18%’ to bill him at an annual rate of eighteen per cent on his unpaid balance.  But an even more convenient method would be to enter ‘Standard’ here and then in the procedure for changing interest on the overdue balance, pulldown the ‘Options’ menu for  ‘Set Standard AR Interest’ XE "Interest"  and specify the standard annual interest rate.  Then if you decide to start charging all normal customers 18%, up from 15%, you only need to make the change in one place, rather than calling up all your vendors XE "Vendors"  and changing their interest rate.  Of course, if you have a special circumstance customer that doesn’t get charged interest on overdue accounts, entering a zero here will instruct the program to not charge him interest, even if the standard is 18%.
Use the Add New thru Exit Buttons, XE "Buttons"  as appropriate to save or discard changes.
Touch your Photo \Relate "BLUE_SKY.DOC!59", "Photo" \D2HTargetDefault  XE "Photo"  button to take a photo of this vendor or of his business card and to store that photo on your hard disk.  Or use some other scanner or camera and store in \Foto1000 folder under the current year’s transaction file as VEN101.bmp for vendor #101.
Setup Employer
After you have done Setup Company: Set Company Name & Address to set your company, name, address, federal and state employer ID numbers, and state;  Set Account Design; [Set Fiscal Year XE "Fiscal Year"  not required for payroll]; Set Password; XE "Password"  Set Costing Option; Set Expert Option last two are used for payroll posting options then you are ready to setup employer minimum hourly wage rate, withholding descriptions, rates and other items.
 XE "Deductions" Setup Deductions
These parameters are company-wide instructions, they will be used for all employees.  This windows appears at: Setup ! Employer ! Setup Deductions.
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Setup Deductions screen
Enter your employer Federal ID XE "Federal ID"  number and State ID number.
Either type in your State abbreviation or use the drop down list to choose the two-letter abbreviation for your state.  These two letters determine the state income tax XE "State Income Tax"  table used to calculate accurate paychecks and reports.  If you have payrolls in two or more states, use a different client number for each state and then set the state code in each client number. Each time you run registers, you will find the state listed.
Any State Income Tax Withholding in Your State?
The 'CA' will be your own state as set in the State box. If your state uses income tax, check this box.  For those few states that have no state income tax, leave this box unchecked so your W2 forms can print properly.
Default Pay Period.
 XE "Default" 

 XE "Pay Period" If most of your new employees are paid weekly, mark ‘Weekly’ as the Default Pay Period, and so on.  When you setup a new employee, he then will already be setup as an who is paid weekly.  If he is a special circumstance employee who is paid monthly instead, just mark him individually as a Monthly employee.
Default Withholding.
If most of your new employees have Federal Income Tax,  XE "Federal Income Tax" State Income Tax,  XE "State Income Tax" Social Security, or State Disability withheld, mark them, above.  Then new employees will automatically be setup to withhold these items, thus saving you keystrokes.  As in all ‘defaults’, you can override them for particular employees, as desired.
Reset Minimum Wage Rates

If federal minimum wage hourly rates has changed, you may reset minimum wage rates in one powerful step at the start of the year. Not only can you change minimum wage, but you can mass change standard hourly rates as well.
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Payroll Standard Deductions
 XE "Deductions" This specifies which general ledger account gets posted with the Federal Income Tax, XE "Federal Income Tax"  State Income Tax, XE "State Income Tax"  etc. withheld from employees for each payroll.  It also specifies the Wage Expense account number.  These GL accounts must be setup in Setup ! Accounts.  Just listing them here doesn’t set them up.  These are just the general ledger posting instruction to the program for each payroll posting.  The ‘deduction rate’ and ‘maximum subject to’ also is set here.  In the above example, FICA,  XE "FICA" the Employee’s Share of Social Security, will be posted to general ledger account number 303 for 6.20% of the gross  XE "Gross" wages until an employee’s year-to-date  XE "Date" wages total $84,900 when the program will stop deducting FICA from that employee and will mark his subsequent wages as exempt from employer’s tax on his wages, also.  On the other hand, medicare presently has no wage limit, all wages are subject to medicare.  So enter either an ‘A’ that will appear as an ‘ALL’ – or you may enter 1000000 or more and an ‘A; will appear under ‘Max Subj’.
Employers in States other than California will not want to have one of their Standard Deductions columns named ‘SDI’, which stands for ‘State Disability Insurance’ for California employers.  Use the elevator box on the right edge of the Payroll Standard Deductions and Accounts list box to scroll down to the ‘SDI/$’  XE "SDI" description.  Then type in ‘L&I/H’ XE "L&I"  for ‘Labor and Industry’ if a State of Washington  XE "Washington" employer,  ‘SAIF/H’ XE "SAIF"  if a State of Oregon  XE "Oregon" employer, etc.  That ‘L&I’ or ‘SAIF’ description will appear on all payroll reports XE "Reports"  instead of ‘SDI’ and it will be deducted as a $/hour instead of $/dollar gross wage.  Enter a ‘J’ in the rate column and the $/hour deduction rate will be determined by the job code \Relate "Blue_Sky.doc!32", "job code" \D2HTargetDefault  XE "Job Code Table" table. Enter employee rates so employee deductions will be calculated and properly withheld from paychecks. Replace job code number defaults (1,2,3,…) with state of WA four digit ‘class code’ to make report more meaningful.  Prior to running L&I report, edit the job code table replacing employee rates with the employer rates. Edit it again before running the next payroll. (You can shortcut this step by saving two (2) different jobs####.dbf files with employee rates/employer rates to different folders and swapping when necessary).
Deductions, Benefits, and Accruals.
 XE "Benefits" 

 XE "Accruals" In addition to all the Payroll Standard Deductions handled in the previous list box, each employer can have up to 15 of his own columns that can be used for Employee Special Deduction,  XE "Special Deduction" 

 XE "Employee Special Deduction" Employee Benefit, or Employee Accruals.
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Special Deductions Setup in Setup Employer Deductions XE "Setup Employer Deductions"  window
Employee Special Deduction:
Suppose employees contribute to their Health Insurance plan.  Typically an employer will pay the employee’s health insurance and the employee will pay for his spouse and children.  Say Employee number 1 withholds $25 from each weekly paycheck and employee number 2 withhold $37.50 from each of his weekly paycheck.  As you setup each employee \Relate "Blue_Sky.doc!14", "setup each employee" \D2HTargetDefault , you will specify whether or not each of these deductions or taxable benefits will apply to him.
Under Description, enter ‘H.INS’ to abbreviate health insurance in eight characters or less.
Under Deduct, click the box or touch space bar to indicate that these amounts will be deducted from the employees gross pay on each paycheck.  On the other hand, if you want to accrue vacation days, for example, don't check the deduction box.
Under Multiplier click on that column until ‘Flat’ appears or enter ‘F’ and ‘Flat’ will automatically appear.  Other Multipliers (or coefficients) are ‘G’ for per cent of Gross XE "Gross"  pay, ‘D’ for dollar amount XE "Amount"  charged for each Day worked, ‘W’ for dollar amount to be charged for each Week worked, ‘H’ is a dollar/Hour charge, ‘N’ is a percentage of Net paycheck, ‘P’ is a dollars per unit of piecework rate.
Under Account#, enter ‘351’ to instruct the program to post these withholdings  XE "Withholdings" to GL account #351.  Account Numbers are required for deductions XE "Deductions"  and are not used for non-deductions - enter a zero for non-deduction lines like the Vacation XE "Vacation"  Days earned line.
W2 Special: W2 forms XE "W2 Forms"  have a space for ‘Advance EIC Payment’, XE "EIC Payment" 

 XE "Advance EIC Payment"  ‘Dependent care benefits’, a general box for 401(k) savings programs, XE "401(k) savings programs"  and others.  If your employees participate in one or more of these plans, setup a special deduction XE "Special Deduction"  (it can be either a deduction or a non-deduction item), touch your spacebar, up/down arrow to the desired W2 special code and then touch your <Enter> key.
Taxable Benefit: Suppose you provide some employees with a pickup truck.  Your accountant may tell you that $25.00 per week must be taxable for those employees.  Enter ‘PICKUP’ in the description column. Under Account# you may enter a zero because you aren’t deducting from employees.  Under Multiplier, enter an ‘F’, for a flat amount.  Then enter a ‘Y’ for ‘Yes’ or ‘N’ for ‘No’ under each four subject-to columns.  In this case, the $25/week is subject to federal and state income tax XE "State Income Tax"  and for FICA, XE "FICA"  enter a ‘Y’ under these three columns, but this benefit isn’t subject to SDI, XE "SDI"  enter an ‘N’ under that column.  Then when you setup an employee, you will have a box to enter his Pickup Benefit’s flat amount.  For this employee enter ‘25’ for ‘$25.00’.  For the employees who aren’t provided a pickup, just enter a zero under the Pickup column for them.  Then, when this employee has a gross weekly paycheck of $100.00, the income tax will be calculated as though his paycheck had a gross of  and additional $25.00 for a total of $125.00.  His W2 form at year end will show the total of the $25.00/week benefit provided in the appropriate boxes.
Employee Special Accrual: Suppose you want to track some other total for your own information, such as Vacation XE "Vacation"  days accrued.  Enter ‘Vacation’ in Description, Enter zero in the gl Account Number column, Enter ‘W’ in the Multiplier column if employees accrue perhaps ½ day of vacation per Week worked.  Then under each employee setup, enter ‘0.50’ or zero for those employees who aren’t earning vacation days.  When an employee takes 5 days of vacation, during his timecard input, go to his special deduction box and enter ‘-5’ and the program reduce his total vacation days by five days.  Under an employee’s setup screen, you can scroll through his year-to-date XE "Date"  total gross, standard deductions, special deductions, and special accruals XE "Accruals"  to review the status of his vacation days.
Other Employee Information.
 XE "Employee Information"  You have eight boxes of additional information you can keep on each employee.  The descriptions for those boxes are set here.  In this example, the first is used for ‘INS Registration #’ so on each employee his Immigration and Naturalization System Registration number can be recorded.  The second is used to record each employee’s INS expiration date.  The third is used to record the employee’s phone number. XE "Phone Number"   Others commonly used are: ‘Termination Date & Why’, ‘Spouse’s Name’, ‘Driver’s License #’.
W2 Type of Employment.

 XE "Employee Information"   Magnetic reporting of W2 Information XE "W2 Forms" , Employees' Annual Wage Information and other reports require you to indicate your type of employment.  For example, if you are classified as an agricultural employer (you follow withholding rules as set forth under agricultural employer subsections of the law), click on the 'Agriculture' employment type so ‘Agriculture’ is highlighted.

W2 Specials Code – W2 Box 12 – 401(k), Tips, other
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Box 12 on W2 forms must be used to show a variety of special codes.  In Blue Skies, you can designate one or more Special Deductions as an employee deduction or an employee benefit subject to taxation.  This W2 has Code ‘D’, which a 401(k), pre-tax employee deduction. So, to setup a deduction for 401(k), for example, choose Options ! Add W2 Special Codes as above.
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This brings up this list of Special Codes to be used on W2 forms.  To use a special deduction for ‘Simple 401(k), click on it, hold down your left mouse button and drag it to the box on the right.  The codes on the right can be used for Special Deductions.

List of W2 Special Deduction Codes
To make ‘Simple 401(k)’ an option for ‘W2 Special’ in Special Deductions setup, follow the below model.
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Click on the right box of this Special Deduction (#7 in this case), a dropdown box will appear and select ‘401k Simple’.  Every employee now can specify a percentage of his gross to be designated 401k.  Or you can set the Multiplier as ‘Flat’ and a flat amount will be withheld from every paycheck.  Of course, each employee will have their own rate.  Set the 401k rate to zero in Employee Setup for employees who do not participate in 401k program.

But suppose 401k is specified here as Gross% and an employee is set at 8% rate.  That employee will have 8% of gross of each paycheck set aside as 401k.  If the paycheck was $1000 gross, then $80 will be deducted from Gross for purposes of FIT and SIT, income tax will be computed on $920 instead of on the $1000 gross pay.  FICA, SDI, FUTA, SUI all will still be calculated on $1000 gross.  Note: States of Pennsylvania and Mississippi are the only states that don’t deduct 401k deduction from SIT calculation.  BSA will perform correctly for employers in these two states.
If you done show ‘401k Simple’ as a drop down menu option under ‘W2 Special’, click on the ‘W2 Special’ box to add it to, to activate it in, your list of W2 Specials.
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Drag and Drop the ‘Simple 401(k)’ from the left box into the right one using the instructions in the yellow text box.
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 XE "Employee Information"   Magnetic reporting of W2 Information XE "W2 Forms" , Employees' Annual Wage Information and other reports require you to indicate your type of employment.  For example, if you are classified as an agricultural employer (you follow withholding rules as set forth under agricultural employer subsections of the law), click on the 'Agriculture' employment type so ‘Agriculture’ is highlighted.

Use the Save button to save & exit.
 XE "Withholdings" 

 XE "Payees" Payees for Withholdings
If, after every payroll, you wish to have the program write a check to a bank or other agency to deposit the payroll withholdings, choose the pulldown menu ‘Payees’ on the Setup Payroll Deductions XE "Deductions"  to show a list of deductions.  In the column to the right.  To issue a check for the total Federal Income Tax  XE "Federal Income Tax" at the end of the payroll to Bank of America, click on ‘Federal Income Tax’, the box to the right of it will be highlighted with a blue background color, type in ‘BA’ and the vendor search list will appear allowing you to choose ‘BANK OF AMERICA’ [you first need to setup Bank of America as a Vendor in Setup ! Vendors XE "Vendors" ]. 
To no longer issue any check for FIT XE "FIT"  withheld, click on ‘2, BANK OF AMERICA’ beside ‘Federal Income Tax’, and then touch your <Delete> key.
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Payees for Withholdings screen
 XE "Job Codes" Job Codes
Job Codes can be used for several purposes:
Workman’s Compensation XE "Workman’s Compensation Insurance Report"  Insurance Reports. XE "Reports" 
Deduct from Employees per their job.
Post Wages XE "Post Wages"  to Different General Ledger Accounts.
Temporarily subtotaling groups of wages.
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Setup Job Codes screen
Tech Note: Want a printout of this screen?  Do a Windows Print Screen.
Job Codes can be any number between 1 and 99999 (you cannot have a Job Code number zero!)
To setup Job Codes, enter Setup ! Employer ! Job Codes.  To enter a line, either do Edit ! Add Line at End or just hold down your <Ctrl> key and touch your <Insert> [or your <Ins>] key.  Job Codes can be any number between 1 and 99999 but you should only use between 1 and 99 without contacting AgData tech support.  The Job Codes can be entered in any order.  The first line above could be job code XE "Job Code Table"  #99, the next job code #2, the next job code #90, etc.
This employer is using Job Codes for his Workman’s Compensation Insurance Reports.  He has four workman’s comp work classifications, Irrigators, Office Work, Orchard Wages, and Field Work.  The completed job table below will trap all Irrigation Wages because those timecard lines will be coded to Operation XE "Operation"  #58, IRRIGATION.  Office Wages will all be coded to Enterprise XE "Enterprise"  #1 (Administration Overhead XE "Overhead" ), and to Operation #25, OFFICE.  His Orchards are Enterprises XE "Enterprises"  20 through 39, 48 and 49, and his FIELD WORK are enterprises 1 thru 19 and 40 thru 47.  He will have Irrigation wages in both the Orchards and the Fields but because the IRRIGATION line occurred first in this table, it will take precedence.  In other words, a timecard line coded to an orchard enterprise number 20, with an operation code of 58, Irrigation, will appear under Irrigation wages, not under the Orchard wages.  The Workman’s Comp Report will total these four types of wages, multiply them by their respective workman’s comp insurance rates of 6.25%, 4.11%, 8.55%, and 17.25% and show the insurance by workman’s comp insurance rate class.
Deduct from Employees per their job code: XE "Job Code Table"  If the employer was a Washington XE "Washington"  State employer or an Oregon XE "Oregon"  employer, his L&I XE "L&I"  or SAIF, XE "SAIF"  respectively, is deducted by dollars per hour in a work classification.  He would go to the place where he redefined the California ‘SDI’ to ‘L&I’ in Setup ! Employer ! Setup Deductions. XE "Deductions"  Under the ‘Rate’ column, he entered a ‘J’ for ‘Job Code XE "Job Code Table"  Table’.  He would have clicked on Deduction = ‘Yes’ instead of leaving them as ‘No’ as was shown in the previous example screen.  And the Rate would have been the Hourly Rate. For example, an Irrigator would have $.0625/hour deducted for SAIF or L&I.
Post Wages to Different General Ledger Accounts: XE "Post Wages" If the employer wanted these wages posted to general ledger accounts 601, 602, 603, and 604 respectively for Irrigation Wages, Office Wages, Orchard Wages, and Field Crop Wages:
Set up the job code table as above
Under Setup ! Company ! Expert Options XE "Expert Options"  set ‘Post Payroll XE "Post Payroll"  to Multiple Wage Accounts XE "Multiple Wage Accounts"  per Job Codes’ to true (checkmarked).  
The ‘600’ that is added to each of the job codes XE "Job Codes"  one thru four is the 600 set as the Wage Expense gl account in the Payroll Standard Deductions & Accounts list under Setup ! Employer ! Setup Deductions.
Setup GL Accounts 601, 602, 603, and 604 and mark them as ‘Wage’ expense type.
Temporarily subtotaling groups of wages:  Since you can revise the Job Code Table as often as you wish, in between payrolls you could redefine the Job Code Table to total all wages on the South Ranch enterprises, XE "Enterprises"  for example.  Just remember to change the Job Code Table back before writing and posting the next payroll.
 XE "Tax Tables" Tax Tables
You will have two tax tables, one for Federal Income Tax XE "Federal Income Tax"  and a second for your State Income Tax. XE "State Income Tax"   Under Setup Employer!Setup Deductions \Relate "BLUE_SKY.DOC!12", "Setup Employer!Setup Deductions" \D2HTargetDefault , you specified your state’s abbreviation.  This abbreviation will point to your state’s tax table.  If your state income tax amounts withheld from employees aren’t correct, verify that your state is properly specified.  For example, if you are a State of Washington XE "Washington"  employer and this box in your Setup Employer Deductions says ‘CA’, your state income tax rates will be California’s, not Washington’s.
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Setup Income Tax Table screen
Tech Note: Want a printout of this screen?  Do a Windows Print Screen.
AgData recommends you use your local dealer to maintain your income tax tables.  But if you need to enter or revise your state tax tables, use the Annual Payroll Rate tables from your state or federal employers’ tax guide.  Do Control / Insert (hold down your <Ctrl> key and touch your <Insert> key) to add each new line.
When you install Blue Skies just before January 1st, the latest federal and state income tax tables will automatically be installed on your computer.
Setup Employees
Each Employee Has His or Her Own Setup Information:  Click ‘Add New’ to assign the next available employee number to this new employee and that number will then appear in the ‘Number’ box just to the left of the employee’s photo. XE "Photo"   Enter the employee’s name, address, social security number as they should appear on W2 forms XE "W2 Forms"  and other payroll reports. XE "Reports"   This employee will have $25/paycheck deducted from each of here weekly paychecks XE "Paychecks"  for H.INS, for her contribution to Health Insurance.  She has 14.50% of each of the gross XE "Gross"  on each of her paychecks will be deducted for CHILD CARE.  She has a zero in Vacation XE "Vacation"  so she doesn’t accrue vacation days with each paycheck.  If, hypothetically, she accrues 10 vacation days (2 weeks) over the 52 weeks of the year, enter 0.1923 as the Flat rate (10 ÷ 52 = 0.1923 days accrued per week) – so you would enter ‘0.1923’ in the rate column.  These special deductions, XE "Deductions"  their descriptions and basis for deduction (flat, percent of gross, etc.) are setup in employer setup deductions \Relate "Blue_Sky.doc!12", "employer setup deductions" \D2HTargetDefault .
[image: image28.png]Employee Setup

File  Options

Mome  IANERAMIREZ

idess  1Z4MANSTREET  Ciow
o s
tw " amoiey

S Ca zip ssus

Soci Sec 8 534419555

Duto Heed - 15/10/00 -
Dot ol Bith 10/24/45

Std Pagrate  $6.50 ™ No Min Wage |

CViibholding Speciations
~Marital Status ——— Exemptions
® Manied_O Single O Head of Houschold | [2 =
Paid

© Weekly O BiWeekly O Semi-Monthly O Monthly O Annually

Standard Deductions:

Special Deductions & Benefits————

Federal Income Tax | | [Deserption [ Multipher |_Rate_J=
Addnl FIT $0.00 HEALTH Flat 00

[ State Income Tax XinasPlan | ¥Gioss | 32.00%
Addol SIT $0.00 Vacation | Flat
Social Securty i Fiat
State Disabilty Ins i

Descriptions & YTD$ 5

M 2ose

Browso Emplopes
NS Regisotiont— [EREEXET

NS Mogh Exp Date 112715705 ] B
canD TYPE 551





Employee Setup screen
Before setting up any Employee, First Setup the Employer to Define the Special Deductions and their multipliers, Descriptions shown starting in the lower left of this screen.
 Look for the additional ‘options’ of setting up employees.  
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If you have an employee who worked last year, and is now working again, use this step to fill in all the employee’s blank fields and you do not have to use the same employee number.
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Descriptions & YTD $:  Use the ‘elevator box’ on the right edge of this list box to view her year to date gross XE "Gross"  and deductions. XE "Deductions"   These cannot be edited here, you will get a beep and an information message box if you try.  But her custom descriptions \Relate "BLUE_SKY.DOC!12", "custom descriptions" \D2HTargetDefault , her INS Registration Number and Expiration Date, her phone number, XE "Phone Number"  her driver’s license number and whatever questions were setup in : Setup ! Employer ! Setup Deductions ! Other Employee Information XE "Employee Information"  can be edited here.
Are old employees coming back to work? Use the new Edit! option ‘Get Employee Setup from last year’s data!
Display Year’s Paychecks:  Under File, choose this pulldown menu item to display (and optionally to print) all the paychecks for this employee.  Any pending computer paychecks will appear with check date and check number as blank or zero.
Tech Note:  If you get a ‘BReport Not Enabled’ error when you try to do this command, your Reports.dbf is damaged.  Exist Blue Skies and then reinstall your latest Blue Skies Accounting master installation disks.
Crews:  Employees are assigned to crews during timecard input’s Edit Crews \Relate "BLUE_SKY.DOC!55", "Edit Crews" \D2HTargetDefault . XE "Crew"   If crews already have been initially setup over there, on this employee’s setup screen you will see her assigned crew number above and to the right of her employee number.  You can then change her crew number here – or enter a ‘0’ (a zero) to remove her from all crews.
Employee Photo XE "Photo"  or Driver’s License Image:  Use the Photo \Relate "BLUE_SKY.DOC!59", "Photo" \D2HTargetDefault  button and procedures to save an image with this employee.
Use the Add New thru Exit Buttons, XE "Buttons"  as appropriate to save or discard changes.
In addition:
> Use Options ! Social Security# Lookup (either click on it or use your <F8> key to check mark this option).  Then when you click on your <Find> button, employees will be listed in social security number order instead of the usual list of employees by employee number and by name.
> Touch Photo \Relate "BLUE_SKY.DOC!59", "Photo" \D2HTargetDefault  to take a photo of this employee.
> Touch Print to print this employee setup screen to your laser or ink jet printer.  Under the ‘Options’ pulldown menu, you can choose whether or not this report will include any employee photos.
> Touch Badge XE "Badge"  to printout a photo ID badge XE "ID badge"  for this employee that even can have a bar code on the badge for the employee’s number that can be used by bar code readers. 
Have your dealer text edit the file ‘C:\BLUE_SKY\EMP_BADG.TXT’ to customize the photo ID for you and to specify to the program the name of your installed windows bar code font.  This file is shipped with Blue Skies and contains technical instructions how to customize the ID Badges.
Chapter 4    Running Blue Skies
 XE "GL Checks" 

 XE "Checks" Writing GL Checks procedures
Do all setups: Setup Company \Relate "Blue_Sky.doc!43" \D2HTargetDefault , Setup GL Accounts \Relate "Blue_Sky.doc!9", "Setup GL Accounts" \D2HTargetDefault ,  etc.
Enter the new transactions by using the appropriate Transaction pulldown menu items -  XE "Reports"  Quick Checks and Manual Checks \Relate "Blue_Sky.doc!10", "Quick Checks and Manual Checks" \D2HTargetDefault . Enter the payees, XE "Payees"  dollar amounts, and other coding for the new checks.
When done entering checks, touch the Print Button on the check input form to print the Checks and Check Registers.
Accounts Payable XE "Accounts Payable"  Checks to enter Due Dates for projected cash requirement reports. The procedures for entering data for A/P is the same as Quick Checks except that Due Date is also asked. Operator chooses status of payable checks to ‘Hold’ or ‘Ready’.   You may individually or select by groups which payable checks to hold or release.  You can do a ‘Heading Click’ to re-sort these transactions in Vendor# order, date order, etc. You can ‘Find’ to limit the list to a group of vendors, by due date, etc.
Post the checks using the command under the ‘File’ pulldown menu in the Print Reports \Relate "Blue_Sky.doc!44" \D2HTargetDefault  screen.
 XE "Paychecks" Writing Paychecks procedures
Do all setups under Setup Company \Relate "Blue_Sky.doc!43" \D2HTargetDefault .
Do all setups under Setup Employer \Relate "Blue_Sky.doc!11", "Setup Employer" \D2HTargetDefault , especially Setup Employer Deductions XE "Setup Employer Deductions" 

 XE "Deductions"  \Relate "Blue_Sky.doc!12", "Setup Employer Deductions" \D2HTargetDefault  and Setup Tax Tables \Relate "Blue_Sky.doc!13", "Setup Tax Tables" \D2HTargetDefault . XE "Tax Tables" 
Do Setup Employee \Relate "Blue_Sky.doc!14", "Setup Employee" \D2HTargetDefault  for each employee who is going to receive a paycheck.
Do Computer Paychecks \Relate "Blue_Sky.doc!16", "Computer Paychecks" \D2HTargetDefault  to enter timecard hours, XE "Hours"  piecework quantities, and payrates and to force deductions \Relate "Blue_Sky.doc!20", "force deductions" \D2HTargetDefault  if you wish to override the programs tax table lookup amounts and employee’s normal withholdings. XE "Withholdings" 

 XE "Forced Deductions" 
Select File ! Print after entering timecard hours.
Print Checks XE "Checks"  and Registers \Relate "Blue_Sky.doc!44" \D2HTargetDefault 
Post \Relate "Blue_Sky.doc!45" \D2HTargetDefault  the checks using the command under the ‘File’ pulldown menu in the Print Reports XE "Reports" 
 XE "Accounts Receivable" Accounts Receivable procedures
Setup for Accts Receivable
Do all setups: Setup Company \Relate "Blue_Sky.doc!43" \D2HTargetDefault , Setup GL Accounts \Relate "Blue_Sky.doc!9", "Setup GL Accounts" \D2HTargetDefault ,  etc.
Enter Invoice Charges
Enter new invoice billing lines by using the Accounts Receivable \Relate "BLUE_SKY.DOC!52", "Accounts Receivable" \D2HTargetDefault  menu item under the Transactions pulldown menu XE "Accounts Receivable" . Enter the payees, XE "Payees"  dollar amounts, and other coding for the new invoices using the same procedures as entering checks, XE "Checks"  except that you have one additional option - you can touch your <F7> or use your Edit pulldown menu to Edit Invoice Notes.  You can enter up to ten lines of notes that will appear on this invoice.  Users often use these notes for ‘Shipped to’ information or as a packing list.  These invoice notes are optional, you don’t have to use them.
When done entering invoice lines, touch the Print Button on the check input form to print the Invoices.  Click ‘Yes” when the question comes up, ‘Print Invoices Now? (Click ‘No” for monthly A/R Reports XE "Reports" )”.  You will need to File ! Post Invoices after successfully printing the invoices. 
Enter payments received during the month as a normal Deposit \Relate "BLUE_SKY.DOC!53", "Deposit" \D2HTargetDefault  under the Transactions pulldown menu.  Your customer’s number will be entered in the Vendor number field.  If you have a customer's deposit returned XE "deposit returned"  for 'insufficient funds XE "insufficient funds" ', you must use the procedures described in the 'Deposits \Relate "BLUE_SKY.DOC!54", "Deposits" \D2HTargetDefault ' instructions.
Month End A/R Procedures
Charge Interest on Late Payments.  Use ‘Set Standard AR Interest’ to 18.00 percent or whatever annual interest rate you charge.  Next ‘Set Aging Columns’ to ‘30-60-90’ days or whatever aging columns you wish to show on the customer’s month end statement. Then do File ! Charge Interest on O/S Balances which will charge interest to all customers who have outstanding unpaid balances.  If you select ‘30-60-90’ days aging, the program will charge 1½% on unpaid balances for these month end reports (1½% is 30days ( 360 days in the year * 18.00% annual interest rate).  Then you are ready to choose File ! Print to print month end statements and other month end reports.
Print Month End Reports will include interest XE "Interest"  on unpaid balances, will show 30-60-90 day aging XE "Aging"  [or you can reset this aging to 15-30-45 or other aging period in the monthly A/R Reports window] of outstanding balances in several different A/R reports.  To print these month end A/R reports, click ‘No’ to take you to a special, month end processing of A/R invoices and payments received. You must print statements before Auto Resolve to show deposits made on account.
Click ‘Auto Resolve’.  The program will automatically credit deposits received against balances due.  Then you will need to click ‘Hand Resolve’ to resolve the remaining payments - partial payments on account either because that was all the customer XE "Customer"  to afford to pay or because they disagree with your billed amount XE "Amount"  or they had a merchandise return that hasn’t been entered, etc.  Click on one or more payments, click on the 'Hand Resolve' button and then click on one or more charges that will be paid off by the marked deposits. You may use the Multiple Line Select XE "Multiple Line Select"  method to quickly select many transactions and/or to unselected all lines.  Normally you will have ‘Include Paid Charges’ turned off so you will see only those invoice charges that haven’t previously been resolved as being paid.  If you wish to see all the customer’s charges in the year, turn ‘Include Paid Charges’ on so it is check marked under the ‘Options’ menu.
Use the AR Diagnostic Analysis report to determine any mistakes during the month (avoid year end headaches).
File Pulldown Menu
To pull down the ‘File’ menu, either click on ‘File’ and continue to hold down your left mouse button, or hold down your ‘Alt’ key and touch the underlined letter -‘F’.  
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When the File menu drops down, move your cursor XE "Cursor"  to highlight a menu item, and click once to select it and to display the menu of File options. Like any standard windows program, you can click on the Exit option to Exit Blue Skies Accounting, or you can exit by double clicking on the Control-Menu Box—the small gray box containing a black dash, located at the top left of the window, just above the ‘File’ pulldown menu.
AgData recommends making Backup Client to a USB Jump Drive (aka Zip Drive) to copy all data for the 2016 year for the current client.  Then if your computer is infected by a virus or has a hardware failure, you can easily copy all your 2016 YTD (year to date) setups and transactions to another computer.

 XE "Close Client" Close Client
To Change to a previous (or another)  set of Company's Books, choose ‘Close Client’ under the ‘File’ pulldown menu], then re-open new set of books by  File ! Open Client’s Books and choose the company or another subdirectory.
 XE "Backup Client" Backup Client
Backup is under the File pulldown menu.  
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-or under Head Bookkeeper File Repair under the Tools main menu:
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All of your entire year’s payroll and general ledger and cost accounting data for Progressive Farming Company will quickly be backed up’d. If you have a virus or other computer hardware problem, or if you make a major mistake doing an end-of-year closing or other procedure, you can Restore XE "Restore"  \Relate "Blue_Sky.doc!28", "Restore" \D2HTargetDefault  to overwrite all that damaged data.  Of course, any good changes made to your data since the backup will be overwritten also.  AgData recommends backing up after each week’s input.  USB Memory Card (also known as Jump Drive or Flash Drive) will store 180 years of weekly backups on the same drive.  
Restore and Test

It is a good idea to make two backups and test them using the ‘Test Backup Disk’ procedure. (Warning: if you Restore, you will overwrite all your data!  You can Add a new Client using your same client number in a different folder (such as c:\blue_sky\testdata, change to that test folder, then restore into that folder to test - and to experiment and learn - backup and restore procedures).
After you have completed a backup of your client number XE "Restore" , this message will appear:
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Backup and Restore into the Cloud Storage
Under Tools ! Head Bookkeeper’s File Repair, you can backup into Cloud.  AgData has huge disk storage reserved as free ‘mini storage’.  This provides you with safe, free, off-site storage in case of truly catastrophic circumstances such as computer failure, maliscious employee, or other such problems.  If your company has more than one office, you can provide your high-level bookkeeper’s password to the other office so they can download and replace ALL the data for your client number books at the second (or third, etc.) office.
 XE "Restore" Restore Client

[image: image35.png]Tools Help=F1 PROGRESSIVE FARMING CO, #1000 in C:\Blue_Sky\DemoData\2016DATA

Head Bookkeeper File Repair
File | Edit

Backup and Restore Backup to a Local Disk
Restore from a Local Disk
Upload a Backup into Cloud Storage
Restore from a Backup in Cloud Storage:

Rebuild Al Indexes

ErrorLog

Bit










Restore is under the Tools! Head Bookkeeper File Repair \Relate "BLUE_SKY.DOC!64", "Head Bookkeeper File Repair" \D2HTargetDefault ! File pulldown menu – listed as ‘Restore Data from Local Disk’ or Restore from a Backup in Cloud Storage.  You will be able to overwrite the information on your hard disk with the information on a previous Blue Skies backup diskette made with Blue Skies’ ‘Backup Client \Relate "Blue_Sky.doc!29", "Backup Client" \D2HTargetDefault ’ procedure. 
Warning: This procedure is not reversable!  Once you restore, you will not get the old data back.
Restoring from USB zip or jump drive or an external hard drive is strongly recommended so you have a backup to restore data from in case of computer crash, theft, etc.
 XE "Reports" Print Reports
Print Reports is under the File pulldown menu prints reports.  After it is chosen, use it’s own File menu to specify the type of reports you wish to print, General Ledger, Payroll, or Cost Accounting. In this example, General Ledger reports were chosen so all GL reports will show in the list box.  In this example, the ‘Balance Sheet & P/L Statement’ will be printed on ‘HP Officejet Pro 8610’ printer showing all 12 months of 2016.  The Screen Preview box is checked so the report will show on screen with an option to print out a hard copy of this report.
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Print Reports screen
Printing Checks or Invoices
When printing checks or invoices, you will see a box asking for the starting check number, check date, and checkstub comments.  Look in your box of checks.  If the first check is number 1345, you don’t need to change the ‘Starting Check#’, shown below.  On the other hand, if the first check is number 1350, click in the area to the right of ‘Starting Check#’ and enter ‘1350’.  If you don’t want the checks dated ‘6/23/2015’, click at the start of that date and enter your desired Check Date.  The default date will be today’s date.  The ‘Checkstub Comments’ will print on all the checkstubs.  For paychecks, federal law requires starting and ending pay periods to be on the employees' checkstubs so verify that the default value set by the program is correct or edit it as needed.  For general ledger checks, the checkstub comments are optional.  Some clients have one name printed on the checks (say ‘ABC, Limited’), but are paying invoices billed to another company (perhaps billed to ‘North Butte Farms’).  They could enter ‘North Butte Farms’ in this ‘Checkstub Comments’ so that the vendor would receive a check with ‘North Butte Farms’ printed on it by Blue Skies program.
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If this ‘Check Writing Setup’ doesn’t appear when you are writing checks or printing invoices, choose the ‘File’ pulldown menu item ‘Print Quick Checks’ or whatever type of check or invoice you are trying to print.
Damaged Checks / Printer Jams
Sometimes your checkstock will get jammed in the printer or will otherwise misfeed.  Suppose out of the three paychecks (checks 1345 through 1348), one printed correctly - number 1345 and the last two were damaged beyond repair.  Click on the grayed ending check number (number 1348), above and enter 1346.  Reprint your check registers.  Only checks 1345 thru 1346 will be on these new check registers.  Then do the File ! Post command to post the completed paychecks (numbers 1345 through 1348) to the employees' year-to-date wages and to general ledger.  Then do Transactions ! Computer Paychecks again.  Touch your <F4> key and you will see that you now have five pending paychecks instead of the nine previously.   Choose Print and Post.  Set the Starting Check# to the first non-damaged check - check number 1247 and print checks and registers and then post these last remaining five paychecks. When printing W2’s and your printer jams, go to Options! Special Query! and use for re-printing W2’s in middle of run or re-printing W2 for a specific employee.

Last name>=”gaspar”   will start printing with that name and print through the end (won’t include ‘garcia’ for example).

Last name = “g*”    will print for anyone whose name starts with the letter g.
Report Destination – Choose your Printer
Report Destination will have your default XE "Default"  (normal) printerxe "Printer" on the top of the list, highlighted with a blue background to indicate it is the default printer.  Check the box ‘Screen Preview’ to display the report on your screen.  With this preview, you can scroll forward and backwards, or to print one or more single pages using the single sheet icon.  Click the printer icon to print all pages, or return to report requests by clicking on the black square box icon.  See R&R Report Writer  below, for pictures and detailed instructions of using these screen preview buttons.
Edit or Create Reports
This command is found under the ‘Edit’ pulldown menu on the Reports window. If you have purchased either R&R Report Writer and installed it in the \RRW subdirectory on your Blue Skies program disk, you can use modify the existing reports created using each of those report writers or you create your own entirely new reports.  Then use the Enable Reports icon in the Blue Skies Accounting work group so your new report will appear on this report setup screen.
Set Labor Benefit Rate
 XE "Benefits" 

 XE "Labor Benefits" This command is found under the ‘Edit’ pulldown menu on the Reports window.  If you have selected Management Reports to print, this item will be enabled so you can specify the Labor Benefit Rate.
‘Special Date Select’ XE "Special Date" 
‘Special Date Select’, under the Options pulldown menu, lets you enter a starting and ending date (a current report periodxe "Current Period") other than from the first of a month to the last day of another month.  You can choose full months  just by clicking on the box representing the month.
‘Special Query XE "Special Query" ’
‘Special Query’, under the Options pulldown, lets you specify you want to print only accounts 600 thru 630, for example, rather than print the full report.  If Special Query is checkmarked,
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 just before the report starts to run, a window showing the standard query that was used by AgData in report design appears:
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In this example, Vendor Activity Report by Num (in order of Vendor number) was chosen.  The top, ‘Query’, window appears.  You can Delete or Edit any of the standard query lines or you can Add new query lines.  To Edit one, for example, double clicking on the ‘VENDOR’ line.  The ‘Edit Select Rule’ window will appear.  You can see that the design Query was to include all Vendors in the range of from 1 thru 99999.  If you click on the ‘equal to’ choice under ‘Comparison’, you can change it to ‘equal to’ and then enter a 75 in the ‘Compared to’ box.  This will print a report showing only the activity (the general ledger transactions) for vendor number 75, only.  Or you can leave the ‘in the range’ as the Comparison, and change the ‘Compared to’ to ‘50,150’ to show the transactions of all vendors from fifty thru one hundred and fifty.  A ‘greater than or equal to’ with a 50 in the ‘Compared To’ will vendors fifty and above.  A ‘greater than’ will get vendors fifty-one and above.  An ‘in the list’ with ‘50, 75, 110, 114, 125’ in the ‘Compared To’ will show only these five vendors.
You could Delete a standard query line.  Click on first one and then the other of the ‘CHECK_DATE’ lines and then the Delete button [hidden under the ‘Comparison’ list] to include all transactions – to not limit the report to showing transactions that have been selected by clicking on the month boxes on the Report Request window.  The ‘Skcl->RPT_STDATE’ and ‘Skcl->RPT_ENDATE’ are internal variables used to link to the dates you selected by clicking on the month boxes in the Report Request window or by entering Special Date Select in the Options pulldown menu.
To Add a query line: put braces around dates – a CHECK_DATE ‘equal to’ {1/15/15} – or a CHECK_DATE 'equal to' {1/*/15} will print all January, 2015, transactions.   Put single quotes around words: a MEMO ‘equal to’  'JANUARY CHGS' or 'JAN*' will show any transactions that start with ‘JAN’.
Wildcards are ‘?’ for a single character and ‘*’ for many characters.  ‘?ODE’ will find both ‘MODE’ and ‘CODE’ and ‘RODE’ and ‘SAN*’ will find anything – regardless of length on name- starting with ‘SAN’.
‘Adjust Check Printing’ XE "Adjust Check Printing’"  will be enabled (will not be dimmed) if you are printing checks.  If you are using a laser or inkjet printer and you need to move the printing on the checks down 2 lines from the top of each page, do this pulldown menu command and enter a ‘2’.  The program will remember this setting so you don’t need to respecify it each time you print checks.  For multiuser (network)  XE "Multiuser" 

 XE "Network"  clients, each workstation can have its own Check Adjustment so if one workstation has a printer attached that needs extra lines and another workstation has a printer that needs no extra heading lines, the program will work properly for both workstations.
‘Force G/L ReAdd XE "Force G/L ReAdd" ’ When you print a general ledger report for May 2015, all g/l transactions.through May 30th, 2015 will be added and posted to each general ledger account.  So if you need to report another general ledger report for January through May, the adding already has been done and the report will print much faster.  But if you later add a g/l transaction dated before May 30th, the program will automatically note that it must readd dollars before printing May reports.  If you want to manually force the program to readd dollars, select this pulldown menu item to checkmark it and then print a general ledger report.
Printer Setup XE "Printer Setup" 
Whatever printer setup options the manufacturer of your printer provided in his ‘printer driver’ can be accessed through File ! Printer Setup.  If you have a color printer, you can specify the quality of the color reports XE "Reports"  - the higher the quality you wish, the longer it will take your printer to print.  If you have more than one paper tray, you can specify the paper tray for the next reports. And so on.
Screen Preview XE "Screen Preview" 
Check this box to view XE "View"  the report on the screen.  You then can click a button to print the entire report or selected pages.
R&R Report Writer
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Screen Preview of an R&R Report
All Blue Skies reports have been created using a powerful report writer, R&R Reports.  If you have selected 'Screen Preview', a window like the one shown above will appear before any printing.  On the preview screens, the top left button, the printer, will print all pages from page number one through to the end.  The next button, the sheet, will print the current page being viewed, only.  The next two, the magnifying glasses will zoom in and out on the currently view page.  The next six buttons XE "Buttons"  are similar to TV VCR viewing buttons.  The first means jump to view page 1.  It is dimmed in this example because we already are viewing page number one. The next is view previous page.  It is dimmed because there are no previous pages to view, we already are at page number one.  The next two view next page and view last page.  The next is Pause when jumping to view last page.  The last button, the black square, is Stop, Close Report, Return to Blue Skies Accounting.  The R&R company that wrote our report writer XE "Report Writer"  also has keyboard equivalents: F1=Print All (not help, unfortunately), F2=Print Current Page, F3=Zoom In, F4=Zoom Out, F5=First Page, F6=Previous Page, F7=Next Page, F8=Last Page, F9=Pause, F10=Stop.
Graphs
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Graphic Server Setup Screen
To create graphs, in report specification, choose General Ledger reports, then either 'Print Graph …' or 'Copy Graph …'.  .  The 'Copy' will copy the graph to your clipboard so that if you immediately go to Microsoft Paint or Microsoft Word or many similar programs, you can choose Edit ! Paste (or just do the standard Windows Control/V shortcut to paste) to insert this graph into that program's screen for special editing or printing.  The 'Print' graph will output the graph to the printer shown in the 'Destination' list of printers or will output the graph to your screen if 'Screen Preview' is checked on.
The graphs are created using a 'Graphic Server' program rather than R&R Report Writer used for all other Blue Skies reports.  Unfortunately R&R does not have a 'create graph' capabilities.  So if you do 'Screen Preview' you will not see the magnifying glass buttons that allow you to zoom into other reports.  To print a graph after previewing it, choose File ! Print command while in that graphic server program before returning to the normal report setup screen.
After Screen Previewing a graph, close it by doing: File ! Exit or by clicking anywhere on the graph or by touching any key.
Budget to Graph
Choose either Annual (12 months) or YTD Budget to graph against your Year-to-Date actual expenses.  Note: expenses will be automatically shown in order of the largest expense down to the smallest expense.  Any expense account with a zero balance for the year will not appear even if it has an amount budgeted for it.
Expense Account Caption
Choose the accounts' Numbers and/or their Descriptions.  But the shorter the length of the caption, the larger, easier to read, the caption will be.
Accounts to Display
If more than 15 expenses are shown, the caption will be too small - so choose which group of 15 accounts to graph.
Preprinted Government Forms XE " Preprinted Government Forms " 
Forms 1099's \Relate "BLUE_SKY.DOC!61", "Forms 1099's" \D2HTargetDefault  XE "1099" , W2 Forms XE "W2 Forms" , Quarterly State Payroll Reports XE "Quarterly State Payroll Reports"  and other government reports XE "Government Reports"  must be printed on the government's forms with all the amounts printed in boxes and spaces provided.  These reports will have '6LPI' XE "6LPI"  in the report title.  This keyword, '6LPI', stands for  6 lines per inch which is the vertical line spacing used on all these government preprinted forms.  After Blue Skies prints the first page, it ask you if the report is 'Printing correctly in your form's boxes?'.  You have three buttons appearing: <Yes>, <No>, and <Cancel>.
If you click on the <Yes> button, Blue Skies will print the rest of the government report.
If you click on the <No> button, you will be asked for the 'Page's vertical printing adjustment in inches'.  If you need to print one full line lower on the page (i.e. the printing was one line too high), enter a '0.1667' for a full, 1/6 of an inch, page adjustment.  If you need to print one full line higher, enter a negative 1/6 of a inch amount '-0.1667' [note the minus sign to print higher than standard].  You don't have to enter a full line up or down - a half a line would be 0.08335 and a full quarter of an inch would be 0.25   --- once you have entered your adjustment, it will be saved and used the next time you print on these government forms.
If you click on the <Cancel> button, the report will abort and you will return to the Print Reports \Relate "BLUE_SKY.DOC!33", "Print Reports" \D2HTargetDefault  window.
Printing 1099 Forms
The  report, ‘Form 1099-Misc’, will print dollars for Rent, Royalties and/or Non-employee compensation in the correct boxes. 
Before printing the 1099-Misc or the 1099-Int, you must first setup 1099 accounts:
Go to Setup!Company! Set 1099 GL Accounts \Relate "BLUE_SKY.DOC!62", "Set 1099 GL Accounts" \D2HTargetDefault , to list account numbers used for Rent, Royalties, Non-employee compensation, and Interest.  Click ‘Help’ for instructions.  
Run the GL report, ‘Vendor Audit for 1099s’ to learn which vendors have been paid over $600.  (Note:  You can do a special query to print this report for only the vendors for whom you’ve already entered a Federal ID # by appending the query, GLVE->Fed_ID is not equal to "" .)
Go to Setup!Vendor and enter a federal ID for the vendors who should receive a 1099.  If that vendor has a ‘dba’ you would like to print on their 1099, then enter it in Setup!Vendor
Run your 1099s on plain paper to check alignment and accuracy before printing to the forms.
If your fiscal year does not start on Jan 1st, the program will create a temporary merged set of books that will include transactions from both this year’s and last year’s books to be used for printing calendar year 1099s.  Proceed only if (1) you have not reassigned vendor numbers for your 1099 vendors in the two different sets of books and (2) the client number for both sets of books is the same number.  Open your books for the current fiscal year in your current data folder.  In Report request window, select General Ledger reports and then do Options ! Special Date Select and enter a start date of Jan 1 and an end date of Dec 31st.  The program will combine part last year’s data with the balance of the calendar year’s data in your current subdirectory into a temporary subdirectory.  Then all reports will use this temporarily combined data until you exit this report request window.
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If your fiscal year is not a calendar year (in the above example, the client’s books start in March 2000 – the first date box displayed), do a special request Run Form 1099 forJanuary thru December 2000.
Magnetic Media Reports:
If your company has more than 250 employees, the Internal Revenue Service requires that you use Magnetic Media Reporting.  You will either send a 3.5” diskette to the IRS or send a file via the Internet that contains all the reporting information rather than mailing a printout to them.  The Magnetic Media is an optional module for Blue Skies Accounting.  If it is purchased, you will see ‘Write report to a Disk File (eg Magnetic Media), shown last on the list of Report Destinations in your reports window:
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State Magnetic Reporting
So, in this example, the company wants a ‘MagMedia Quarterly St=CA’ report to be written to Disk File.  The ‘St=CA’ means this report only shows for California employers, where the ‘State’ in Employer Setup=CA.  The ‘[MMREF]’ means that the State of Calif. has specified that the filename on the diskette be ‘MMREF’ – it’s not something you need to worry about.  Chose the report period of January to March 2002 or whatever period the quarterly report covers.  He then would click on his ‘Print’ button.  If the operator wanted to printout that file for his own viewing (not for sending to the government), he could select the ‘MagMedia Quarterly’ report and then his default printer.
Currently, the State of California wants you to send the diskette with the ‘MMREF’ file accompanied by a printout of the DE166 printed report.  California employers can phone the State of California Magnetic Media Reporting Office at (916) 654-6845 for official clarification of these issues and for update information.
Federal Magnetic Reporting
The Federal Personal ID# (PIN) and the password associated with it must be obtained from the federal government.  The person who will be personally liable for the accuracy of the information to be submitted can obtain a PIN number by one of two methods:
By telephoning Social Security Administration at (800) 772-6270.
Or by using the Internet to access the Employer Services Online page at www.ssa.gov/employer/esohome.htm.  
For a federal magmedia report, choose ‘Write to a Disk File’ as the destination, as you did for the state report.  Select the report – the annual W2 report in this example.  Click all for  January through December, for this annual report period.  
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Magnetic Media Setup for Federal Mag Reports
When a federal magnetic media report is selected, after clicking on the ‘Print’ button, a Magnetic Media Setup window will appear as shown below.  Since this information will be written file to your diskette, you won’t need to do an accompanying printed-on-paper report.  All the ‘contact name’, PIN number, etc. will be on the diskette.  This information takes the place of the previous printed ‘6559’ report.
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Magnetic Media Setup window
Using either method, that person will have to provide:
His own company’s EIN. †
His Social Security Number.
His name as shown on his Social Security records.
His date of birth
His telephone number and e-mail address so the SSA can contact him with any problems.
His mailing address.
His company name †
His company’s phone number †
His company address †
†  If the person applying for a PIN is a CPA this will be his own company’s (Smith Accountancy Corp.) name, address, EIN, phone number, not the name of his client company he is reporting for.
On the other hand, if the owner or the company bookkeeper is applying for the PIN number; the EIN, company name, address, phone number, etc. will be the same as that of the company being reported on.  If the applicant is not an employee – perhaps the applicant is the farmer’s wife who hasn’t received a paycheck from the company – the applicant must phone the SSA – the Internet method will not work.
The SSA then will match the name, date of birth, and SSN of the PIN applicant against the records of the company to verify he works for that company.  Then the SSA will mail a password associated with the PIN.  With that password and the PIN number, the applicant then can submit information for any company.  He must change his password for that PIN at least yearly or the password and PIN number will expire.
This Magnetic Media information comes from the Social Security Administration’s ‘Magnetic Media Reporting and Electronic Filing’ (MMREF-1) manual.  
 XE "Checks" 

 XE "Posting" Posting Checks or Invoices:
After printing the checks or invoices, do File ! Post to post the entries so they won’t appear in the next group of checks.  Until you do File ! Post, you can reprint the checks as many times as you wish, if, for example, your printer ran out of ink and so the checks needed to be rerun.  See 'Damaged Payroll or General Ledger Checks \Relate "BLUE_SKY.DOC!49", "'Damaged Payroll or General Ledger Checks" \D2HTargetDefault ' for instructions about reprinting checks.  If you have a Payday Posting Disaster \Relate "BLUE_SKY.DOC!56", "Payday Posting Disaster" \D2HTargetDefault  or need to Void a Paycheck \Relate "BLUE_SKY.DOC!57", "Void a Paycheck" \D2HTargetDefault , contact AgData Tech Support \Relate "BLUE_SKY.DOC!58", "AgData Tech Support" \D2HTargetDefault .
 XE "Checks" 

 XE "Posting" ACA Form 1095 Report:

Select Print Form 1095-C in list of Payroll Reports
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This next screen will show only:
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Usually employees who qualify for ACA, will be offered ACA health insurance to cover only the employee himself.  So, under this Edit menu, usually you will choose the second line, ‘Code 1B’.
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Then, since the ‘1B’ ACA code was chosen, it will then appear in large, red, letters at bottom center of this screen.  If all FT (full time) employees between employee#1 and the last#, 83, show have a ‘1B’ in their Form 1095C for all months, set as above. 
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If you want only employees who have contributed to a Special Deduction account, choose ‘Options’ and then select which Special Deduction is a key to this employee participating in ACA Health Insurance.  In this example, Special Deduction#1 is ‘HEALTH’.  By chosing ‘HEALTH’, then the above selection will change to:
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Showing Spec#=1, Description = ‘HEALTH’.

Enter the smallest monthly deduction of all 1B employees.  This example was $20.00 monthly deduction.  So now all employees with $20 in each month will be reported as ‘1B’ after clicking the ‘Set 1B Code for Employees’.  On the other hand, if an employee started participating in ACA health plan in June, he would have $20 or more as HEALTH insurance deduction in June thru December, then only June thru December will be marked as ‘1B’ for him.  January thru May will be set per the next question:
[image: image52.png]Blue Skies Accounting =

1 moriy ttal for Spectt], HEALTH s less than 20, oK
what Code shouldbe used?

Code 14, Qualiving Offer Code 18, Offer to EE only

Code 1C, Qffrto EE + Deperdarts Code 10, Oferta e,

EE + Spouse
Code TE. Dfer o EE + Spouse + Dependents Code
1F. No Oifering

Code 16, Non FT EE Sefinsured Code TH, No
Offeing FT or Not

Code Tl,Non Dual Ofer Avail

]





You can make several runs.  Suppose employee #10 was an ‘1E’ employee, giving him, his spouse and his dependents ACA health insurance. After setting ‘1B’ for all employees, you can overwrite his ‘1B’ setting by making another pass choosing ‘1E’, $20 minimum monthly HEALTH deduction, set Employee# Start to 10 and End to 10, thus setting ‘IE’ for him only.
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Under the File menu for ‘Assign ACA Employee Codes’, you can print an Activity Report of assigning these codes to employees.  When you are ready to leave this ‘Assign ACA Employee Codes’ step, do File ! Exit to continue on to the actual printing of ACA Form 1095-C.
Select ‘Help’ on this ‘Assign ACA Employee Codes’ window to see this help:
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Exit
File ! Exit leaves Blue Skies Accounting and returns to window’s program manager.
Edit Pulldown Menu
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 XE "Paste" 

 XE "Copy" 

 XE "Cut" Cut, Copy, Paste
Cut, Copy, and Paste are standard windows commands that allow you to copy information from one employee to another, for example.  Go to the employee to copy, put your cursor XE "Cursor" 

 XE "Cursor"  in his Address input box, then touch Control/C to copy the address to your clipboard.  Get the second employee, put your cursor in his Address input box, then touch Control/V to paste the first employee's address into his address box. 
Show Clipboard
You may view XE "View"  the contents of your clipboard (the Cut, Copy, Paste contents) by using the last choice on this Edit pulldown list.
View Pulldown Menu
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 XE "Equipment" 

 XE "Enterprises" View Accounts, Enterprises, Operations, Equipment, Vendor & Customers, Employees
You may look at your list of Vendors, XE "Vendors"  for example, by choosing View ! Vendor.  The first half of the list is in numeric order, the second half is in alphabetic order.
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View XE "View"  Codes screen
Speed Search a View Codes list
You may type the first letters of the Vendor's name, and with each letter keyed, the highlight bar will Speed Search, XE "Speed Search"  to the first vendor with the letters you have typed so far (or the first numbers you have typed so far).  Touch your <Delete> key to jump to the first line of the list and start typing letters or numbers anew.  You may use your up / down / page up / page down arrows to move up and down the list rather than typing letters or numbers, if you wish.  Touch your <Escape> key to put the list away.  While entering data, as you touch a letter or number, the appropriate View list will appear.  Employee list will appear when typing in an employee number. Touch your <Enter> key or double-click on that code to select it..  


 XE "View" View & Edit General Ledger Transactions
Important note: Clerical (low level) password XE "Password"  employees in a two password system do not have high enough password privileges to be able to ‘View & Edit General Ledger Transactions’ - it will be disabled (it will appear in a gray, dimmed, color) on their View pulldown menu.
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View Transactions screen
Tech Note: Note the horizontal scroll bar just below the list of transactions.  Click in the middle of that scroll bar to view technical information columns presently not visible, off to the right edge of these normal columns.  These hidden columns are: Quantity XE "Quantity" & Quantity Description, Batch Number which is an internally assigned number that groups all the transactions for a check or an invoice, OutS is check reconciliation XE "Reconciliation"  outstanding status yes/no, EntO is enterprise-only XE "Enterprise"  yes/no, Type [QCk, MCk, Dep, JE, AP, AR, Inv, E-O, Pr for, respectively, Quick Check, Manual Check, Deposit, Journal Entry, Accts Payble, Accts Receivable, Inventory, XE "Inventory"  Enterprise Only, or Payroll transaction], Paid or pending for quick checks XE "Checks"  or AP checks, Hold status for AP checks, and Due Date XE "Due Date" 

 XE "Date"  for AP checks.
You won’t be able to search for transactions on these technical information columns - the search input boxes at the top of the screen will disappear when viewing these columns.  When done viewing these technical fields, click in the horizontal scroll bar about above the ‘Find’ button to return to viewing the normal columns. 
Tech Note: If the input columns don’t align on your computer screen, under the Options pulldown menu, choose ‘Align boxes over columns’.  Touch left/right arrow keys until boxes are aligned, then uncheck ‘Align boxes over columns’.
To view fields that have been shortened to appear in the display box, double-click on that field and a temporary larger box will appear.
Find button
You may find all transactions with a debit to account number 680 by entering ‘680’ [don’t actually type in the quotation marks in all of these examples] above 'Debit' in the search bar and then click on the ‘Find’ button.  You may enter ‘680-720’ to list all transactions that have debit account numbers between ‘680’ and up to and including ‘720’ but you will have to turn off Description Lookup by touching <F9> or the program won’t accept ‘680-720’ because that doesn’t describe any one valid account number.  Enter ‘-680’ to list all transactions up through account number 680.  Enter ‘680-’ to list all transactions from 680 on to the highest number.  Enter ‘PRO’ in the Payee XE "Payee"  Name column to list all transactions to payees XE "Payees"  that start with ‘PRO’ which might include ‘PRODUCTION CREDIT’ and ‘PROFESSIONAL MANAGEMENT SERVICES’.  Enter ‘1/1/96-1/31/96’ to display all transactions with a January 2015 date. XE "Date"   You can use the ‘Find…’ pulldown menu item (short cut = Ctrl/F) to select these columns on the left or even those columns to the right (use your horizontal scroll bar on the bottom of your screen to see these more ‘techy’ columns) – these columns that have no selection box.
Find Range of Employees
To find the transactions to an employee, turn off ‘Description Lookups’ either by using the pulldown menu item under ‘Options’ heading or by touching your <F9> key.  Then to find transactions to employee #100, enter ‘-100’ in the Vendor search field.  Then click ‘Find’.  Transactions for employee #100 are stored under minus 100 to keep them separate from transactions to normal vendor number 100.
Clear find button
Clear the Find parameters (in the boxes above the ‘Vendor   Payee Name ...’ column descriptions) by clicking on the 'Clear' button.  This button doesn't clear the data.  Click on the ‘Find’ button to redisplay all transactions.
Add transactions button
To Add several transactions, mark them using the ‘Marking Transactions’ procedures to highlight them and then click on this 'Add' button.  The total will show in the box located just above this button.
Check All button
The 'Check All' button (the ‘( All’ button) will highlight all transactions in your database.  After highlighting all your transactions, if you then click your 'Add' button, you will get a grand total of all transactions in your database.  Warning! - If you then dragged one to the trash XE "Trash"  can, you would delete all transactions in the database!  Actually, you will be asked if you really want to delete transactions when you drag them to the trash can.  Once the 'Check All' has been clicked, it changed to an 'UnCheck All' button with a different picture on it.
Exit button
Closes the View XE "View"  and Edit general ledger transactions window. 
Print button
Gives a screen dump of the transactions shown.  You can get a printout of many transactions in the normal print reports XE "Reports"  procedure - File ! Print Reports ! File ! General Ledger Reports then choose ‘Print List of GL Transactions’.  To narrow the list of transactions on that report more than the date select, turn on Options ! Special Query to specify ‘DEBIT greater than or equal to 680’ and ‘DEBIT less than or equal to 700’, for example.
Sorting transactions
Click on any Column Heading to sort by that column.  For example, click on the ‘Vendor’ heading to sort by vendor number. Click on heading a second time and the transactions will be sorted in the reverse order.
Would you like to ‘Find’ all records for employees whose first name is ‘Raul’? Type Raul above the Payee column and click the Find Button.
Using the ‘Options’ pulldown menu you can choose any one of six different ordering methods to list your transactions: Batch Number, Vendor Number, or Date or the descending (highest first and smallest last) versions of these three.  In the image below, you can see this operator was viewing transactions in Date Order – earliest date first and highest date on the bottom of the list.
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Correcting General Ledger Transactions.
To correct any transaction (assuming you have more than a clerical password XE "Password" ), just click in the area of the transaction to change and retype the correct value.  The changes will be a different color until the record is saved - touch your up, down, left, or right arrow keys to save your corrections.  You cannot correct pending check entries, nor pending accounts payable XE "Accounts Payable"  entries on this screen - you must enter Computer Quick Checks, XE "Checks"  touch your <F4> key to List Pending Checks, and double-click on the check to correct and then change that check.
Marking Transactions for Adding, Deleting, or Mass Updating:
Move your cursor XE "Cursor"  to the left edge of a transaction to the push button box in the column to the left of the ‘Vendor’ column.  Single click with your left mouse button and the entire transaction line will become highlighted in a different color.  Right mouse click and all lines returns to normal - they become unselected.  You may also use the Multiple Line Select XE "Multiple Line Select"  method to quickly select many transactions.
Delete Transactions
To Delete one or more transactions, check to highlight them, then either go to the Edit menu and choose Delete Marked Transactions or you just drag (click w/o releasing the left mouse button and move the new mouse icon to the Trash XE "Trash"  Can located on the lower left of the View Transactions window.
 XE "Mass Update" Mass Update Transactions
To Mass Update (correct several transactions), mark by clicking the left edge of the transaction to highlight it as a transactions to change, then enter the new value in the appropriate input box at the top of the list.  For example, mark four transactions, then enter '690' in the Debit Account box at the top of the Debit column.  Then choose Update Marked Entries under the 'Edit' pulldown menu on this View Transactions window.  The four transactions will now be changed so that their debit account number is ‘690’.
Void Check XE "Void Check" 
To Void a Check or Checks:
A general ledger check, mark all the lines of that check by clicking the boxes at the left edge of the transaction lines to highlight them as transactions to change.  To ‘Delete’ one or more transactions, check mark to highlight them, then either go the the Edit menu and choose Delete Marked Transactions or just drag (click without releasing the left mouse button) and move the new mouse icon to the Trash Can, located on the lower left of the View Transactions window.
A paycheck, highlight only the check line (the line that has Debit = zero and Credit = 101 or whatever gl account number you use for your payroll checking account).  You can only select and void one paycheck at a time – you can’t select a group of paychecks as you can for general ledger checks.
Tech Note: for Voiding Paychecks – if you need to void all the paychecks on one payroll, go to Head Bookkeeper File Repair to Unpost the Payroll.
Then choose Void Marked Entries under the 'Edit' pulldown menu on this View Transactions window.  All the voided check transactions will change to Debit Account#0,  Dollar Amount=$0, Memo ='Voided Check', with the Vendor#, Payee Name, Check Number and Batch Number will stay the same, Outstanding status will be set to False (not an outstanding check).  If you have voided one or more paychecks, upon exiting this View GL Transactions window, the program will readd for all employees.
Thus the voided check will appear in your General Ledger Detail and other reports to maintain your audit trail.
Edit: Move to First Record, Move to Last Record
Under the ‘Edit’ pulldown menu, you will see that you can jump to the first transaction record and then quickly to the last by doing Ctrl/A and then Ctrl/Z.
Options: Viewing Order
You can permanently order your transactions in one of six sequences – Batch Number Order, Vendor# Order, Date Order, Descending Batch Number Order, Descending Vendor# Order, and Descending, Date Order.  You can change the viewing order of your general ledger transactions as often as you like.  When you next start to view transactions, the program will recall the viewing order last used for this client.  You can temporarily sequence transactions with a Heading Click - just by clicking in a heading description.  For example, click in the box with ‘Ent’ to sequence transactions in ascending Enterprise number order (all the transactions with no enterprise number will be listed first, then those with enterprise #1, then #2, etc.).  Click on the ‘Ent’ heading a second time and transactions will be listed in descending enterprise number order (highest ent# down to those transactions without an enterprise number being listed last).
Options: Select Transactions
To view a certain type of transaction, for exmaple, Deposits, select this pulldown menu item.
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Options: Select Paid
If you wish to view only ‘Paid=True’, only posted transactions, choose ‘Paid=Yes’.  To view only unpaid (pending)  transactions, choose ‘Paid=No’.  To view all transactions, whether paid or not, choose ‘Paid=All’.
One of the simple and easiest ways to find a vendor, with an  error and to correct them:  Use both options, Select Transactions and Select Paid.
Transaction Pulldown menu
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Quick Checks and Manual Checks
This procedure is for general ledger checks XE "Checks"  - not for paychecks.  For payroll checks, do Transactions ! Computer Paychecks \Relate "Blue_Sky.doc!16", "Computer Paychecks" \D2HTargetDefault .
To see job steps to Print Quick Checks and Manual Checks, see Writing GL Checks Procedures.
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Transactions: Quick Checks, Manual Checks, and A/P Checks screen
For checks, if you know the total dollar amount XE "Amount"  to pay, enter that amount in the check’s ‘Amount’ box, speed search the payee, XE "Payee"  and then enter the coding line or lines in the check stub input boxes.  When the total dollar amount of checkstub XE "Checkstub"  lines equals this amount shown on the check, the check will finalize and clear, ready for the next check.
Or if you don’t know the full amount of the check, enter a zero in the check’s ‘Amount’ box, enter the payee, and then enter the coding lines with their dollar amounts.  When you are done entering coding lines, touch ‘New’ to automatically carry the checkstub total dollars into the check’s total ‘Amount’ box, finalize the check, and clear it ready for you input of the next check.
The instructions for each input field is given below.
‘To Order of’ or  XE "Payee" Payee
Enter the Payee (type in the first letters of your Payee's name to automatically bring up the Vendor Speed Search list - touch <Enter> when the highlight bar is on the vendor you wish to write a check to or just double click on that vendor). Touch <F2> to setup a single new vendor.  If the Vendor’s information needs to be corrected, you can easily do it here by touching <F3>, to Edit Old Vendor’s information.  Then just type in the vendor’s new address, etc.  When you click your ‘Save’ button to save the first line of details for this vendor, all this new information will be saved to the vendor’s information file as well as saving the entry for this check to write.
 XE "Quantity" 

 XE "Amount" Amount
Enter the total Amount of the check to write in the ‘Amount’ input box.  If the total amount of the check is unknown, enter a zero or leave it blank, then enter the checkstub XE "Checkstub"  details and dollar amounts.  When the sum of the stub breakdown items equals the amount of the check, the program automatically will finalize this check and start a new check for you.  If you have entered zero in the Amount box, then click on ‘New’ to automatically move the total of the checkstub dollar amounts into the ‘Amount’ input box and so to finalize the check.  In the Amount field, you may enter an Equation XE "Equation"  instead of an amount.
Date XE "Date"  or Due Date XE "Due Date" 
For manual checks, XE "Checks"  accounts payable XE "Accounts Payable"  checks, or accounts receivable XE "Accounts Receivable"  invoices you will be asked for the Date or the Due Date.  If you enter two numbers and touch <Enter>, the program will use these as the day of the month and will copy XE "Copy"  the month and the year from the previous transaction.  If you wish, you may touch your <F6> key to Get Calendar XE "Calendar"  Date \Relate "Blue_Sky.doc!4", "Get Calendar Date" \D2HWindow /d . XE "Get Calendar Date" 
Purchase Order XE "Due Date" 
Enter any description that you like.  The purchase order description will printout on your computer check XE "Get Calendar Date" s so your vendors can better credit your account.  The purchase order field can contain up to 25 letters or numbers.
Checkstub List
If you add several accounting breakdowns on one check, the breakdowns will be shown in the checkstub's list on the bottom of the check - the area occupied by the two lines totaling $280.90 in the above example.  As in the view XE "View" 

 XE "View"  transactions procedure, you may click in any area on the checkstub to correct it. The corrections will shown in red until you up/down or left/right arrow which will instruct the program to save the corrections.  You may delete a checkstub line -  see ‘Trash XE "Trash"  Can’ below for instructions.
Acct
This is the general ledger account number for the next coding.  Enter a letter or number to Speed Search account numbers. For example, for general ledger account number 680, ‘SUPPLIES EXPENSE’, enter ‘680’ or ‘SUP’.  This is a required field.
Quan & QDesc & Rate
The quantity and quantity description for this line. You may enter ‘4500’ in Quan and ‘TON’ in QDesc. These are optional fields, they may be left blank.  If you enter a quantity, you may enter a Rate and the program will both store that rate and computer the dollar amount equal to Quantity times this Rate. In either the Quantity or the Rate fields, you may enter an Equation XE "Equation"  instead of an amount.
Memo
Enter up to twenty characters of any comment you wish, such as ‘NOVEMBER SERVICE FEE’ or ‘100 #/ACRE’.  This is an optional field.
Ent, Oper, Eqp#
Use Speed Search to enter the enterprise XE "Enterprise"  number, operation XE "Operation"  number, and equipment XE "Equipment"  number if the general ledger account number for this line is either an income or an expense item.  But if the account  (the 'Acct') is an asset or liability code, the program won’t stop to ask these codes.
Multiple Enterprises for One Input Line
If you want to percentage out one input line to several enterprises based upon their acreages, use the powerful Multiple Enterprises for One Input Line XE "Multiple Enterprises for One Input Line"  \Relate "BLUE_SKY.DOC!50", "Multiple Enterprises for One Input Line" \D2HTargetDefault  shortcut method - 'multi XE "multi" ' will appear in the enterprise input box.
Voiding a Check
While the check is a pending check (until it has been posted and so won't show on the <F4> list on pending checks), just retrieve it by touching <F4> and then do Edit ! Delete Check.  After it has been posted, use the view GL transactions void check \Relate "Blue_Sky.doc!34", "void check" \D2HTargetDefault  method.
Save, Clear, New, Print, Exit Buttons
‘Save’ writes the entry in the stub input boxes (‘Acct’ thru ‘Eqp#’) down to the check stub list. If the total dollars on the check stub list equals the dollars of the total check, the check will finalize and the form will be erased, ready for the next check.  ‘Clear’ blanks all these stub input boxes, but doesn’t finalize the check.  The ‘New’ button finalizes the check, forcing the total dollar amount XE "Amount"  of the check to the total of the stub entries entered.  In other words, if you don’t know the total amount of the check, enter a zero in the check’s total dollar amount, enter the various codes and dollar amounts into the checkstub, XE "Checkstub"  and then click ‘New’ to finalize the existing check and to start entering a new check.  The ‘Print’ button takes you to print reports. XE "Reports"   The ‘Exit’ button leaves check input.
 XE "Trash" Trash can
You can delete the entire check by drag and drop the check’s vendor number to the trash can. Or you can delete a single one of the checks’ checkstub lines by highlighting it and then drag and drop the line in the trash can.
 XE "List All Pending Checks" 

 XE "Checks" List All Pending Checks
If you later need to make corrections to this check, touch <F4> to List All Pending Checks, then double click on this check to bring up its details. 
 XE "List Pending Checks for a Vendor" List Pending Checks for a Vendor
 To List Pending Checks for a Vendor, touch your <F5> key.
 XE "Description Lookups" Description Lookups
If you know all your checkstub codes and don’t want your code lists to appear, touch <F9> to make the check mark disappear beside ‘Options ! Description Lookups’.  Touch <F9> to make the check mark reappear and Description Lookups to automatically occur again.  In other words <F9> toggles Description Lookups.  But to lookup a range of codes or date, you must first turn Description Lookups off.  Otherwise when you enter ‘680-720’ to retrieve all transactions to accounts 680 thru 720, the program will beep and inform you that ‘680-720’ is not a valid general ledger account number.
Done - Print the Checks and Check Register
To print these checks (for Quick Checks), click on the Print button.  You should print your Check Register first and look for errors before printing checks on your checkstock.
Multiple Checking Accounts
If you write checks from more than one checking account, check the 'Multiple Checking Accounts \Relate "BLUE_SKY.DOC!47", "Multiple Checking Accounts" \D2HTargetDefault ' option in Set Expert Options.  
Once ‘Multiple Checking Accounts’ is checked, you can specify which GL accounts are Checking Accounts by check marking the ‘Checking Account’ box in their Account Setup:
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Then as you start to enter general ledger or payroll checks the following list will appear.  Up/Down arrow to the checking account you want to effect and then touch your <Enter> key.
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Accounts Payable Check


Allows you to enter payables as your invoices are received in the mail.  Each payable can have its own Due Date so this program can print a list of 'Cash Requirements' projected into the future.  After reviewing that list, you can put some payables into 'Hold' status and tell the program to print all others in the computer with a Due Date less than or equal to March  1, 2002, for example.  The procedures for entering data for accounts payable is the same as that of Quick Checks except that Due Date is also asked.  The program then prints the checks and check register similar to those from Quick Checks.  
Setup AP Account Number:

Go to  Setup! 
 Accounts!   Add new Accounts Payable GL account number  (ie…320). This is a current liability account that represents the total Accounts Payable due.
Next go to  Setup! Company!   Account Design!    Enter your new AP number.
Accounts Payable entries start in HOLD status
If you use the Blue Skies Accounts Payable program, and check this box, you can enter all your payables at once and print checks for just a few payables at a time.  A payable remains in HOLD status until you mark it 'released'.  Only then will a check be issued.
If you have Accounts Payable and leave this box unchecked, all entries will start in the READY status.  All checks will print unless you click on specific entries to place them in HOLD status.  
This option lets you specify the default for new Accounts Payable entries.  The computer operator can specify which entries will change from that default.
When you are done and click on the 'Print' button, you can individually click to choose which payable checks to put into Hold status, or which to release.  Tip: do 'Heading Click' to re-sort these transactions in Vendor# order, etc.  You can do 'Find…' to limit the list to a group of vendors, by due date, or use the Bookkeeper’s Assistant.
Correcting general ledger transactions.
To correct any transaction (assuming you have more than a clerical password), just click in the area of the transaction to change and retype the correct value.  The changes will be a different color until the record is saved - touch your up, down, left, or right arrow keys to save your corrections.  You cannot correct pending check entries, nor pending accounts payable entries on this screen - you must touch your <F4> key to List Pending Checks, and double-click on the check to correct and then change that check.
Date or Due Date
For manual checks, accounts payable checks, or accounts receivable invoices you will be asked for the Date or the Due Date.  If you enter two numbers and touch <Enter>, the program will use these as the day of the month and will copy the month and the year from the previous transaction.  If you wish, you may touch your <F6> key to Get Calendar Date.
Writing GL Checks procedures
Go to Transactions!  Accounts Payable pulldown menu and enter the new transactions. You must enter a Due Date for projected cash requirement reports.  Enter the payees, dollar amounts, and other coding for the new checks. Tip: If you enter a zero in the dollar amount field, the program will automatically calculate the total amount of the check for you.
When done entering checks, touch the Print Button on the check input form to print the Checks and Check Registers. Always run a register & checks before posting the checks (using the command under the 'File' pulldown menu in the Print Reports Print Reports screen).
To Void or Delete a posted Accounts Payable check, follow the same procedures as General Ledger checks.  Check mark all the lines of that check by clicking the boxes at the left edge of the transaction line, to ’highlight’ them as transactions to change. Either go to the Edit menu and choose Delete Marked Transaction or drag (click w/o releasing the left mouse button) and move it to the Trash Can located on the lower left of the View Transactions window.
AP Diagnostic Analysis
New command tool determines problems in Accounts Payable. Use for month-end closings or year end closing.
 XE "Deposits" Deposits
Enter deposits to your checking account XE "Checking Account"  (or your multiple checking accounts XE "Multiple Checking Accounts" ) choosing the Transactions ! Deposits from the Main Pulldown menu.
First Style of Deposits window – Batch Deposits
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Deposits Screen with batch totals
This method of deposits is designed for entering batches of checks as a total deposit.  And designed for multiple daily entries and/or multiple deposits from one vendor. Enter the date and total dollar amount of the bank deposit. 
Tip: Enter a zero in the total dollar amount of the deposit. When all the deposit transactions are entered and saved, click on your ‘New’ button to automatically record the total amount of the deposit.  Many program users enter the total amount of the deposit as an extra safeguard or double check, that the dollar amount of this deposit has been entered correctly.
Under the File! Print and Post pulldown menu, print your Register (shown below)
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verify all entries are correct, then Post the Deposits.
Deposits – No Batch Method
If you hold down your ‘Ctrl’ key when choosing Transactions! Deposits!  from the main menu, the alternate deposit window shown below will appear.
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Deposits Screen – no batch total, but Quan & Rate allowed
If you want to enter several checks as a single batch deposit, use the Batch Deposit window. The advantage of this screen, is that is has space to enter the ‘Quantity’, ‘Desc’, and the ‘Rate’ associated with the deposit transaction.  But for Blue Skies users who have Accounts Receivable and are sending out invoices, their invoices already have space available for quantity and rate, so wouldn’t need additional space on the deposit window.
These entries will automatically debit account number 101(or designated checking account).  If your credit account number is either an income or and expense account, the ‘Income or Expense: Costing Enabled’ questions must be answered.
Quan & QDesc & Rate
The quantity and quantity description for this line. You may enter ‘4500’ in Quan and ‘TON’ in QDesc. These are optional fields, they may be left blank.  If you enter a quantity, you may enter a Rate and the program will both store that rate and computer the dollar amount equal to Quantity times this Rate. In either the Quantity or the Rate fields, you may enter an Equation XE "Equation"  instead of an amount.
Date XE "Date" 
If you enter two numbers and touch <Enter>, the program will use these as the day of the month and will copy XE "Copy"  the month and the year from the previous transaction.  If you wish, you may touch your <F6> key to Get Calendar XE "Calendar"  Date \Relate "Blue_Sky.doc!4", "Get Calendar Date" \D2HWindow /d . XE "Get Calendar Date" 
Memo
Enter up to twenty characters of any comment you wish, such as ‘NOVEMBER SERVICE FEE’ or ‘100 #/ACRE’.  This is an optional field.
Ent, Oper, Eqp#
Use Speed Search to enter the enterprise XE "Enterprise"  number, operation XE "Operation"  number, and equipment XE "Equipment"  number if the general ledger account number for this line is either an income or an expense item.  But if the Credit Account  is an asset or liability code, the program won’t stop to ask these codes.
Returned Checks XE "Returned Checks" 
If a check you have a Deposit returned \Relate "BLUE_SKY.DOC!56", "Deposit returned" \D2HTargetDefault  for 'insufficient funds XE "insufficient funds" ', enter that information in your Blue Skies books by making another deposit entry to this same vendor, enter the same Credit Account number, Enterprise, Operation, and other codes used when you originally recorded the deposit, enter the dollar amount as a negative dollar amount amount (put a minus sign before the dollar amount), and enter 'INSUFFICIENT FUNDS' or some such notation in the Memo field.  If you have Accounts Receivable and the deposit was an Accounts Receivable payment, it is very important you use this negative dollar amount deposit method to record returned checks.  Do not use a journal entry to enter a positive dollar amount with Debit Accounts Receivable, Credit Cash - Blue Skies cannot close these entries properly at fiscal year end.
Use the Save button to write this deposit entry to your hard disk.
 XE "Accounts Receivable" Accounts Receivable
Accounts Receivable is an optional module - if you haven’t purchased it, it won’t be enabled and will appear dimmed.   The AR module prints Invoices, can automatically charge interest on overdue accounts, prints End of the Month Statements, and more.  For an overview of accounts receivable procedures, see the Accounts Receivable Procedures \Relate "BLUE_SKY.DOC!27", "Accounts Receivable Procedures" \D2HTargetDefault  section.
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Transactions: A/R Invoices screen
Entering Invoice Charges
Enter your billings using this procedure.  You will enter payments received from your customers against these charges using the normal Deposits pulldown menu shown under Transactions.  For deposits, just enter your Accounts Receivable account number (number 130 as shown in the upper right of the screen shot shown below) as the Credit account number.  The accounts receivable reports look for transactions to customer number 57, Boeger Farms, that are invoice charges (with a Debit to 130 and usually a credit to an income account such as Corn Income) and match those against deposit payments against accounts receivable (Credit to 130 and usually a debit to your cash account number.)
The instructions for each input field is given below.
‘Customer'
Enter your customer's name (type in the first letters of your Payee's name to automatically bring up the Customer/Vendor Speed Search list - touch <Enter> when the highlight bar is on the customer you wish to invoice or just double click on that customer). Touch <F2> to setup a single new customer.  If the Customer’s information needs to be corrected, you can easily do it here by touching <F3>, to Edit Old Customer’s information.  Then just type in the customer’s new address, etc.  When you click your ‘Save’ button to save the first line of details for this invoice, all this new information will be saved to the customer’s information file as well as saving the entry for this check to write.
Date XE "Date"  and Due Date XE "Due Date" 
Date is the invoice date.  Due date is the aging date.  Since the typical aging for accounts receivable is 30, 60, or 90 days.  The invoice will show as 30, 60, or 90 days overdue from this due date.  Due Date will also be used for charging interest on late payment. There are a few shortcuts to entering these two types of A/R dates.  If you enter two numbers and touch <Enter>, the program will use these as the day of the month and will copy XE "Copy"  the month and the year from the previous transaction.  If you wish, you may touch your <F6> key to Get Calendar XE "Calendar"  Date \Relate "Blue_Sky.doc!4", "Get Calendar Date" \D2HWindow /d . XE "Get Calendar Date" 
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You can instruct A/R to automatically set your Due Date for you.  Click on the A/R Due Date item, ‘Autoset to Invoice Date Plus nn Days’ so it is checkmarked.  Click on it again and the checkmark will disappear and Autoset Due Date will be turned off.  In the above example, the Due Date would be set to Invoice Date plus 15 days.  If Invoice Date was 9/1/00, the Due Date would be set to 9/16/00.  To set the number of Autoset Due Date Days, choose the second item under A/R Due Date, ‘Change Autoset Days from nn Days’.
Invoice#
Enter a number from 1 to 99999 in this field.  The default value will be one higher than the previously used highest invoice number.  If you wish, you may touch your up or down arrow keys or click on the up or down buttons beside the invoice number to set the next higher or lower invoice number than the one shown.
Purchase Order
Enter any description that you like.  The purchase order description will printout on your invoices so your customers can better verify his charges.  The purchase order field can contain up to 25 letters or numbers.
Invoice List
If you add several accounting breakdowns on one check, the breakdowns will be shown in the invoices's list on the bottom of the invoice - the area occupied by the two lines totaling $25245.00 in the above example.  As in the view XE "View"  transactions procedure, you may click in any area on the invoice to correct it. The corrections will be highlighted in a different print style until you up/down or left/right arrow which will instruct the program to save the corrections.  You may delete an invoice line -  see ‘Trash XE "Trash"  Can’ below for instructions.
Acct
This is the general ledger account number.  Enter a letter or number to Speed Search account numbers. For example, for general ledger account number 510, ‘CORN INCOME’, enter ‘510’ or ‘COR’.  This is a required field.  Note: if the description lookup doesn’t appear, description lookup is off.  Turn it back on by touching your <F9> key.
Quan & QDesc & Rate
The quantity and quantity description for this line. You may enter ‘125’ in Quan and ‘TON’ in QDesc. These are optional fields, they may be left blank.  If you enter a quantity, you may enter a Rate and the program will both store that rate and computer the dollar amount equal to Quantity times this Rate.  In either the Quantity or the Rate fields, you may enter an Equation XE "Equation"  instead of an amount.
Memo
Enter up to twenty characters of any comment you wish, such as ‘NOVEMBER SERVICE FEE’ or ‘100 #/ACRE’.  This is an optional field.
Ent, Oper, Eqp#
Use Speed Search to enter the enterprise XE "Enterprise"  number, operation XE "Operation"  number, and equipment XE "Equipment"  number if the general ledger account number for this line is either an income or an expense item. But if the account  (the 'Acct') is an asset or liability code, the program won’t stop to ask these codes.
Multiple Enterprises for One Input Line
If you want to percentage out one input line to several enterprises based upon their acreages, use the powerful Multiple Enterprises for One Input Line XE "Multiple Enterprises for One Input Line"  \Relate "BLUE_SKY.DOC!50", "Multiple Enterprises for One Input Line" \D2HTargetDefault  shortcut method - 'multi XE "multi" ' will appear in the enterprise input box.
Void / Delete an Invoice
While the invoice is a pending invoice (not  posted and shows on the pending list), just retrieve it by touching <F4> and then do Edit ! Delete Invoice. You may also click on vendor number and drag to trash can.  Do not try to edit the vendor number!! Re-enter new corrected invoice.
**After the invoice has been posted, it is very important how you delete an invoice:**
Make a Journal Entry coded to the AR account number reversing the invoice or Delete a Marked Transaction in “View GL Transactions ! Delete Marked Entries” method.    
Call Tech Support if necessary.
 To delete an invoice after it has posted and ‘No Deposit’ has been applied to this particular invoice, then highlight all the transaction lines to the invoice, and Go to Edit! Delete Marked Transactions!
*Notice when the invoice is posted, it shows Paid ‘Yes’
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*Once a deposit has posted ,  the ‘Paid’ column says Yes.
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*You may delete either of these transactions as long as the  ‘AR Res’  column says No. 
As before, highlight all the transaction lines to the invoice, and Go to Edit! Delete Marked Transactions! 
*When you ‘resolve payments against invoices, the ‘AR Res’ column will change to Yes for both invoice and deposit.
If you need to void or delete this type of transaction, call Tech Support.
***DO NOT MAKE A NEGATIVE (-) ENTRY ON ANOTHER INVOICE TO SHOW A ZERO (0) BALANCE. These entries will not auto resolve at year end and will cause you problems at year end closings.***
Save, Clear, New, Print, Exit Buttons
‘Save’ writes the entry in the stub input boxes (‘Acct’ thru ‘Eqp#’) down to the invoice's list of charges.  ‘Clear’ blanks all the stub input boxes, but doesn’t finalize the invoice.  The ‘New’ button finalizes the invoice.  The ‘Print’ button takes you to print reports. XE "Reports"   The ‘Exit’ button leaves invoice input.
Invoice Notes
If you want to add shipping notes or other comments to this invoice, touch your <F7> key (or use the Edit! Edit Invoice Notes pulldown menu item) while the invoice is still on your screen.
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This brings up a new data entry box.  You can enter up to ten lines of comments that will print out on this invoice to Boeger Farms, Inc.  Click its Save button when done or click the Clear button to delete all of the notes for this invoice.
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 XE "Trash" Trash can
You can delete the entire invoice by drag and drop the invoice’s customer number to the trash can.  Or you can delete a single one of the invoice’s lines by clicking on its left edge (the color of the line changes) and then drag and drop the line in the trash can.
 XE "List All Pending Checks" 

 XE "Checks" List All Pending Invoices
If you later need to make corrections to this invoice, touch <F4> to List All Pending Invoices, then double click on this invoice to bring up its details. 
 XE "List Pending Checks for a Vendor" List Pending Invoices for a Customer
 To List Pending Invoices for a Customer, touch your <F5> key.
 XE "Description Lookups" Description Lookups
We recommend you keep this on (check mark). To lookup a range of codes or date, you must have Description Lookups on.  If you know all your checkstub codes and don’t want your code lists to appear, touch <F9> to make the check mark disappear beside ‘Options ! Description Lookups’.  Touch <F9> to make the check mark reappear and Description Lookups to automatically occur again.  In other words <F9> toggles Description Lookups.  Otherwise when you enter ‘680-720’ to retrieve all transactions to accounts 680 thru 720, the program will beep and inform you that ‘680-720’ is not a valid general ledger account number.
Done - Print the Invoices and other Accounts Receivable Reports
To print these invoices, click on the Print button.  The following window will appear:
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Click ‘Yes’ to print invoices and registers.  Post invoices after printing.
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One of the Invoice Formats Provided. Replace the ‘c:\Blue_Sky\Logo.Bmp’ on your computer with your own company logo  and it will print out on these invoices.
Month End Accounts Receivable Procedures
At month end, click your ‘Print’ button, then click ‘No’ for monthly A/R procedures and reports. 
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The following window will appear:
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 Unresolved Payments are your Deposits.
Click on the ‘Help’ pulldown menu item to show the list of Month-End Bookkeeping Steps shown below:
Typical Month End Bookkeeping Steps
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Step 1) Do File!Charge Interest on past due balances.
If you want to charge interest on past due balances, the program will make the charges for you, automatically.  The late payment interest rate can vary by customer - set your rates in their customer/vendor setup \Relate "BLUE_SKY.DOC!42", "customer/vendor setup" \D2HTargetDefault  – in the ‘Overdue Interest Rate’ box.  If you don’t want to charge interest on past due balance, skip to ‘Step 2)’.  To start charging interest, choose ‘Charge Interest on O/S [Outstanding] Balances’ under the ‘File’ pulldown menu.
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The program will next ask ‘Last Day of Billing Cycle’.  If you are charging interest once a month, this probably will be the last day of the month.
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Some Blue Skies users, such as those with fresh produce business, might use an accelerated billing – might want aging of 15-30-45 days instead of 30-60-90.  They will need to do their billing cycle twice a month (on 15th and 30th) and will get a half month’s (15 days) interest charge on past due balances.  But this company is setup with 30-60-90 day aging (specified in ‘Set Aging Columns’ under ‘Options’) and charging interest once a month, so the following window next appears:
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After clicking on ‘Ok’, the program will automatically generate interest charges on unpaid, late (past the due date), accounts receivable invoices.  Again, the interest rate can vary on a customer by customer basis.  For most customers, set them up as ‘Company Standard’ interest rate.  Then you can set the interest rate for all of them in this A/R Month-End Bookkeeping window, using the ‘Set Standard AR Interest’ item under the ‘Options’ pulldown menu.
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Example: Aging is based on the ‘Date of Invoice’ and the month-end ‘Due Date’, after 30 days. If your invoice is dated  9 /2/02, then run a statement dated with month end date of 9/30/02, statement reflects ‘Current’ (within 30 day aging). If you run a statement dated with month-end date of 10/31/02,   charges will appear in the 30 day column (with applicable interest if this step was done).
Step 2) Click ‘Print’ to print month-end Accts Rec Reports such as monthly statements.
Choose the ‘Print & Post’  menu command under the ‘File’ heading or click on your ‘Print’ button to print whatever end of the month A/R reports you might wish.
Step 3) Resolve payments by clicking on ‘Auto Resolve’ button …

(and then click on the ‘Hand Resolve’ button for any payments the program couldn’t ‘Auto Resolve’).
Resolving Payments means matching up customer payments with their old invoices and marking both as ‘Paid’ – taking them out of the ‘awaiting payment’ status.
There are two reasons to Resolve Payments on a monthly basis.  First, if you have a type of business that has customers who reject part of your deliveries, who just make partial payments on their invoices because of ‘product adjustments’, this will let you highlight which customers you to contact to negotiate a invoice adjustment.  In this invoice example, the business is selling Alfalfa Hay.  If the customer receives the hay and is upset about the hay quality, he may just pay part of the bill – perhaps after pointing out the problems to the truck driver without phoning your office.  So when this customer makes a partial payment, it won’t auto resolve - the program can’t figure out which invoice(s) must be being paid off by the customer payment.  So those payments that still unresolved after doing ‘Auto Resolve’ and ‘Hand Resolve’ are from customers who either are disagreeing with their invoiced amounts or just can only make a partial payment on their total balance due.
The second reason to Resolve Payments on a monthly basis is that it will speed process of various Accounts Receivable job steps.  The program has fewer ‘UnPaid’ invoice charges and payments to process.  At year-end, when closing out your fiscal year, the program will bring forward all Unpaid charges and payments.  If you haven’t Resolved Payments, every Accts Rec charge and payment will be brought forward to next year – slowing down all Viewing of GL Transactions, and all GL report processing.
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If you don’t have a business that has customers making partial payments to dispute bills, or if you don’t want to use Blue Skies to make these partial payments stick out, checkmark the ‘Auto Split $Amounts’ item under the ‘Options’ menu – as shown in the graphic of ‘Auto Split $Amounts’, above.  Then if a customer makes a $200 payment on a $500 invoice, the program will automatically break the old $500 invoice into two amounts, a $200 charge that will be marked ‘Paid’ along with the $200 payment, and leave a $300 ‘Unpaid’ amount still awaiting payment.  Both the $200 and the $300 will retain the original Vendor#, Invoice# and Batch# for audit trail purposes.  If you use ‘Auto Split $Amounts’, you will just need to click on ‘Auto Resolve’, monthly - you won’t need to ‘Hand Resolve’.
Step4 AR Diagnostic Analysis
Itemizes  problems within your books (ie..which vendor has different balances due) which causes your books not to close properly. 

Optional A/R Month-End Steps
Replicate Invoices. 
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If you have many invoices that are the same amount and to the same customers every month, you don’t need to reenter the invoices every month.  Use this ‘Replicate Invoices’ command.  Enter the standard invoices one time and put them on a date that has no other invoices, say ‘9/29/00’.  Then at the end of October, you can do this ‘Replicate Invoices’.  The program will ask ‘Date of Old Invoices?’ and you enter ‘9/29/00’.  Then it will ask ‘Date for New Invoices?’ and you enter ‘10/29/00’.  Then if you had 100 invoices dated 9/29/00, you will then have 100 new, pending, invoices to the same customers and in the same dollar amounts dated 10/29/00.  To edit amounts or coding or to delete a few invoices, just edit the newly pending invoices using your <F4> key to view and retrieve the pending invoices that need to be changed.  To add invoices to be repeated monthly, just add the new invoices with a date of 10/29/00 so that when you need to do November’s monthly invoices, you can replicate all invoices dated 10/29/00.
Refund Credit Balances. 
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Blue Skies A/R program will Refund Credit (overpayment) balances with creating either a Quick Check or an Accounts Payable Check to each overpaid customer.  If you maintain settlement accounts with customers – both buying and selling to a customer, this step will issue the final settlement check to customers whom you owe money to (on net of their A/R balance).  This job will ask you what date to put on these checks, and will ask "Stop to ask 'Ok to write?' for each refund check?".  If you answer ‘Yes’, the program will ask if you want to write a $xxxx.xx check to ‘XYZ Company’ and for all of your credit balance A/R customers.  Actually the Quick Check or A/P refund checks will appear in the list of Pending Quick or A/P checks, as appropriate.  You could even delete or modify those checks using the normal method of modifying pending checks.
Cash Basis Books
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Reverse to Cash Basis – for Cash Basis companies only.  If you are a ‘Cash Basis’ company \Relate "BLUE_SKY.DOC!38", "^145Cash Basis^146 company" \D2HTargetDefault , at year end, the program will automatically run this step unless your accountant wants to do his own Reverse to Cash Basis without putting the reversal entries on your computer.  Do an ‘Auto Resolve’ and ‘Hand Resolve’ first to resolve payments and so to reduce the number of Unpaid entries. This step takes all Unpaid invoice charges  and generates an equal number of new entries with the Debit and Credit flipped – thus reversing A/R balance to zero.  The fiscal year end program \Relate "BLUE_SKY.DOC!31", "fiscal year end program" \D2HTargetDefault  automatically will re-setup these unpaid A/R entries on the first day of the next fiscal year -  just like an accountant does laboriously with journal entries.  If you need to erase all these A/R reversing entries, i.e. to Undo the ‘Reverse to Cash Basis’, do ‘Revert to Accrual Basis’, and the new reversing entries will be erased.  The ‘Revert to Accrual Basis’ shows above as being a disabled, dimmed, command. It will be enabled, undimmed, after you run your ‘Reverse to Cash Basis’ step.  
Print your AR Diagnostic Analysis: Itemizes  problems within your books (ie..which vendor has different balances due) which uses your books not to close properly.
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Important, ‘Good Bookkeeper Note’:  run your Balance Sheet after doing this ‘Reverse to Cash Basis’ step to verify that your Accounts Receivable balance is zero.  It won’t be zero if the ‘Fiscal Year Balance Forward \Relate "BLUE_SKY.DOC!9", "Fiscal Year Balance Forward" \D2HTargetDefault ’ for your Accts Rec GL account wasn’t zero.  Fiscal Year Balance Forward must be zero if you are a Cash Basis company.  Remember, the unpaid amounts for each vendor are carried over to the next fiscal year by the Fiscal Year End program and recoded to the first day of your new fiscal year.
 \Relate "Blue_Sky.doc!27" \D2HTargetDefault 
 XE "Journal Entry" Journal Entry
These adjusting entries are typically given to you by your accountant.  They allow you to not only enter your accountant’s adjusting entries, but also to make entries that don’t effect  your checking accounts (to make entries other than checks or deposits) such as your depreciation entries: Debit to your depreciation expense and credit to your allowance for depreciation and an entry writing off inventory damaged in a storm: debit to Wheat Income and credit to wheat inventory.  You can even enter checks and deposits – use the pneumonic trick Debit cash = Deposit, Credit cash = Check [where the ‘D’ in Debit cash equates to the ‘D’ in Deposit].  For example a deposit for Interest Income would be Debit Cash Account and Credit Interest Income.  A check written for Interest Expense would be Debit Interest Expense and Credit Cash Account.
 XE "Inventory" Inventory
Prints a list of inventory items in one or more warehouses.  This is an optional module.  If you haven’t purchased it, it won’t be enabled and will appear dimmed. 
 XE "Enterprise Only" Enterprise Only
These transactions will only appear in your Enterprise Reports, your Management Reports.  If, for example, you wanted to print a report that included the $50,000 you estimate you will receive throughout next year, make an Enterprise Only transaction debit account number zero and credit Sales Income for $50,000 to a particular enterprise.  The $50,000 will appear in the Enterprise Detail and other management reports but won’t effect your Balance Sheet and P&L tax reports.  In other words, enterprise only transactions are for adjustments to your internal management reports.
Computer Paychecks XE "Paychecks" 

 XE "Computer Paychecks" 
This computer paychecks procedure will print paychecks and register.  To print general ledger (non-payroll) checks, do not use this step, use the general ledger check input procedures \Relate "Blue_Sky.doc!10", "general ledger check input procedures" \D2HTargetDefault .
These instructions also pertain to Manual Paychecks \Relate "BLUE_SKY.DOC!51", "Manual Paychecks" \D2HTargetDefault .  But for 
Manual Paychecks, you must enter employee deductions.  For Computer Paychecks, the program will calculate employee deductions.
Off of each employee’s timecards XE "Timecards"  or timesheets, enter his hours, XE "Hours"  payrates, (or piecework quantities & rates) and cost accounting coding to specify where he was working and what job he was doing (in other words, which enterprise XE "Enterprise"  and which operation XE "Operation"  for each timecard line). 
 Blue Skies then will verify that any piecework was at or above minimum wage \Relate "BLUE_SKY.DOC!55", "minimum wage" \D2HTargetDefault , will add these timecard lines for the employee’s total gross XE "Gross"  for the payday, will compute his appropriate taxes and other withholdings XE "Withholdings"  and then will write the paychecks, check register, and other optional reports XE "Reports"  and post the paychecks to the employee’s year-to-date XE "Date"  totals and to general ledger and cost accounting.  The program will adjust wages for all piecework earnings that fall short of the minimum wage requirements. Most significantly, if adjustments are necessary to one or more enterprises to bring an employee’s wages up to minimum wage rates, the program will add one or more adjusting entries to your original input.  This adjusting entry will be printed on your paycheck registers.  
 XE "Timecards" Payroll Timecards
Click on ‘New’ (lower left of employee’s photo) to start entering timecard lines for an employee.

Enter the employee’s number or first letters of his last name in the box to the right of the 'New' button.
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Enter Timecards for Computer or Manual Paychecks screen
Social Security# Lookup: To find an employee by his social security number rather than the normal method by employee number or name, touch your <F8> key once so that Options ! Social Security# Lookup is checkmarked.  Then enter the first numbers of his social security number to speed search for him.  You must enter a dash as the fourth and seventh character as in the ‘333-44-5555’ social security number format.
Setup New Employee: if this employee isn't on the list of employees that appears, he hasn’t been setup yet.  You can assign the next employee number to him and set him up by touching your <F2> shortcut XE "Shortcut"  key \Relate "Blue_Sky.doc!19", " <F2> shortcut key" \D2HTargetDefault .  To edit an exiting employee – for example to change his social security number – go to Setup ! Employees and correct the fields that are in error. Network clients must use Setup! Employees! to enter new employees or edits.  If you have an employee from last year, who is now working again,  go to the Setup! Employee! Edit! for new command ‘Setup Employee from Last Year’s Information’. This fills in all the employee’s blank fields from last years database and you do not have to use the same employee number.
Enter hours XE "Hours"  and accounting information for each timecard line.  The timeclock XE "Timeclock"  calculator will compute hours given start time, stop time, and time off for lunch if you wish.  As you can see, if you have a photo XE "Photo"  or ID card of this employee stored on the computer, it will appear in the box on the upper left of his timecard input.  
When printing your registers, timecard lines will sort by ‘Work Date’.  New report ‘Pay Journal by Enterprise’ is a paycheck register designed for those who would like to sort payroll time card lines by enterprise to get subtotals for gross wages, hours worked and pieces.
Overtime

To enter Overtime or Doubletime hours or Piecework, in this screen’s ‘Edit’ menu you will find below menu.  To speed data entry, you also can just key an ‘O’, a ‘D’, or a ‘P’ to enter Overtime, Doubletime, or Piecework timecard line. An ‘H’ or an ‘S’ will return to Straight time Hourly timecard entry.
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Edit menu to change pay types
If you have entered a timecard line below the minimum wage, this message will appear. See notes above on minimum wage adjusting entries.
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Secret Speed Tip:  while in the ‘Hours’ input box, you may just type an ‘S’ to enter straighttime pay, or an ‘O’ to enter overtime, a ‘D’ to enter doubletime, and a ‘P’ to enter Piecework.
Edit Crews
This will display a list of each crew. XE "Crew"  Crews are used to select which employees will receive computer paychecks XE "Paychecks"  on any given payday.  As you go to print computer paychecks (but not manual checks XE "Checks" ), if you have crews setup, the following window will appear:
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Select Which Crews to Receive Paychecks screen
In this example, the program will write paychecks to employees on Crew #1.  Pending paychecks to other crews won’t be: printed on any of the Payday Check Registers, won’t be printed on paychecks, and won’t be posted to payroll and general ledger – they will just stay in a ‘Hold’ status.  So choose which crew you wish to process,  then proceed to tax calculation, printing and posting of the paychecks for Crew#1, only.  
Even if you don’t normally issue paychecks by crews, if you lay off some employees and need to issue them early paychecks, you will want to use this feature.  Assign the laid off employees to a new crew and then issue the paychecks for that new crew, only, leaving all your other employees’ timecard lines pending until the normal payday. 
Setup a new crew, choose ‘Edit Crews’ under the ‘Edit’ pulldown menu.  When no crews are setup, this window will appear:
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If you already have one or more crews setup, under the ‘File’ pulldown menu on one of the Crew windows, choose ‘Add new crew(s)’ and the above menu will appear with the existing crews already checkmarked.  An existing crew is one that has employees  already assigned to it.  In other words, if you remove all employees from a crew, it will no longer be checkmarked.  Checkmark other crew numbers you wish to create.
If you want to setup Crew#1 and Crew#2, checkmark them by clicking in their boxes and then clicking on the ‘New Crews’ button.  Then you will see:
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To add an employee to crew#2, XE "Crew"  click on the ‘Crew #2’ window to bring it to the top.  Left click on employee#3, Martine Herrera in the Employee Search list to highlight it with a blue color.  Then click drag (hold down your left button while moving – your cursor will be the man icon shown above) on his line over to Crew #2 and drop (lift up on your mouse).  If you drop him on Crew #1’s window, he would then be a member of crew #1.
To remove an employee, use your up/down arrow keys on the crew's list of employees until the employee is highlighted with a different color, then touch Shift/Delete or just <Delete> or just drag and drop the employee into the trash XE "Trash"  can.
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To remove ALL employees from a crew, use the ‘Remove ALL Employees from Crew #nn under the ‘Edit’ menu heading on the crew’s list of employees as shown above.
To move an employee between crews, drag and drop him onto the proper crew list.  Click on the employee's name first to highlight him.  Then click and drag him to the other crew's list of names.
But what happens if you assign an employee to two different crews?  As you  File ! Exit or click on the close button of each crew’s list, the program updates the employee setup information for each employee on the crew’s list, recording him as being on this crew.  So the last crew list closed will take precedence and supersede the previous crew number for these employees - he will be saved as being on the crew of the last list closed.
To enter timecard lines for all members of a crew: if crew lists are put away, do Edit Crews on the timecard input screen to display them.  If you want to enter timecard lines for crew#1, click on Crew #1’s window to bring it to the top and to activate it. On Crew #1’s own ‘Edit’ pulldown menu (not the ‘Edit’ pulldown menu on the timecard input screen), do 'Enter Timecard Lines for Crew #1'.  Enter the timecard lines for the crew and then touch your <New> button to copy all these new timecard lines to every employee on the crew.  If you wish, touch your <F4> key to list pending checks to look at these lines that were copied to each employee in the crew.
Tech tip:  To put away all crew lists, click on the timecard input form.  Warning - This will put crew lists away in crew number order.  So if you have an employee on two different crew lists, he will be saved as being on the higher crew number, superseding the lower crew number.
 XE "Date" Date
Enter the date of the work or touch your <F6> key to Get Calendar XE "Calendar"  Date \Relate "Blue_Sky.doc!4", "Get Calendar Date" \D2HWindow /d  XE "Calendar" 

 XE "Get Calendar Date"  from a pop up calendar.  Incidentally, this menu item will be disabled and will appear dimmed on the pulldown menu except when you are in a date input field.  In other words, the program will let you use <F6> only when it is asking you for a date.
 XE "Quantity" 

 XE "Hours" 

 XE "Gross" Hours, Quantity, or Gross
You may either enter a number or an equation XE "Equation" .
Ent, Oper, Eqp#
Use Speed Search to enter the enterprise XE "Enterprise"  number, operation XE "Operation"  number, and equipment XE "Equipment"  number.
Multiple Enterprises for One Input Line
If you want to percentage out one input line to several enterprises based upon their acreages, use the powerful Multiple Enterprises for One Input Line XE "Multiple Enterprises for One Input Line"  \Relate "BLUE_SKY.DOC!50", "Multiple Enterprises for One Input Line" \D2HTargetDefault  shortcut method - 'multi XE "multi" ' will appear in the enterprise input box.
 XE "Quantity" 

 XE "Hours" 

 XE "Gross" Macro Keys
Often you will have many employees doing the same job. Blue Skies Accounting has Macro Keys to speed your repetitive timecard data entry XE "Equation" .  To use Macro Keys, at the end of entering an employee’s paycheck line, just before touching the save button, hold down your Control key (your <Ctrl> key) and touch your <F1> through <F9> key to save that input coding into macro number one through nine, respectively.  Or, alternatively, after timecard lines already have been saved, click on the hours field in one of the timecard lines in his list of timecard lines already saved and then do <Ctrl> plus <F1> through <F9>.  The saved information can be viewed under the File pulldown menu heading of this timecard input form.  To retrieve the saved information, when you start timecard input for another employee, hold down your Shift key and touch <F1> through <F9>.  If you retrieved the wrong macro information, just do Shift plus <F1> through <F9> to replace the input information with another macro key information.  You then touch <Enter> through the input boxes - replacing any information you wish to revise - and then touch your Save button to save this new timecard line.  Macro key information will be stored for each computer operator so the macro key information can be used across client numbers and across subdirectories.  You can overwrite macro key information with new parameters as often as you wish.  To empty macro keys, click your ‘Clear’ button, then hold down your <Crtl> key and touch <F1> through <F9> to clear the contents of these macro keys.
Correcting Timecard Lines
To correct timecard lines for this employee, click on the numbers to change in his list of timecard lines.  You may delete timecard lines, by clicking on the box on their left edge.  Once they have been highlighted, drag and drop it in the trashcan. 
 XE "Forced Deductions" 

 XE "Deductions" Forced Deductions
To specify a deduction different than the normal tax calculations made by the program, click on the ‘Start’ deductions button in the upper right corner of this window.  Then up/down arrow to the deduction to change.  After entering the deduction, click on ‘Stop’ deductions button.  As for Hours, Quantity, or Gross, you may use an Equation to enter a deduction.  For example, to enter 6.25% of the $270.75 gross pay, enter ‘.0625*270.75’ and touch <Enter>.  The program will multiply these two numbers and replace them with 16.92.  To change back from a Forced Deduction, to let the program calculate the withholding by itself, type a ‘C’ in the deduction amount XE "Amount"  and the program will replace the ‘C’ with ‘Calc’.
Employee Advances XE "Advances" 
Giving a payroll advance to an employee.
Under the Transactions.pulldown menu, choose ‘Computer Paychecks’.  Enter the employee’s number and touch your enter key. Then to advance $100 to this employee click on the ‘Start’ deductions button, in the upper right hand corner of check, and enter ‘-100.00’ in the Advance box – the minus sign before the $100 means make a negative deduction that will be later zeroed out by the $100 entered without the minus sign in the ‘Deducting a payroll advance’ explanation just below.  Click the ‘Deductions Stop’ button and enter any other employee advances.  Proceed to Print and Post.  Print checks and register and post this as you would for a normal payroll.  If you don’t want the program to print out a $100 advance check to this employee, if, for example, you advanced $100 cash or $100 in a manual check written in the field, use the Transactions ! Manual Paychecks procedure, click ‘Deductions Start’, enter ‘-100’ in the advance, click ‘Deductions Stop’, enter a check number (or leave it blank if the advance was given in cash) in the manual check window that appears.  Proceed to print and post.  Print the Paycheck Register and Post (don’t need to print checks in this case).
Withhold a payroll advance from an employee.
When entering the next computer paycheck for this employee, a message will appear indicating ‘this employee has $100 of advances still owed’. Click the Stop button in upper right hand corner, and enter in the Advance field ‘100’ to deduct the full amount [or ‘50’ to deduct half the outstanding advance].  
Options Menu
Timeclock
If ‘Timeclock’ is checked, then you will see a timeclock displayed on your timecard input window.  Use the up/down arrows adjacent to the start and stop clock to set the normal starting and ending times and the normal length of lunchtime.  The program will calculate the hours: (stop time minus start time less lunchtime hours) and put that into the ‘Hours’ field for you.  
Military Timeclock
If ‘Military Timecard’ is checked will display hours on the timeclock in military time – eg shows 1:00pm as 13:00 hours.
Show Photos
If ‘Show Photos’ is checked, employee photos will be displayed for each employee.
Ask Workdate
If ‘Ask Workdate’ is checked, the workdate for each timecard line will be asked in a column to the left of the ‘Hours’ column.  Enter ‘10/15/00’ for October 15th, 2000 timecard line.
Ask OT/Quantity
If ‘Ask OT/Quantity’ is checked, then when you are entering either Overtime or Doubletime timecard lines, the program will ask for ‘Quan’ and ‘Quan Desc’.
Display Employee Description
On the top, left, corner of the Timecard input window, one of the employee’s eight custom descriptions will be displayed.  Perhaps you would like to see their Birthday, phone number, etc.  The eight categories such as ‘Birthday’ are setup in employer setup \Relate "BLUE_SKY.DOC!12", "employer setup" \D2HTargetDefault .  Then the employee’s own Birthdate is entered on his employee setup \Relate "BLUE_SKY.DOC!14", "employee setup" \D2HTargetDefault  info screen.
Social Security# Lookup
If ‘Social Security# Lookup’ is checked, then to speed search for Jane Ramirez, enter the first part of her Social Security Number, ‘333-22’ instead of ‘RAMIREZ’.
Align Boxes over Columns
On some screens, the input boxes aren’t aligned over the columns.  Perhaps it looks like:
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Click in the input box for hours (the box highlighted with a yellow background in the above graphic), then the ‘Align Boxes over Columns’ will no longer be dimmed.  Then checkmark this option.  The touch your left or right arrow keys until the input boxes are aligned over the columns like the graphic below.  When aligned, choose uncheckmark ‘Align Boxes over Columns’ to end the aligning process.  The new alignment you have specified will be automatically used the next time you start timecard input.
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Done with the Paycheck
When the timecard lines for this paycheck are all entered, click the 'New' button (or touch your <Esc> key) to enter the next employee's timecard lines.
When all employees have been entered, choose File ! Print and Post Checks XE "Checks"  to print and post these paychecks.   XE "Paychecks" 
Payday Posting Disaster
If you make a huge mistake posting a payroll – such as posting all paychecks with the wrong date or wrong check numbers or you forgot to make lots of deductions.  Use the ‘Unpost Payroll’ command 
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If you find duplicate employee information, go to the new command, ‘Change Employee# on Posted Paychecks’. Look for new ‘List Missing & Duplicate Employee Info’ under the Head Bookkeeper File Repair, under File!
 AgData strongly recommends you print (and closely examine) a Payday Check Register to verify check date, starting check number, dollar amounts and payees before printing Paychecks and Posting to avoid Posting Disasters.
Void a Paycheck
After a paycheck has been posted, you can void a paycheck using the View GL Transactions \Relate "BLUE_SKY.DOC!34", "View GL Transactions" \D2HTargetDefault  window.  In the example below, Thomas Jefferson, employee #8 (shown on this window as Vendor # MINUS 8), check#1191 will be voided.  Click only in the box on the left edge where debit=0 and credit=101 (checking account) highlighting the line with a blue background, then choose ‘Void Marked Entries’ under the Edit menu heading.  You can only delete one paycheck at a time. For those payroll clients who do not have General Ledger, who only have Blue Skies Payroll, you will be able to use a ‘Delete a Posted Paycheck \Relate "BLUE_SKY.DOC!66", "Delete a Posted Paycheck" \D2HTargetDefault ’ pulldown menu command in Head Bookkeepers File Repair \Relate "BLUE_SKY.DOC!64", "Head Bookkeepers File Repair" \D2HTargetDefault .
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 XE "Paychecks" Manual Paychecks XE "Manual Paychecks" 
Use Manual Paychecks to enter paychecks that you have already calculated all the gross XE "Gross"  and paycheck deductions. XE "Deductions"   The procedures are just the same as Computer Paychecks \Relate "Blue_Sky.doc!16", "Computer Paychecks" \D2HTargetDefault  except you must type in all the Forced Deductions \Relate "Blue_Sky.doc!20", "Forced Deductions" \D2HTargetDefault , XE "Forced Deductions"  the paycheck number, and the net amount XE "Amount"  of the paycheck - the program won’t let you enter a ‘Calc’ in any of the deduction amounts.  You still will enter a timecard line for each cost accounting job the employee performed.  Enter a group of manual paychecks that were written on the same day.  Then do ‘Print and Post’ under the ‘File’ pulldown menu.  Print a Register of these checks (so you can verify they were properly entered) and then post these manual paychecks.
Year End Closings
Reset Fiscal & Payroll Yr Bal Fwds  (FY = Calendar Year)
If your fiscal year (FY) begins on Jan. 1, then follow the instructions below to close your general ledger. 
The ending balances of the general ledger accounts will be moved forward to starting balances of the new books
Last year’s profit or loss will be posted to your closing account.
If appropriate, unpaid payables/receivables, outstanding check reconciliation and enterprise transactions for selected enterprises are brought forward.
If you use the payroll module, your employees’ YTD amounts will be zeroed in the new books in a new folder.   (You may print your W2s and other payroll reports after doing the payroll reset, because your current books will remain unchanged in your current folder; your new year’s books will be written to a new folder.)
Go to Setup ! Company ! Reset GL & Payroll Yr Bal Fwds.
Accounts Payable and Accounts Receivable
If you use Accounts Payable, Accounts Receivable, your will see prompts about ‘Diagnostic Tests’.  Click ‘No’ if you have not yet run those reports and follow the on-screen instructions to run them.
Check Reconciliation is now under the Requirement list. If you have not reconciled, you will be prompted during your close to do it and start over.
Folder for New Year’s Books
You will then be prompted to enter the path to the folder for your new books for the new year.  If, for example, your current data folder has been c:\blue_Sky\2001data, Blue Skies will default to the new folder for next year’s books:  c:\blue_sky\2002data, as illustrated in the ‘Reset GL & Payroll Yt Bal Fwds’ window below.  Your new books will automatically be copied to this folder, after you’ve completed the customized list of requirements for your close  [If the yellow box is empty, you will have to key in the name of your new folder.  If you import data from 3rd party software and you must retain the same folder name for your new year, call AgData tech support before proceeding.] .  Please verify the path and folder name is correct, then click ‘Proceed’.
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Backup
At the next prompt, put a backup disk in the drive you use for making backups, then click  'OK'. Label your diskette and keep forever.  At the 'Backup' window click 'Start' to make your backup.  Click 'OK' when it is complete and the program will return you to the ‘Reset GL & Payroll Yr Bal Fwds’ procedure.
Requirements Checklist
Click on the ‘Requirements’ pull down menu and you'll see 'Current Backup'  is already checked off your list of required closing steps.It is important to start at the top and continue in order down the list.  Do not skip steps or you may have to start over from the top.
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Your list of requirements is customized for you, and will look different from the example above if you use the Accounts Payable, Accounts Receivable, or Check Reconciliation modules, or if you do not use Enterprises.
If you own Check Reconciliation, you will see prompts telling you the number of outstanding checks and deposits that will be carried forward to next year’s books.  Follow all prompts.
If you own Check Reconciliation, but do not use it, you should clear the outstanding transactions by going to Tools ! Check Reconciliation; select Edit ! Select All; then select Edit ! Change Outstanding for Marked Rows.  You should also select Options ! Checks & Deposits Initially are Cleared
Select the next unchecked item on the Requirements pulldown menu, Requirements ! Review Closing Parameters and follow the on-screen directions to check this requirement off your list.  Each time you check a requirement off the checklist, simply return to the ‘Requirements’ pull down menu, and continue down the list.  
Review New Year Enterprises
The last item on the ‘Requirements’ list applies only to clients who use enterprise costing.  If you do not use enterprise costing or neither of the following two situations apply to you, select ‘Review New Year Enterprises’ then click ‘Yes’ at the prompt, ‘OK to checkmark this step as done?’
If you have crops in progress that will not be harvested until sometime in your next fiscal year you may want to carry forward the transaction for those enterprises as enterprise-only transactions.  Click on the box in the $Amts column to checkmark those transactions.
If you have a crops or business ventures that will span several years and you want to carry forward both the transactions for those enterprises as enterprise-only transactions, and also keep their yearly costs separate, you will need to do two things.   First, check the box in the‘$Amt’ column to checkmark those enterprises.  Second, in the ‘NewEnt#’ column, specify the new enterprise number you want this year’s enterprises to be copied to, in the books for your new FY.  As a suggested numbering scheme, this year’s enterprise 50 could be carried forward as enterprise 150.  Then, after you have completed the closing procedure for the fiscal year, you must change to your new fiscal year’s books and setup the new enterprise number (go to Setup ! Enterprise).  Use enterprise 50 when coding transactions in your new year for this crop.  If at the end of next year, your enterprise 50 is still not complete, carry forward enterprise 150 as 250, and 50 as 150, and so on for each subsequent year.
Click ‘Yes’ to checkmark the ‘Review New Year Enterprises’ item after making the appropriate edits to the ‘New Year Enterprises’ table.
All ‘Requirements’ have been check marked
When all of the items on your list of requirements are checked you may click the 'Go' button to create your new books for your new fiscal year. They will be written to the folder you specified in the first step and your payroll will automatically be reset in your books for your new fiscal year. 
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To view the new year’s books
To view the new year’s books, go to File ! Close Client, then File ! Open Client’s Books.
Click on the drop down arrow at the upper right corner of the ‘Open Client’s Books’ screen, shown below, on down triangle button at the right of the yellow combo box.  You will see a list of your Blue Skies folders.
Double-click the folder for your new year to open your new books.  Click the down triangle button on the upper left of this window ([image: image101.png]


) to list all the folders with different year’s data.  Select ‘C:\Blue_Sky\2015data’ to go back to your 2015 data.
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Then click on the set of books within the 2015data folder to open that set of books.  Either double click on ‘1000, PROGRESSIVE FARMING CO’ or single click on that client#1000 and then click the ‘Open’ button to open that set of books.
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Open Client’s Books screen
You should always Print ‘Balance Sheet & Income Statement’ for the first month of your fiscal year, to verify your balance forwards match the ending balances of your previous year. If they do not match, call AgData technical support.
If you use Blue Skies payroll
Install the Blue Skies Accounting year-end update before entering your first payroll for the new year, so that the latest tax tables will be copied to your new folder automatically when you process your first payroll.   
Go to Setup ! Employer ! Setup Deductions in your new books, to make edits if the minimum wage or tax rates and/or limits for standard deductions have changed.
If you have employees with outstanding advances at the end of the year, you may wish to re-enter those transactions in the new year’s books so you will continue to see the ‘outstanding advance’ reminder for those employees.  Go to Transactions ! Manual Paychecks and re-enter the advance using a date of Jan. 1 of the current year.  When you post these checks, at the prompt, ‘Post to General Ledger?’, click ‘NO’.
Reset Fiscal Yr Bal Fwd (FY not a Calendar Year)
If your fiscal year (FY) does not start on January 1st, then follow these instructions to close your general ledger books before entering records for a new fiscal year.  You must close your general ledger books before entering records for a new fiscal year. 
The ending balances of the general ledger accounts will be moved forward to starting balances of the new books
Last year’s profit or loss will be posted to your closing account If appropriate, unpaid payables/receivables, outstanding check reconciliation and enterprise transactions for selected enterprises are brought forward.
A new folder will be created for the new year’s books’
Your current data will remain unchanged in your current data folder.
Go to Setup ! Company ! Reset Fiscal Yr Bal Fwd.
Accounts Payable or Accounts Receivable
If you use Accounts Payable or Accounts Receivable, you will see prompts about ‘Diagnostic Tests’.  Click ‘No’ if you have not yet run those reports and follow the on-screen instructions to run them.
Check Reconciliation
If you own Check Reconciliation, you will see prompts to alert you to the number of outstanding checks and deposits that will be carried forward to next year’s books.  Follow the prompts.
If you own Check Reconciliation, but do not use it, you should clear the outstanding transactions by going to Tools ! Check Reconciliation; select Edit ! Select All; then select Edit ! Change Outstanding for Marked Rows.  You should also select Options ! Checks & Deposits Initially are Cleared.
Folder for New Year’s Books
You will next be prompted to enter the path to the folder for your new books for the next fiscal year.  If, for example, your current data folder has been c:\blue_Sky\0001data, Blue Skies will default to the new folder for next year’s books:  c:\blue_sky\2016data, as in the ‘Reset Fiscal Yr Bal Fwd’ example below.  Your new books will automatically be written to this folder, after you’ve completed the list of requirements for your close.  Please verify it is correct, then click ‘Proceed’.  [If the destination box is empty, you will have to key in the name of your new folder.  If you import data from 3rd party software and you must retain the same folder name for your new year, call AgData tech support before proceeding.]  
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Backup
At the next prompt, put a backup disk in the drive you use for making backups, then click  'OK'.   Label your diskette and keep forever. At the 'Backup' window click 'Start' to make your backup.  Click 'OK' when it is complete and the program will return you to the ‘Reset Fiscal Yr Bal Fwd’ procedure.
Requirements Checklist
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Click on the ‘Requirements’ pull down menu and you'll see 'Current Backup'  is already checked off your list of required closing steps.  (Note: your list of requirements is customized for you, and will look different from the example above, if you use the Accounts Payable, Accounts Receivable, or Check Reconciliation modules, or if you do not use Enterprises.)   
Select the next unchecked item on the Requirements pull down menu, Requirements ! Review Closing Parameters and follow on-screen directions to check this requirement off your list.  It is important to start at the top and continue in order down the list.  Do not skip steps or you may have to start over. Each time you check a requirement off the checklist, simply return to the ‘Requirements’ pull down menu, and continue down the list
Review New Year Enterprises
The last item on the ‘Requirements’ list applies only to clients who use enterprise costing.  If you do not use enterprise costing or neither of the following two situations apply to you, select ‘Review New Year Enterprises’ then click ‘Yes’ at the prompt, ‘OK to checkmark this step as done?’.
If you have crops in progress that will not be harvested until sometime in your next fiscal year you may want to carry forward the transaction for those enterprises as enterprise-only transactions.  Click on the box in the $Amts column to checkmark those transactions.
If you have a crops or business ventures that will span several years and you want to carry forward both the transactions for those enterprises as enterprise-only transactions, and also keep their yearly costs separate, you will need to do two things.   First, check the box in the‘$Amt’ column to checkmark those enterprises.  Second, in the ‘NewEnt#’ column, specify the new enterprise number you want this year’s enterprises to be copied to, in the books for your new FY.  As a suggested numbering scheme, this year’s enterprise 50 could be carried forward as enterprise 150.  Then, after you have completed the closing procedure for the fiscal year, you must change to your new fiscal year’s books and setup the new enterprise number (go to Setup ! Enterprise).  Use enterprise 50 when coding transactions in your new year for this crop.  If at the end of next year, your enterprise 50 is still not complete, carry forward enterprise 150 as 250, and 50 as 150, and so on for each subsequent year.
Click ‘Yes’ to checkmark the ‘Review New Year Enterprises’ item after making the appropriate edits to the ‘New Year Enterprises’ table.
All ‘Requirements’ have been check marked
When all of the items your list of requirements are checked you may click the 'Go' button to create your new books for your new Fiscal Year.  They will be written to the directory you specified in the first step.   You should see a ‘Successfully Done’ message when the procedure is complete.
To view the new year’s books
To view the new year’s books, go to File ! Close Client, then File ! Open Client’s Books.
‘Open Client’s Books’ screen, shown below, on down triangle button at the right of the yellow combo box.  You will see a list of your Blue Skies folders.  
Double-click the folder for your new year to open your new books.
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Open Client’s Books screen
You should always Print ‘Balance Sheet & Income Statement’ for the first month of your fiscal year, to verify your balance forwards match the ending balances of your previous year. If they do not match, call AgData technical support.
Payroll Yr End – Zero Amounts (Payroll-only Company, a company that doesn’t use GL)
If you are a ‘Payroll Only’ client (you don’t use Blue Skies for general ledger financial reporting), you must reset your payroll at the end of December each year before entering payrolls for the new year.  This procedure will zero employee YTD totals in a newly created set of books to be used for the new year’s payroll.  You will be able to run W2s or any payroll reports after resetting your payroll – the payroll data in your current folder will remain unchanged.
Go to Setup ! Company ! Payroll Yr End – Zero Amounts.
Check Reconciliation
If you own the Check Reconciliation module, you will be reminded to do your check reconciliation before the program resets your payroll. Follow the prompts.
If you own Check Reconciliation, but do not use it, you should clear the outstanding transactions by going to Tools ! Check Reconciliation; select Edit ! Select All; then select Edit ! Change Outstanding for Marked Rows.  You should also select Options ! Checks & Deposits Initially are Cleared.
Folder for New Year’s Books
You will next be prompted to enter the path to the folder for your new books for the next fiscal year.  If your current data folder has been c:\blue_Sky\2001data, Blue Skies will default to the new folder for next year’s books:  c:\blue_sky\2015data, as in the example below.  Your books will automatically be copied to this folder, and the payroll reset there, after you’ve completed the list of requirements for your close.  Please verify the new folder name is correct, then click ‘Proceed’.  [If the destination box is empty, you will have to key in the name of your new folder.  If you import data from 3rd party software and you must retain the same folder name for your new year, call AgData tech support before proceeding.] 
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Backup
At the next prompt, put a backup disk in the drive you use for making backups, then click  'OK'.  Label the diskette and keep forever. At the 'Backup' window click 'Start' to make your backup.  Click 'OK' when it is complete and the program will return you to the ‘Payroll Yr End – Zero Amounts’ procedure.
Requirements Checklist
Click on the Requirements pull down menu and you'll see the 'Current Backup' requirement is already checked off your list of required closing steps.  (Your list of requirements will look different if you don’t use the Check Reconciliation module.)  
Select Requirements ! Review Closing Parameters and continue working down the list until all items are check marked. It is important to start at the top and continue in order down the list.  Do not skip steps or you may have to start over.  
All ‘Requirements’ have been check marked
When all of the items on your list of ‘Requirements’ are checked you may click the 'Go' button to create your new books for the new calendar year.  Your new books will be written to the folder you specified in the first step and your payroll will automatically be reset in your new books for the new payroll year.   
The job will be completed when you see the prompt telling you ‘The year’s payroll has successfully been reset to zero in …  (where next year’s payroll will be processed)’.
To open the new year’s books
To open the new year’s books, go to File ! Close Client, then File ! Open Client’s Books.
‘Open Client’s Books’ screen, shown below, in down triangle button at the right of the yellow combo box.  You will see a list of your Blue Skies folders. 
Double-click the folder for your new year to open your new books.
Install the Blue Skies Accounting year-end update before entering your first payroll for the new year, so that the latest tax tables will be copied to your new folder automatically when you process your first payroll.   
Go to Setup ! Employer ! Setup Deductions, to make edits if the minimum wage or tax rates and/or limits for standard deductions have changed.
If you have employees with outstanding advances at the end of the year, you may wish to re-enter those transactions in the new year’s books so you will continue to see the ‘outstanding advance’ reminder for those employees.  Go to Transactions ! Manual Paychecks and re-enter the advance using a date of Jan. 1 of the current year.  When you post these checks, at the prompt, ‘Post to General Ledger?’, click ‘NO’.
Payroll Yr End – Zero Amounts (FY not a Calendar Year)
At the end of December, you must reset your payroll before entering January payrolls.  This procedure will archive the last year’s payroll and zero employee YTD totals in your current books.   Install the Blue Skies Accounting year-end update before entering your first payroll for the new year, so that the latest tax tables will be copied to your new folder automatically when you process your first payroll.  Go to Setup ! Employer ! Setup Deductions, to make edits if the minimum wage or tax rates and/or limits have changed. 
Open your current books, and go to Setup ! Company ! Payroll Yr End – Zero Amounts.  
Backup
You’ll be prompted to make a backup, if you haven’t already made one.  Label the diskette and keep forever.
Reset Payroll – Zero Amounts
Next you’ll see the window below.  The program will automatically create a new folder in your current data folder, and copy this year’s payroll records to that new folder.  In this example, the current data folder is c:\Blue_sky\2016data and the new folder used to archive your past year’s payroll will be c:\Blue_sky\2016data\Pr2001.  You’ll be able to open that new folder to print payroll reports for the past year.  
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Click ‘Ok’ to complete the job.
Before Processing Payroll for New Year
Install the Blue Skies Accounting year-end update before entering your first payroll for the new year, so that the latest tax tables will be copied to your new folder automatically when you process your first payroll.   
Go to Setup ! Employer ! Setup Deductions in your new books, to make edits if the minimum wage or tax rates and/or limits for standard deductions have changed.
If you have employees with outstanding advances at the end of the year, you may wish to re-enter those transactions in the new year’s books so you will continue to see the ‘outstanding advance’ reminder for those employees.  Go to Transactions ! Manual Paychecks and re-enter the advance using a date of Jan. 1 of the current year.  When you post these checks, at the prompt, ‘Post to General Ledger?’, click ‘NO’.
To run reports for the past year
To open the newly created folder to run reports for the past year, go to File ! Close Client.   Then select File ! Open Client’s Books.
Double-click the folder for your new year to open your new books.
Highlight your newly created folder and double-click to navigate to that folder, then open your payroll company to access the past year’s payroll records.
 XE "New Company" Add a New Company
Standard Blue Skies Accounting lets you put up to five companies in each subdirectory.  If you either want to add another one of the five for the current year or want to setup your books for the next fiscal year, XE "Fiscal Year"  use this ‘Add a New Company’ command.  Choose ‘Setup ! Company ! Add a New Company’ to bring up the following window:
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Add a New Company screen
The next client number (1003 in this example) appears.  Type in the new company’s name.  Put it in a different directory XE "Directory"  (including clicking on ‘New Dir’ to create a new directory, such as ‘2015DATA’ under ‘Blue_Sky’ directory).  Choose which data files to copy XE "Copy"  from the present client #1000 to this new client by checking the files you wish to copy.  Then click on the Proceed button.
Delete a Company
If you are ready to remove a set of books from your computer, do
‘Setup ! Company ! Delete a Company’.  As a safety feature, you cannot delete your current books.  If you are using two passwords, the low level password XE "Password"  employees will not be able to do this nor any other setup command.
AgData recommends you open XE "Open"  up this client you wish to delete and first back up his books up before deleting his books from your hard disk.
Tools Pulldown Menu
The Tools menu gives you easy access to standard and purchased windows programs and optional Blue Skies modules as well as other customization and file repair.
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Tools Pulldown menu
 XE "Calendar" Calculator, Calendar
You have a Calculator, Calendar, Word Processor, Spreadsheet program, and other tools.
File Manager
File Manager (to format diskettes, search for files, erase or rename files, etc.)
 XE "Excel" Excel Spreadsheet XE "Spreadsheet" 
If you have purchased Excel (Microsoft’s Spreadsheet program), you can edit enterprise XE "Enterprise"  budgets using Excel.
Scanner XE "Scanner"  Input / Camera / Photos XE "Camera" 
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If have either a scanner or a camera input for your computer, you can use it to store Photos of Employees (or of their ID cards), of Vendors or Customers (or of their business cards), and of Equipment XE "Equipment" .  To store photos in Blue Skies:
Start your photo or scanner program either: before starting Blue Skies or while in Blue Skies by clicking on your Windows Start key located on either side of your spacebar: ([image: image112.png]


) or by clicking on the start button on the task bar on the bottom of your window’s screen: ([image: image113.png]


 Start).  Then start your photo or scanner program.  Once it has been started, ‘Minimize’ it -  hold down your ‘Alt’ key and then touch your space bar and then touch your ‘n’ key to ‘Minimize’ that window.  To ‘minimize’ a window means not close that program but to shrink it down, to ‘put it temporarily away’ as another icon on your task bar.  You will later be able to instantly ‘Restore’ the program by using the ‘Alt/Tab’ procedure, given just below.
Just before clicking the ‘Photo’ button in setup Employees, Vendors, or Equipment, Alt/Tab as many times as necessary (hold down your ‘Alt’ key and touch your ‘Tab’ key) until your photo program’s icon and description are highlighted and then release your ‘Alt’ key to Restore your photo program to normal, non-shrinken, size. Then take or scan in the picture.  Then copy the picture to your clipboard.  To copy to clipboard, some programs use a File!Send to Clipboard pulldown command.  Others describe it as ‘Send to another Program’, other photo programs describe it just as ‘Copy’ or ‘Copy to Clipboard’.  Most programs use a ‘Ctrl/C’ shortcut key to copy your new image to your clipboard.  Then Alt/Tab back to ‘Blue Skies’.
Save the clipboard image as a Blue Skies photo file:  click on your ‘Photo’ button.  The photo will be resized if you wish.  The ‘Options’ pulldown menu shows a ‘Resize Photos’ option.  Checkmark ‘Make Height fit Picture Box’ and/or ‘Make Width fit Picture Box’ to resize to the box that displays photos.  You can choose ‘Make Driver License Size’ to scan in an employee’s drivers license and have it retain full size or ‘Make Business Card Size’ on a vendor setup.  Or leave all uncheckmarked to keep it at the image’s original size.  If the original image is too large for the picture box, the upper left corner of the image will be displayed, even thought the full picture will be saved to your hard disk.
Check Reconciliation XE "Check Reconciliation" 

 XE "Reconciliation" 
This module will help you reconcile your bank account statements.  It is an optional module.  If you haven’t purchased it, it won’t be enabled and will appear dimmed.
The first time you run this module, set your preference under the Options menu.   You can instruct Blue Skies to start all checks and deposits out as either ‘Outstanding’ or ‘Cleared’:
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AgData recommends as you are learning Check Reconciliation, you start with the Option set to ‘… Initially are Outstanding’, as was done in the graphic of Demo Data, shown above.  If, after you have learned Check Reconciliation, you want to change to ‘… Initially are Cleared’, click on it to checkmark it.  
Various ways to search in check reconciliation.
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Mark checks and deposits as no longer outstanding either:
by double-clicking on them (double-click on them again to make them outstanding again)
–or- by using the Bookkeeper's Assistant.  The Bookkeeper’s Assistant will let you quickly set ranges (specify starting and ending check number and check dates) as all being either outstanding or all 
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having cleared the bank.  
Say you had a deposit with check number zero dated 3/7/16 that was outstanding.   Set starting check number and ending check number to zero, set the starting and ending check date to 3/7/16, set 'OUTSTANDING' and then click on 'Set Group'.
–or- by doing the Multiple Line Select XE "Multiple Line Select"  method (see glossary) to quickly select many transactions to mark them as no longer outstanding.
You can do ‘Heading Click’ (see glossary) to resort these transactions in CheckN#, Date, Payee, Debit Acct# order, etc.
You can do ‘Find…Ctrl+F’ (see glossary) to limit the list to a group of transactions by any or all of the column headings..
Important:  Since this list of transactions is normally only those that are outstanding,  rather than the program immediately making these transactions disappear, they will be shown as ‘Outstanding’=‘No’.  To see the changes any of the three methods of changing from Outstanding Yes to No, or visa versa, do Tools ! Refresh List to make the list show only outstanding entries.  Why does the program require a ‘Refresh’ step?  If the program immediately reflected changes and immediately made the Cleared line disappear from the list and you double-clicked on a wrong line, that line would immediately disappear – you would have to go through the longer step of using your Bookkeeper’s Assistant to change it back to Outstanding= ‘Yes’.
Do File ! Print to print a checking account reconciliation report.
 XE "Export" 

 XE "Import" Import / Export
Reads and writes this client’s data files into other database formats to assist interface to other programs.  This is an optional module.  If you haven’t purchased it, it won’t be enabled and will appear dimmed. This module interfaces with data collection systems and bar code compatible devices.
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 XE "Budgeting" Enterprise Budgeting XE "Enterprise Budgeting" 
Creates Excel XE "Excel"  spreadsheets for each enterprise to allow you do ‘what if’ analysis at year end, changing yields, prices, and expenses per acre.  The finalized spreadsheet is the budget for next year.  The program will sum all the enterprise budgets into and overall, general ledger, budget and will print expense versus budget report on an enterprise by enterprise level. This is an optional module.  If you haven’t purchased it, it won’t be enabled and will appear dimmed.
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All your enterprises are listed.  In the above example:
Bud Ent#:  You are going to create one enterprise budget for the berries (enterprises 10 & 11 will be combined into a single budget enterprise number – Bud Ent# 10).
The Exist column indicates that a budget already exists, has already been created, for this enterprise number ten.
The Print column indicates that the monthly Enterprise Detail Report will include all budget enterprises.  If you didn’t want to include Potatoes on your Enterprise Detail Report, double click on its line to turn the ‘Print’ from ‘yes’ to ‘no’.
Expanded explanations of these three columns are given in the topics listed below:
Choose enterprises to use in enterprise budgeting.
Each of your setup enterprises will be shown in the list with a 'Yes' shown in the 'Print' column.  If you won't be budgeting for some of these enterprises (if, for example, you have a 'Potato' enterprise setup but won't be growing potatoes for this next budget year), either double click in the 'Print' column to change it to a 'No' or just click in it's 'Yes' box to make its background go dark and then type an 'N' and touch up or down arrow.  When the enterprise is set to 'No', that enterprise will be skipped – it won’t be printed - when you print your monthly Enterprise Budget Report.
Group enterprises into the same Bud Ent#.
In the sample Budget Enterprise screen shown above, enterprises 10 & 11 will have their expenses added together to be considered as though they were just one enterprise because Bud Ent# has been set to '10' for both of them.  Then when you Create Budget from Old Expenses, for example, only one Excel enterprise budget will be created, that for an enterprise number ten that is the sum of both actual enterprises ten and eleven.  When the monthly Enterprise Budget Report is printed, the actual expenses from enterprises ten and eleven will be compared against this budget enterprise number ten.
Create Budget from Old Expenses.
At the end of your crop year, create all the enterprise budgets for next year using this command.  This will create an excel spreadsheet for each 'Bud Ent#' equal to this past year's actual expenses but expressed in equations so you can overtype the acreage shown in that budget with your next year's acreage and all income and expenses will be adjusted accordingly.  Similarly, you can revise the yield, price, and cost per acre and all totals will be automatically revised.  Highlight enterprise number one by clicking on its left edge.  Then do File ! Create Budget form Old Expenses to create its excel spreadsheet.  Do each enterprise budget number separately.  When you get down to budget enterprise number ten that has two enterprises that make it up (normal enterprises ten and eleven) as shown in the sample Enterprise Budgeting screen, highlight both enterprise number ten and eleven before giving the command to create an enterprise budget for them.
Edit and print each of those enterprise budgets.
After you have created enterprise budgets, you can correct and print those that you wish.  Highlight the enterprise budget to edit, and then do File ! Edit or Print an existing Budget.  While in Excel, you can revise the total acres, the yield, price, and cost per acre.  You can highlight several cells and drag them left or right to change the months that you expect them to occur in.  You can insert or delete income or expense lines.  The monthly amounts do not have to be expressed as equations but if they aren't, you won't be able to revise the dollars per acre and have all the monthly amounts for that account change appropriately.  AgData suggests you copy the line above and then edit it so all formating and equations will be correct.
Do not close the enterprise budget when you are done.  Just Alt/Tab back to Blue Skies and proceed.  Blue Skies is already programmed to save and close the budget for you.  So if you do it manually, yourself, you will get a program error as Blue Skies tries to save a file that you already have closed.
The monthly amounts in an Enterprise Budget created by Blue Skies are: Units*DolPerUnit*0.35 where units usually are acres and are shown in cell D1, DolPerUnit means the [dollars/acre] amount shown in the 'D' column and the '0.35', for example, means that 35% of the dollars per acre will occur in this month.
To print the budget, use Excel's normal print command (or just click it's printer button).
Any edits you make in Excel will automatically be saved by Blue Skies after you Alt/Tab back to Blue Skies.
Tech Note: You actually may create your own excel enterprise budget from scratch.  Put your Operation XE "Operation"  code, if you wish to use operations in your enterprise budgets, in column A.  Put your GL Account number in column B.  Put account description into column C, dollars per acre and total dollars into columns D and E - or just leave them blank (these three columns aren't used in printing the monthly Enterprise Budget report or in Create GL Budgets). Put your 12 monthly budgets in columns F through Q.  When the program either encounters 8 lines without a GL Account number in column B, or it encounters a cell named 'EndBudget' it will close the budget.  A budget for enterprise number 10 for client number 1000 whose data is in the 'c:\blue_sky\2015data' directory will be saved as ‘C:\BLUE_SKY\2015DATA\FOTO1000\EB10.XLS’. 
Build overall business budget equal to sum of enterprise budgets
After all enterprise budgets have been created and edited, you then can build your overall business budget - Blue Skies will add all these together and update your gl budgets (the ones shown as you setup each gl income or expense account).  You don't need to highlight any enterprises, just Do File ! GL Budget from Ent Budgets and all budget enterprises that have Print = Yes will be added into the proper month's gl budgets.  This step will zero all existing gl budgets and then overwrite any budgets you may have typed in while setting up gl accounts.
Print Enterprise Actual Expense versus Budget monthly report.
Just do File ! Print Enterprise Budget Report to print your monthly actual income/expense versus budget report for each Budget Enterprise (enterprises ten and eleven will be combined together for this report because both have a ten in the Bud Ent# column.
Set Labor Benefit Rate
This will specify the Wage Benefit or Labor Benefit  XE "Benefits" 

 XE "Labor Benefits" rate for the budget spreadsheets and for your monthly Enterprise Budget reports.  Enter the amount as a percentage, i.e. as 25.5% not as .255. [.255 would be saved as 0.255%, about a quarter of one percent]. 
Use Operations in Budgets.
If this Option is checked, Operation codes will be in the excel budgets created and in the monthly Enterprise Budget reports.  If it isn't checked, all operation codes will be blanked - so all WAGE EXPENSE, account number 600, will be combined into one enterprise budget line regardless of the various operation codes.  In other words, if you want to see Operation expense versus budget in your monthly Enterprise Budget reports, leave this option checked.  If you don't want to see operations in those reports, leave this option unchecked while creating your excel enterprise budgets and while printing your monthly reports.
Ask Yield & Price.
If this Option is checked, when you create an enterprise budget from old expenses, you will be immediately asked for the yield and price to use in the budget.  Enter '50 CWT @ $6.50', for example.  You may substitute an 'x' for the '@' and may omit the dollar sign if you wish, i.e. '50 CWT x 6.50'.  After the budget is created, you may edit the excel budget and type in various yields and prices to do 'what if' analysis, to work the excel spreadsheet.  The excel spreadsheet created will alter the income lines appropriately to reflect the different income amount.
Use Wage Benefits.
If this Option is checked, when you create an enterprise budget from old expenses, the dollar amounts to wage expense accounts (those expense accounts specified as a type 'W',  'Wage' account, when the gl account was setup) will be increased to reflect labor burden (the employer's share of FICA, workman's compensation insurance, and other employer costs beyond the base employee wage rate).  You can specify the wage benefit markup you wish to use in Edit ! Set Labor Benefit Rate XE "Benefits" 

 XE "Labor Benefits" .
Use Equipment Chargeouts.
If this Option is checked, when you create an enterprise budget from old expenses, or you print a monthly Enterprise Budget Report will include equipment chargeouts (if you have chosen Company Setup ! Set Costing Option \Relate "Blue_Sky.doc!1", "Set Costing Option" \D2HTargetDefault  to the highest level of detail, 'Ask Ent, Oper, Equip#, & Equip Chargeout.
Rebuild Indexes
Rebuild Indexes will rebuild your description indexes (transactions are not indexed in Blue Skies, unlike the old AgData program)
Head Bookkeeper File Repair XE "Technician File Maintenance" 

 XE "File Maintenance" 

 XE "File Repair" 

 XE "Repair" 
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Restore Data From Floppies
Overwrites all your books for the year with data previously backed up on floppy disks. New safety precaution ‘Restore Data from Hard Disk’; this feature saves your last backup (to floppy) to your hard disk in case of damaged floppy.
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Readd Year’s Paychecks
Repair Damaged File Command that should never need to be done: The program, during posting of each payroll, will add the new payroll to employee’s year-to-date totals.  But if you have deleted paychecks or added paychecks via some import/export program, you can command the program to zero all employee year-to-date totals and then to readd all the paychecks for employees using this command.
List Missing & Duplicate Employee Information
Repair Damaged File Command that should never need to be done: This step will check that every paycheck has an employee setup for it.  Furthermore, if an employee had two setup records for him, the program will inform you.
Error Log
When ever you have a program problem, a window will appear asking if you want to ‘Abort, Retry, or Ignore’ with the internal programming line number where the problem occurred.  This error log stores all those error messages so technicians can view frequency of errors and the exact wording of those error messages.
Delete All Pending (unposted) Paychecks
If you entered 100 computer and/or manual paychecks, and then you decided you want to erase all of them, this step will do that for you.
Delete a Posted Paycheck
Companies who have both general ledger and payroll should use View Transactions method to void paychecks.  But companies who have payroll but don’t have general ledger installed, can use this step to erase a posted paycheck.  After deleting one or more paychecks, the program will readd all paychecks for the year to adjust for this paycheck deletion.
Change Employee# on Posted Paychecks.
Suppose you setup new employee Juan Garcia as employee#101.  He returns later in the year and, thinking he is a new employee – not one who already is setup, you set him up as employee number 157.  When you later realize that you need to combine the paychecks for this employee to get his W2 form correct, this job step will let you change all paychecks from employee number 157 to number 101.
Reset Costing Income/Expense Acct
Repair Damaged File Command that should never need to be done: In view transactions, when you scroll to view the columns off the right edge of your normal viewing screen, you will see a column labeled “ExpAc”.  This is either the income or the expense account of this transaction and it is the account number used for Management (Enterprise) Reports.  If 3rd party programmers edit the database, this step will go through all transactions, get the income or expense account from the debit or credit for each, and then write it into this column.
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Reset Payroll Sort Names
This command that should never need to be done: The Sort Names lets the program re-alphabetize paychecks.
Technician File Repair XE "Technician File Maintenance" 

 XE "File Maintenance" 

 XE "File Repair" 

 XE "Repair" 
This step should by handled only with AgData technical support \Relate "BLUE_SKY.DOC!58", "AgData technical support" \D2HTargetDefault  before doing any of these very powerful database maintenance jobs.  Be sure you do a backup \Relate "BLUE_SKY.DOC!29", "backup" \D2HTargetDefault  of your data before doing any SQL Statements.
 XE "Compress" Compress Files
This step should by handled only with AgData technical support \Relate "BLUE_SKY.DOC!58", "AgData technical support" \D2HTargetDefault  before doing any of these very powerful database maintenance jobs. Compress Files will remove all deleted transactions from within a specific Blue Skies data file or you can choose 'All' and the program will remove all deleted transactions from all Blue Skies data files (for the currently opened company only - it doesn't remove all deleted transactions from all companies on your computer!)
 XE "Repair Damaged Files" 

 XE "Damaged Files" Repair Damaged Files
Do not attempt to make up your own SQL statement. AgData technical support \Relate "BLUE_SKY.DOC!58", "AgData technical support" \D2HTargetDefault  can instruct you what SQL statement XE "SQL Statement"  to enter under Tools ! Technician File Maintenance to unpost payrolls and many other powerful things.    At the very least, backup XE "Backup Client"  your files before entering any SQL statements. 
 XE "Tools List" Setup Tools List
Setup Tools List lets you customize the Tools List for you - you can specify the Spreadsheet program you use, the Word Processor you use, the Signon and background picture you want to use, etc.  The left column is the description that will appear in the Tools Pulldown menu [tech note: put and ampersand before a letter to make it the hot letter - e.g. Calc&ulator makes the 'u' in calculator the hot letter - you can just type a 'u' or a 'U' when that list is down to invoke the calculator].  Click on the 'Path & Program' column next to 'Calculator' then click on 'Browse' XE "Browse"  to search for the '.EXE' program on your computer you wish to be invoked whenever you choose 'Calculator' from the tools list.  Double-click on the program’s ‘.EXE’ file when you find it.  When you are done, click 'Save'.  To see these changes in your Tools list, exit Blue Skies Accounting. The next time you enter Blue Skies Accounting, these changes will take effect.
Help Pulldown Menu
The Help menu gives you access to the on screen help manual, some diagnostics on your computer (available hard disk and memory space and speed tests) and other items to assist you and AgData tech support.
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The Help Pulldown Menu
Help, this on-screen manual, is invoked either by touch your <F1> key or by choosing this last pulldown menu.  The <F1> key will give you ‘context sensitive help’.  For example, if your cursor XE "Cursor"  is in the Find Employee box on the Timecard input window and you touch <F1> the instructions pertaining to Find Employee will immediately appear on your screen.
Tutorial
This pulldown menu will start Microsoft’s Windows Tutorial.
Print User Manual
This pulldown menu item will print a hardcopy of this entire on screen manual.  You will get the best looking manual if you have Microsoft Word program installed on your computer.
Tech Note:  The filename of this manual is ‘BLUE_SKY.DOC’ and will be found in your ‘C:\BLUE_SKY’ subdirectory.
Who Am I
This pulldown menu item will display whether you are operating a multiuser XE "Multiuser"  (network)  XE "Network"  or single user company, what password privileges you have, and the subdirectory where your client’s data is located.
Multiuser Warning: do not use a single user version of Blue Skies Accounting to enter data on a network computer.  If you do so, you will find is that lines from a check you entered will mysteriously disappear, only to reappear on a check entered by some other network user.
Speed Tip: you can click on your company name in the main pulldown menu to do the ‘Who am I’ item in the Help menu.
Who Are We
This pulldown menu item only will appear if you are operating a multiuser XE "Multiuser"  version of Blue Skies.  It will display any other workstations that are running Blue Skies Accounting and what job steps they are performing. This is helpful in a large office.  For example, if you and several other computer operators are entering payroll timecard information, you can use this command to determine when all the other operators are finished doing their payroll input.
Program Information
This pulldown menu item will display the date, time, size of your currently running Blue Skies Accounting.  It will also display in seconds, the time your computer took the last time it loaded paycheck or general ledger check input screens.  This will test the speed of different computers in your office in different circumstances.
Tech Support Help
Need help?  Contact your local dealer for help with your computer hardware and with Windows operating system.  For Blue Skies help, contact AgData at:
Voice telephone at:  (530) 846-6203 for tech support.  Sales informationfor Monday thru Friday 8am – 5pm Pacific Time except for major holidays.
E-mail to: support@agdata.com
Visit our website at www.agdata.com for sales and support information.
Postal and ground delivery service at: AgData, 891 Hazel Street, Gridley, CA  95948
Shortcuts
 XE "Shortcut" 

 XE "Shortcut Keys" Shortcut Keys
<F1> Key calls up the onscreen manual
<F2> Key setups up next Vendor or Employee
<F3> Key edit existing Vendor or Employee
 XE "List All Pending Checks" 

 XE "Checks" <F4> List all Pending Checks or Invoices
 XE "List Pending Checks for a Vendor" <F5> List Pending Checks for a Vendor
 XE "Get Calendar Date" 

 XE "Date" 

 XE "Calendar" <F6> Get Calendar Date
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Get Calendar Date
Use your arrow keys to up / down / left / right to the date.  You also may Page Up / Page Down to move between months.  Note that holidays and weekends are highlighted using different background colors.
<F9> Toggle Description Lookup
Multiple Enterprises for One Input Line XE "Multiple Enterprises for One Input Line" 
The program will automatically percentage out a general ledger check, accounts receivable invoice, or a payroll timecard input line into several enterprises based on their acreage (or other enterprise divisor).  Touch any key at the 'Ent' prompt to get your list of enterprises.  Hold down your <Ctrl> key and click on the various enterprises you wish to charge.  Touch your <Esc> key to return to your check input screen.  You will see 'multi XE "multi" ' displayed in your Enterprise input box.  Enter your Operation and Equipment codes then click on your <Save> button to see multiple lines created for you.  Suppose you had highlighted three enterprises of 20, 30, and 50 acres (a total of 100 acres) and the dollar amount you entered was $1000, you will automatically get three transactions in the check stub list -- one for $200, one for $300, and one for $500 (20%, 30%, and 50% of the total) instead of the $1000 transaction.  If you had entered a quantity in the $1000 input line, the quantity also would be percentaged out at 20%, 30%, and 50%.
Tech Note1: The list of enterprises uses Microsoft's extended multiple selection.  So, in addition to control/click on lines to select them, you can: a) hold down your Shift key and arrow up or down, or b) Shift click on the first item and then Shift click on the last enterprise in a group of enterprises.
Tech Note2: In the quantity, you can tell the program how many places to the right of the decimal you want by the way you enter the quantity.  The normal is two places to right of the decimal but if you enter 45.0000 TONS in the quantity input box, the percentaged out transactions will have four places to the right of the decimal, also.
 XE "Buttons" Buttons & Boxes
Standard Buttons
Add new button XE "Add new button" 
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  Saves any inputs & clears screen for a new entry.
Find Old button XE "Find Old button" 
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  Search an existing list of codes.
Save button XE "Save button" 
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  Writes your keyed information to disk.  Actually your information is written to memory and when a memory area is full, the operating system will write the information to disk.  So a power outage before you close your books may lose data not yet written to disk.
Clear button XE "Clear button" 
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  Blanks all input boxes.
New button XE "New button" 
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    Saves the current keyed information & then clears inputs.
Delete button XE "Delete button" 
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  Deletes (erases) the record or code currently shown on your screen.
Exit button XE "Exit button" 
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  Leave the current screen.
 XE "Photo" Photo button XE "Photo button" 
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  Trigger the photo \Relate "BLUE_SKY.DOC!59", "photo" \D2HTargetDefault  or scan program. XE "Tools List" 
Print button XE "Print button" 
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  Start printing reports. XE "Reports" 
Proceed button XE "Proceed button" 
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  You are done typing and checking options.  Program proceed. 
Help button XE "Help button" 
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  Display instructions on your screen.
 XE "Trash" Trash can picture XE "Trash can " 
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  Click and drag a transaction to this picture to delete the transaction.
Scroll bars
 XE "Browse" Browse scroll bar XE "Browse scroll bar" 
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Click left-most button to display employee number 1. Click right-most button to display highest employee number.  Click next buttons XE "Buttons" 

 XE "Buttons"  just inside to right and left to display and/or edit the next higher or lower employee.  Click and drag the scroll box in the middle to zoom up or down employee numbers.  Click on the slide bar to left and right of scroll box to jump up or down 5% of employee numbers.
Glossary of Terms\GLOSS
ABEND
ABnormal ENDing.  An error message that appears on-screen when the computer stops running because of programming error.
Abort
The act of terminating a program operation in the early stages.  If the program asks ‘Ok to delete - <Ok><Cancel>’ and you click on <Cancel>, the deletion procedure will be aborted, it will be stopped.
Account
The General Ledger Account Number. A number from 1 to 99999 that corresponds to an asset, liability, capital, income, or expense account.  For example, 101 usually is the account number for the Checking Account, also called ‘Cash in Bank’.  600 often is the account number for Wage Expense.
A/P
An abbreviation for Accounts Payable.
Accounts Payable
If you wish to put checks in a ‘Hold’ status or to pay checks that have been entered into the computer only as they come due, enter the checks as Accounts Payable Checks (A/P Checks) with Due Dates instead of as Quick Checks.  The ‘Print’ button will print ‘Cash Requirements’ reports by Due Date and by Vendor.  When you’re ready to print accounts payable checks, specify you want all ‘Ready’ status checks (bypass the ‘Hold’ status checks) that are due by November 15th, for example.
A/R
An abbreviation for Accounts Receivable.
Accounts Receivable
Accounts Receivable reports include invoices and month end statements.  Throughout the month, after you have entered the invoices for the day, click ‘Print’ button.  Then don’t go to month-end reports, go directly to print those pending invoices.  At month-end, do Transactions !Accounts Receivable and then ‘Print’.  Then go to month-end reports to charge interest on unpaid balances and to print month end reports showing 30-60-90 day aging of past due accounts.
Add New thru Exit Buttons
The command buttons are used to setup Accounts, Vendors & Customers, Enterprises, Operations, Equipment, and Employee Codes.  They are:
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Add New saves any inputs & clears screen for a new entry.
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Find Old searches an existing list of already setup codes.
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Save writes your keyed information to disk.
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Deletes (erases) the old record currently showing on your screen.  Do not erase any codes that are being used!
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The ‘Exit’ button leaves the current screen.  Do ‘Save’ button to write any new changes before exiting.
See the glossary  topic, Button, for instructions on using buttons.
Backup
To copy information from your hard disk to floppy diskettes for use in case your hard drive becomes damaged either from equipment failure or from programmer or operator error.
Batch Number
The Batch Number is an internally assigned number that groups all the transactions for a check or an invoice.  The most recently entered check or invoice will have the highest batch number.
Button
This ‘Save’ button is an example of a command button.  To command the program to do a job (in this case to save your edits to hard disk), click the button by moving your cursor over the button and then touching your left mouse button once.  Or, if you don’t want to remove your hands from your keyboard, you can ‘click’ this button by using the ‘hot letter’.  Note that on this Save button that the ‘S’ is underlined.  That indicates it is the hot letter.  So if you hold down your <Alt> key and then touch your ‘S’ key, the program will respond just as though you had mouse clicked this button.
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CD
An abbreviation for Compact Disk.  AgData ships its installation program on a CD.
Check Reconciliation
This optional module helps your reconcile your monthly bank statement using the information you already have entered into the computer as checks and deposits.
Client Number
The number assigned by AgData to each set of purchased programs.  Used for our servicing, billing, and royalty payment reference.  A different client number is used for each income tax entity.
Crew
You may assign your employees to crew number one through twenty.  Then, when writing computer paychecks, the program will ask which crews are ready to be paid and will print and post only those paychecks to the crew numbers you selected.  If you lay off several employees and need to issue them a paycheck immediately, assign them to a new crew and tell the program to issue paychecks only for that crew.
Cursor
A special character on the screen that marks the place where the next character you type will appear on the screen.  Some screens use a ‘I-Beam’ character, like a very large ‘I’, and others use an underline character, ‘_’.  When the cursor changes to an Hourglass, telling the operator to wait while the computer is working.
Customer Number
If you have Accounts Receivable, Vendor numbers also are used for Customer numbers - to add a new Customer, do Setup Vendors \Relate "Blue_Sky.doc!42", "Setup Vendors" \D2HTargetDefault , and click ‘New’.  If you buy from and sell to the same company, you will use their vendor number when you write the check to them, and will use this same number as a Customer Number when you issue them an Accounts Receivable Invoice.
Default
A value automatically assigned by the computer when the operator does not enter any information in response to a prompt.  For example, if at the ‘City’ prompt ‘SACRAMENTO’ already is shown as the value before you start any typing, ‘Sacramento’ is the default value.  Just touch your <Enter> or your <Tab> key if ‘Sacramento’ is correct.
Diskette
Often called a floppy disk or flexible disk.  It resembles a 45 rpm record with a permanent cover that contains a magnetic recording surface that can store information. 
Disk Drive
Diskettes usually go into either disk drive ‘A’ or disk drive ‘B’ so information can either be written on them or read from them.  The Hard Disk is usually ‘C’.  The drive unit itself houses one or more magnetic disks, spins them, and moves the read/write heads into proper position when information may be read from or stored on the disk.
Drag and drop
Left click and keep holding down a record line and then move your mouse until your cursor is over your trash can (or other destination) and then release (let up) on your left mouse button.
Due Date
Due Date is used for accounts payable and accounts receivable transactions.  For accounts payable, the due date is the date when the check will be past due and will incur overdue interest penalties.  For accounts receivable, the due date is the date when, if your customer still hasn’t paid this invoice amount at the next interest charging session, you will charge interest.  If an invoice was due on October 24th, but you next bill and charge interest next on October 31st, if he hasn’t paid by the 31st he will be charged interest, but if he pays before the 31st, he won’t be charged interest.  But if you charge interest on October 24th, he will be charged interest on this overdue line.
Employee Number
A number between 1 and 99999 assigned to each employee by Setup ! Employees.  John Smith might be employee number 1 and Jane Doe might be employee number 2.
Ent
An abbreviation for Enterprise.
Enterprise
The major cost accounting classification and is used in many different ways by different AgData users.  The most detail-minded users classify each field or herd as a different enterprise.  Others group all fields of one crop in one enterprise.  For example, all fields of wheat, regardless of field or ranch number, are included in the wheat enterprise and all corn fields are a second enterprise.  The third method is a combination of the first two.  In it, all fields of a crop on one ranch form one enterprise, and all fields of the same crop on a different ranch form a second enterprise.  Your enterprises might be called Corn, North Ranch and Corn, South Ranch.
Ent-only Transaction
Enterprise-only transaction.  A transaction that will appear only in the Enterprise Reports, not in G/L or tax reports, usually because it occurred in the last income tax year.  Fall land preparation and planting expenses on a wheat field can be included on current Enterprise Reports without double accounting on income tax reports by entering them as Ent-only Transactions, a choice after selecting Journal Entries.
Equation
Whenever Blue Skies Accounting asks you for a quantity or a dollar amount, you may enter an equation.  After you touch <Enter>, the program will solve the equation for you.
For example, if the dollar amount you wanted to enter was 45 times $3.75, rather than you using a calculator to multiply them and then entering 168.75, you can just type in ‘45*3.75’ and then touch <Enter>.  The program will replace your ‘45*3.75’ with ‘168.75’.  Use ‘4+47’ or ‘47-3.50’ or ‘45*3.75’ or ‘45/3.75’ or ‘(3+35)/4.75’ as examples of addition, subtraction, multiplication, division, combined operations.
If you enter one or more of the six special symbols, ‘+-/*()’ , in an amount or a quantity field, the program will recognize that input as being an equation and will solve it before proceeding on to the next field.
Equipment Number
A number between 1 and 99999 assigned to each piece of equipment.  Then repairs to that piece of equipment can be coded with that number so the program can find and sort all equipment cost be piece of equipment.  As a convenience, most users use number 1-99 for pickups and cars, 101-199 for trucks (so truck number 3 would be equipment number 103), 201-299 for tractors, 301-399 for harvesters, and so on.
FICA
Social Security.
Find…
The ‘…’ after a command means, in standard windows’ usage, that, if chosen, another window will appear.  In this ‘Find…’ case, the window will look like:

[image: image144.png]Eind % Date C 14

Find All

Cear_| gp I
=] | auamiy ]





The ‘Date’ thru ‘Batch#’ match the column headings of the table, or list, of transactions.  In this case, selecting ‘2540-2559’ and then clicking on ‘Find’ will find only those transactions whose Batch Number was from 2540 thru 2559.  You don’t need to use the ‘=’ sign if you don’t wish.  If you move your cursor over the other buttons, you will find that: ‘<>’ means ‘not equal to’, ‘>’ means ‘greater than’, ‘>=’ means ‘greater than or equal to’, ‘<’ means ‘less than’, ‘<=’ means ‘less than or equal to’.  The ‘Find All’ means all search parameters will be cleared and all transactions will be listed – will undo the ‘Find 2540-2550’, in this example.  Clear blanks all search parameters.  Done or clicking the ‘X’ in upper right corner puts this ‘Find…’ window away.  The transactions will be remain sorted according to the Heading Click sort sequence.  This ‘Find…’ window has a short cut: Ctrl/F.
Fiscal year
The 12-month period used as the income tax year (for the general ledger books).
FIT
Federal Income Tax
Floppy Disk
See Diskette.
G/L
An abbreviation for General Ledger.
GL
An abbreviation for General Ledger.
Hard Disk
An internally installed magnetic memory unit that can store large amounts of information, and can access that data faster and more reliably than from floppy disks.  But hard disks have a drawback - are fixed, not removable.  
Heading Click
If you click on any column heading on many (but not all) tables, Blue Skies will sort the transactions into that order.  In the example, below, the operator selected enterprises 1 thru 99, click his ‘Find’ button and then clicked on the ‘Ent’ column heading.  This sorted the selected transactions into Enterprise number order.  If the operator immediately clicks on the ‘Ent’ heading again, the transactions will be listed in Descending order – from Ent#13 listed first at the top of the list down to Ent#1 being listed last, at the bottom of the list.  See also: ‘Find …’ glossary definition.
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Highlight
Click on the record selection box on the left edge of a record.  The line will change color like the blue, 35 hour line, shown below.
[image: image146.png]L | L b}
Date | Hours | Quantity| Desc | Rate Gross| Memo
37207 2750 | 0.00 HRS | 6.00 | 165.00
[3r217 3500 | 0,00 WRs | 600 | 210.00
37247 47.00 | 0.00 HRS | 6.00 | 282.00
3725/ 15.50 | 0.00  HRS | 6.00 93.00




Highlighted
Click on the record selection box on the left edge of a record.  The line will change color like the blue, 35 hour line, shown below.
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Labor Benefit
A six dollar per hour employee costs you more than six dollars per hour because you also must pay the employer's share of FICA, workman's compensation insurance, and other items.  These costs beyond the base, stated payrate, are wage benefits that typically will total to 25% or more beyond the base payrate.
Manual Checks
If you have written out checks by hand (rather than the computer printing them on its printer), enter them as Manual Checks so the program can include these expenses in your Blue Skies Accounting reports.
Monitor
The Television-like Video Display unit that displays menus, prompts and any items you key in.  A monitor is also called the Screen or Terminal.
Multi
If, when entering paychecks, general ledger checks, or accounts receivable invoices, you specify multiple enterprises \Relate "BLUE_SKY.DOC!50", "multiple enterprises" \D2HTargetDefault , 'multi' will appear in the enterprise input box.
Multiple Line Select
If you want to quickly select several lines in a list of transactions without clicking on them individually, use the windows Shift click method.  Hold down your Shift key and click the left edge of the top line to select, and then Shift click the bottom line to select.  All lines from this top line to the bottom line will be selected.  To select several lines that aren’t consecutive, hold down your ‘Ctrl’ key and then click on the several lines.  Right mouse click on the list of transactions to unselect all lines.
Multiuser
More than one computer operator can enter, edit, and print data to a Blue Skies company at the same time if you have the multiuser version of Blue Skies.  The several computers will have been connected together over one of several types of Microsoft Visual Basic compatible networks. Warning - Do not use a single user version of Blue Skies Accounting to enter data on a network computer.  If you do so, you will find is that lines from a check you entered will mysteriously disappear, only to reappear on a check entered by some other network user.
Operation
A subtotal of GL Expense Accounts within an Enterprise.  Abbreviated as ‘Oper’ or ‘Op’.  Typical operations for crops will be Land Prep, Planting, Irrigation, Weed Control, Harvest, etc.:
Enterprise#10, Berries on Home Ranch, 25 Acres
    Operation 1, INCOME
          Account 520, Berry Sales
    Operation 28, LAND PREPARATION
          Account 600, Wages
          Account 640, Machine Hire
For construction companies, the enterprise will be the project number such as building ‘John Smith’s Residence’. The operations would be Site Prep, Foundation, Siding, Roofing, Plumbing, Electrical, etc.  These correspond to the subcontractor that may work on the project, on the enterprise as it progresses through to finished product.
Payee
The person or company who will be paid by your check.  Use ‘Vendor’ codes to specify the payee.
PR
An abbreviation for Payroll.
P/R
An abbreviation for Payroll.
Quick Checks
The most common, easiest, way to write general ledger checks in Blue Skies Accounting.  Enter quick checks and the program will print all these checks and a register of those checks.  On the other hand, if you wish to put checks in a ‘Hold’ status or to pay checks that have been entered into the computer only as they come due, enter the checks as Accounts Payable Checks (A/P Checks) with Due Dates instead of as Quick Checks.
Restore
The opposite of Backup.  If you have a computer equipment failure that partially erases or otherwise damages your data, use Tools ! Head Bookkeeper File Repair ! File ! Restore from Floppies  to recover data from your backup diskettes.  This procedure will erase the information on your hard disk for the current client number only, and replace that information with the information that was current at the time of the last backup.  Any information you have entered since the last backup will be lost and must be re-keyed.
Screen
The television-like video display unit that displays program screens and data you've entered.  It is also called a terminal or monitor.
SDI
State Disability Insurance withholding for California employers.  Can be renamed by out-of-state employers for their needs, e.g., SAIF for Oregon Employers or L&I for State of Washington employers.
Single-user
If you have the multi-user version of Blue Skies, more than one computer operator can enter, edit, and print data to a Blue Skies company at the same time.  On the other hand, the single-user version of Blue Skies is installed and used on a single, non-networked, computer. 
SIT
State Income Tax
Special Deductions
Any deductions, excluding FIT, SIT, FICA, and SDI, that are automatically calculated and deducted from wages.  You may use fifteen Special Deductions that you define for your business.  They can be used for Hospital Insurance, Union, Pension, Saving, etc.
Speed Search
Blue Skies will help you search your code lists.  When the program asks for a GL Account Number, an Enterprise, an Operation, an Equipment Number, a Vendor or Customer Number, or an Employee Number, touch the first letter of the name or the first number of its code number and a full list of setup codes will appear.  The first half of the list is in numerical order and the second half is in alphabetic order.  Touch the second letter or number of the code and the program will jump to the first code that matches the two letters you have entered.  Once the list is displayed, you may up/down arrow or mouse click up/down the scroll bar to find your code.  When the desired code is highlighted, either touch <Enter> or double click on it to put the list away and to insert the code onto the original form.  If you want to put the list away without returning a code number, touch <Escape>.  To jump to the beginning of the list, touch <Delete>.
SQL Statement
SQL stands for Structured Query Language.  AgData technical support can instruct you what SQL statement to enter under Tools ! Technician File Maintenance to unpost payrolls and many other powerful things.  Do not attempt to make up your own SQL statement.  At the very least, backup your files before entering any SQL statements.
Subdirectory
A disk directory that is stored within another directory.  Each directory is an area of a disk where the names and locations of files are stored.  For example, Blue Skies Accounting programs and programmer files are usually kept in C:\BLUE_SKY which is the disk directory.  You data files for  Blue Skies are usually kept in the subdirectory C:\BLUE_SKY\2015DATA which is under the program’s directory.
SUI
State Unemployment Insurance
Vendor
 A company or an individual to whom you write checks, or from whom you receive payments.  Set up your vendors with a number so they receive 1099s.  If you have Accounts Receivable, Vendor numbers also are used for Customer numbers - to add a new Customer, do Setup Vendors, and click ‘New’.  If you buy from and sell to the same company, you will use their vendor number when you write the check to them, and will use this same number as a Customer Number when you issue them an Accounts Receivable Invoice.
Wage benefit
A six dollar per hour employee costs you more than six dollars per hour because you also must pay the employer's share of FICA, workman's compensation insurance, and other items.  These costs beyond the base, stated payrate, are wage benefits that typically will total to 25% or more beyond the base payrate.
Window
A box of graphic and/or text information that can be moved (using drag) around the screen  This is an example of a window:
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Windows Print Screen
To print your current (active/highlighted) window on your printer, do Alt/Print Scr (hold down your <Alt> key and touch your <Print Scr> key).  This will copy an image of your current window to your clipboard.  Then use your Tools pulldown menu and select Paint Brush program.  When Paint Brush comes up, do Paste (Ctrl/V) to paste your clipboard image.  Then do File ! Print in Paint Brush to print it.  Just File ! Exit Paint Brush (no need to save the untitled image) and you will be back in Blue Skies Accounting.
-or- In the Blue Skies Accounting group [windows start button ! Programs ! Blue Skies Accounting®, click on the Print Key program.  Then when you touch your ‘Prt Scr’ key, you can easily print out the window directly from that program that represented by this icon: [image: image149.png]N Pii
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1099, 10, 20, 33, 65
401(k) savings programs, 38
6LPI, 65
Account Groups, 11
Account Number, 21
Accounts Payable, 12, 18, 48, 76, 81
Accounts Receivable, 12, 34, 50, 81, 89
Accruals, 37, 39
Add new button, 145
Adjust Check Printing’, 63
Administrative Overhead, 25
Advance EIC Payment, 38
Advances, 109
Aging, 50
Allocations, 26
Amount, 12, 16, 38, 51, 80, 81, 83, 109, 112
Backup Client, 55, 139
Badge, 47
Bal Fwd, 12
Balance Forward, 22
Benefits, 37, 61, 134, 135
Browse, 140, 147
Browse scroll bar, 147
Budgeting, 25, 132
Budgets, 22
Buttons, 23, 27, 29, 32, 34, 46, 64, 145, 147
Calendar, 14, 81, 88, 90, 108, 128, 143
Camera, 128
Change Directory, 54
Chargeout, 16, 31
Check Reconciliation, 129
Checking Account, 12, 22, 86
Checks, 8, 12, 15, 18, 22, 33, 34, 48, 49, 50, 70, 73, 76, 80, 81, 83, 94, 105, 111, 143
Checkstub, 80, 81, 83
Clear button, 145
Close Client, 55
Closing, 12
Closing Account, 12
Compress, 138
Computer Paychecks, 103
Copy, 52, 70, 81, 88, 90, 127
Costing Options, 9, 16, 24, 28, 31
Crew, 46, 105, 107
Crop Year, 17, 25
Current Assets, 11
Current Period, 61
Cursor, 15, 53, 70, 76, 140
Custom Work, 25
Customer, 12, 33, 34, 51
Cut, 52, 70
Damaged Files, 138
Date, 14, 36, 39, 73, 74, 81, 88, 90, 103, 108, 143
Deductions, 35, 36, 38, 39, 42, 45, 46, 49, 109, 112
Default, 18, 36, 53, 60
Delete button, 146
deposit returned, 50
Deposits, 86
Description Lookups, 83, 94
Directory, 54, 58, 127
Discount Account, 12
Due Date, 73, 81, 90
EIC Payment, 38
Employee Information, 39, 46
Employee Special Deduction, 37
Enterprise, 16, 24, 25, 26, 29, 31, 34, 41, 73, 82, 88, 91, 103, 108, 128
Enterprise Allocations, 26
Enterprise Budgeting, 132
Enterprise Only, 102
Enterprises, 16, 24, 25, 41, 42, 54, 71
Equation, 81, 82, 88, 91, 108
Equipment, 16, 26, 30, 31, 71, 82, 88, 91, 108, 129
Excel, 128, 132
Exit button, 146
Expense Type, 22
Expert Options, 7, 9, 12, 18, 42
Export, 131
Farm Shop, 26, 27
Farm Shop Enterprise, 26, 29
Fax Number, 33
Federal ID, 33, 35
Federal Income Tax, 36, 39, 43
FICA, 36, 38
File Maintenance, 136, 138
File Repair, 136, 138
Find Directory, 54
Find Fiscal Years, 54
Find Old button, 145
Fiscal Year, 14, 22, 35, 127
FIT, 40
Fixed Assets, 11
Force G/L ReAdd, 63
Forced Deductions, 49, 109, 112
Get Calendar Date, 81, 88, 90, 108, 143
GL Checks, 48
Government Reports, 65
Gross, 36, 38, 45, 46, 103, 108, 112
Hardware Requirements, 5
Help button, 146
Hours, 31, 49, 103, 104, 108
ID badge, 47
Import, 131
Income Tax Group, 22
insufficient funds, 50, 88
Interest, 12, 34, 50
Interest Income, 12
Inventory, 73, 102
Job Code Table, 27, 37, 41, 42
Job Codes, 19, 27, 41, 42
Journal Entry, 102
L&I, 37, 42
Labor Benefits, 61, 134, 135
List All Pending Checks, 83, 94, 143
List Pending Checks for a Vendor, 83, 94, 143
Long Term Liabilities, 11
Manual Paychecks, 112
Mass Update, 77
Miscellaneous Expense, 12
multi, 82, 92, 108, 144
Multiple Checking Accounts, 18, 86
Multiple Enterprises for One Input Line, 82, 92, 108, 144
Multiple Line Select, 51, 76, 131
Multiple Wage Accounts, 19, 22, 42
Multiuser, 5, 10, 63, 141
Network, 5, 10, 63, 141
New button, 145
New Company, 127
Open, 52, 127
Open Client, 53, 54
Operation, 16, 25, 26, 28, 31, 34, 41, 82, 88, 91, 103, 108, 133
Oregon, 37, 42
Overhead, 25, 27, 29, 41
Password, 9, 15, 35, 73, 76, 127
Paste, 52, 70
Pay Period, 36
Paychecks, 45, 49, 103, 105, 111, 112
Payee, 74, 80, 81
Payees, 39, 48, 50, 74
Phone Number, 33, 39, 46
Photo, 32, 34, 45, 46, 104, 146
Photo button, 146
Post Payroll, 19, 22, 42
Post Wages, 41, 42
Posting, 70
Preprinted Government Forms, 65
Print button, 146
Printer, 60
Printer Setup, 63
Proceed button, 146
Quantity, 26, 73, 81, 108
Quarterly State Payroll Reports, 65
Reconciliation, 22, 73, 129
Repair, 136, 138
Repair Damaged Files, 138
Report Writer, 34, 59, 64
Reports, 8, 14, 15, 16, 22, 26, 27, 37, 41, 45, 48, 49, 50, 52, 53, 58, 63, 75, 83, 93, 103, 146
Restore, 55, 56, 58
Returned Checks, 88
SAIF, 37, 42
Save button, 145
Scanner, 128
Screen Preview, 63
SDI, 37, 38
Set 1099 GL Accounts, 20
Setup Employer Deductions, 37, 49
Shortcut, 33, 52, 104, 143
Shortcut Keys, 143
Special Date, 61
Special Deduction, 37, 38
Special Query, 61
Speed Search, 71
Spreadsheet, 128
SQL Statement, 138
State Income Tax, 35, 36, 38, 43
Tax Tables, 43, 49
Technician File Maintenance, 136, 138
Their acct# for you, 34
Timecards, 103, 104
Timeclock, 104
Tools List, 140, 146
Trash, 74, 77, 82, 83, 91, 93, 107, 146
Trash can, 146
Vacation, 38, 45
Vendors, 8, 33, 34, 40, 54, 71
View, 52, 63, 71, 73, 75, 82, 91
Void Check, 77
W2 Forms, 38, 39, 45, 65
Washington, 37, 42, 43
Withholdings, 38, 39, 49, 103
Workman’s Compensation Insurance Report, 41
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For reporting to the IRS (Form 1094 and 1095 Affordable Care Act reporting)





These forms need ACA Codes 1A thru 1I showing ACA status for each month by employee.


1) To set ACA code '1B', for example, under 'Edit' chose 'Code 1B'.


2) Then set starting and ending employee#,  Monthly Gross, Hours Worked/Month select ranges





For example,


If only employees with more than 130 hours worked/month qualify for '1B' code,


    put 130 in Start box and any employee in the empl# range who worked less than 130 hours


    will not receive the '1B' code for that month.


To use a Special Deduction to further qualify an employee for code '1B', use Options to"


    specify a Special Deduction key. If Employee Contribution to Health Insurance is #4(H.INS),


    put a 10 in health insurance special deduction and any employee who with less than $10


    in a month will not get the '1B' ACA classification code for that month.
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